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INTRODUCTION

Thank you for choosing the Mitsubishi MELSOFT Series Integrated FA software.
Read this manual and make sure you understand the functions and performance of MELSOFT series
thoroughly in advance to ensure correct use.
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1 Introduction MELSOFT

1 Introduction

GX Configurator-ST is used for the configuration and diagnosis of SLICE systems.

MELSEC-ST systems consist of a head module (ST1H-PB for PROFIBUS-DP systems
or ST1H-BT for CC-Link systems) and a number of power supply or /O modules
assembled in a rack.

These systems provide an easy and modular way to add /O to a PROFIBUS-DP or CC-
Link system, without having to install separate wiring to many separate /O modules. The
I/O from each module is grouped into individual data input/output areas for transmission
to/from the network master station.

GX Configurator-ST connects to the communication port of the ST1H-PB or ST1H-BT
head module using an appropriate programming cable. The head module will
independently act as a slave station on a PROFIBUS-DP or CC-Link network.

. ST1H-BT
GX Configurator-5T II RS232 cable o
. ol
D -l_ - J{GOO
= K Setting/Status
monitor 1[
Master station @ME%EEE%@EE
MELSEC-ST system
CC-Link dedicated cable

Example CC-link system
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1.1

Safety Precautions

® SAFETY PRECAUTIONS @

(Read these precautions before using.)

When using Mitsubishi equipment, thoroughly read this manual and the associated manuals
introduced in this manual. Also pay careful attention to safety and handle the module properly.

The precautions given in this manual are concerned with this product. Refer to the user's manual of
the network system to use for a description of the network system safety precautions.

These SAFETY PRECAUTIONS classify the safety precautions into two categories: "DANGER" and
"CAUTION".

Indicates that incorrect handling may cause hazard ous coenditions,
|~ DANGER resulting in death or severs injury.

- .

. -

r'fll-\" CAUTION Indicates that incorrect handling may cause hazardous conditions,
LY resulting in medium or glight personal injury or physical damage.

Depending on circumstances, procedures indicated by - - CAUTION may also be linked to serious
results.
In any case, it is important to follow the directions for usage.

Store this manual in a safe place so that you can take it out and read it whenever necessary.
Always forward it to the end user.

[Design Instructions]

@ DANGER

¢ For data change and status control made to the MELSEC-ST system which is running
from a Personal computer, configure the interlock circuit externally so that the system
safety is ensured. The action to be taken for the system at the occurrence of
communication errors caused by such as loose cable connection must be determined
for online operation of MELSEC-ST system from Personal computers.

-.l-'

1% CAUTION

e Be sure to read the manual careful and exercise an appropriate amount of caution
connecting to MELSEC-ST system and performing online operations (head module
resetting, forced output test, etc.) while the personal computer is operating.

* When replacing the module online, make sure to observe the procedure specified for the
module.
For I/O module, refer to the chapter of online module change in the head module user's
manual; for each intelligent function module, refer to the same chapter in the

corresponding intelligent function module user's manual.
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1.2

Documentation layout

MELSOFT

Each topic is divided in sections as shown below.

dlj PURPOSE

Purpose of operation explained in
each chapter, section or paragraph.

Bl pas/C OPERATION

Operation to be performed until the
actual operation screen appears.

10.1  Transfer setup
s )\
b @ PURPOSE
\ Sets the connection with the head madule. )
s ~,
% BASIC OPERATION
(1) Click the [Onling] = [Transfer Setup] menu.
\ (2) Make setting and click :hel:uu:tnn. )

-

4 DISPLAY/SETTING SCREEN

Transfer Selup

COM Pait:
Trazmizsion Speed ; ig.skhps

Timenud - § RlE

ok I Cance

@ DISPLAY/SETTING DATA

J

Item

Diescription

Select the COM port connectsd with the head maodule.
(Setting range: COM1 o COMI0, default - COM1}

Transmission Speed

Select the fransmission speed. 3
(Setting rangs: 9 6kbps, 19 2kbps, 38 4kbps, 57 Ekbps, defauli " O 6kbps)

DISPLAY/SETTING SCREEN

Screen used to make setting or
provide display for the purpose
being described.

S

E DISPLAY/SETTING DATA

Explains the display/sefting screen items
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In addition, there are also the following explanations.

i#' HELPAN OPERATION

Describes application operation if there are multiple purposes and the basic operation and display/
setting data do not provide enough information.

i- /@ﬂnt
|

Provides information relevant to that page, e.g. the items you should be careful of and the functions
you should know.

The following table lists the symbols used in this manual and their definitions.

Symbol Description

Represents the menu name of the menu bar.
[ ] [ 17 [ Jindicates a drop-down menu.

Example: [File] — [New] menu

Represents the tool button on the toolbar corresponding to the drop-down
( ) menu.

Example: [File] — [Save] menu (n)

Represents the item name in the dialog box.

Example: "File name"

Represents a button.

Example: button

Represents the tab in the dialog box.

<< >>
Example: <<Verify All Modules>> tab
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How to read manual (For CC-Link

In this manual, remote I/O, remote registers and message transmission areas for CC-Link are
represented with Br, Wr, Cr, Bw, Ww, Cw.

(1) Data symbol
<Example :[Cr] Command result aras>

Cr. 0 (7-0)

—Rﬂm
In the case of 1-word {16bit) data, thls shows the
comesponding rangs.

{0} :Shows 0blt position.
{7-0} : Shows O-7 bit rangse.

— Datall data No.

Abbreviated data symbel
For detalls of deta:1 data No. and abbreviated data eymbel,refer to {2} and (3}

(2) Head Module > Master Station
(a) Remote input (RX)

Data symbol Area name Unit Detail data No.
notation
[Br| | | Br_[}[}|to | Br.FF | Bitinput area 1 bit/symbol Hexadecimal

(b) Remote register (RWr)

Data symbol Area name Unit Detail data No.
notation

[ Wr | |Wr-[}[}|to [Wr.33|| Wordinputarea 1 word / symbo Hexadecimal
|

(c) Message transmission

Data symbol Area name Unit Detail data No.
notation
Command result |1 word /symbo Decimal
area |

10
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(3) Master station > Head module

(a) Remote output (RY)

Data symbol Area name Unit Detail data No.
notation
Bw Bw.00 |4, Bit output area 1 bit/symbol Hexadecimal
Bw.FF

(b) Remote register (RWw)

Data symbol Area name Unit Detail data No.
notation
[ W | |ww_[}[}|t0 Word outputarea |1 word/symbo Hexadecimal
|

(c) Message transmission

Data symbol Area name Unit Detail data No.
notation
Command execution |1 word / symbo Decimal
area |

How to read manual (For PROFIBUS-DP)

In this manual, remote I/O, remote registers and message transmission areas for PROFIBUS-
DP are represented with Br, Wr, Cr, Bw, Ww, Cw.

(1) Data symbol
<Example :[Cr] Command result ares>

Cr. 0 (7-0)

In the case of 1-word {16bit) data, this shows the
comesponding rmnge.

{0} :Shows 0 blt position.

{70} : Sheows O-7 bit rangs.

— Datall data No.

Abbreviated data symbo
For detalls of detar1 data No. and abbraviated data symbol,fefer to {2) and (3}

11
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MELSOFT

(2) Input send data

Data symbol Area Unit Detail data No. notation
o | | |
Bit Input Area 1 bit/ symbol Hexadecimal
Br.FF
Er00] _ . .
Error Information Area 1 bit/ symbol Hexadecimal
Er.FF
IEI -to Module Status Area 1 bit/ symbol Decimal
Mr. 127
*1 Command Result Area 1 word / symbol Decimal
Wr 00, _
Word Input Area 1 word / symbol Hexadecimal
W 33

12

*1: The detailed area of the command result area uses the following symbols.

Data symbol

Area

!

Cr

cro(1%8

Command Execution Result

Start Slice No. of Execution Target

H

Executed Command No.

Q
i

Response Data 1

&
w

Response Data 2
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(3) Output receive data

MELSOFT

Data symbol Area Unit Detail data No. notation
o | | |
Bit Output Area 1 bit/ symbol Hexadecimal
Bw.FF
Ew.00] _ _
Error Clear Area 1 bit/ symbol Hexadecimal
Ew.FF
| Sw| || Sw.b]| i | Sw.7||system Area 1 word / Decimal
—1to - symbol
*1 Command Execution Area 1 wordo{ symb Decimal
| Vyw. 00
-to Word Output Area 1 word {symb Hexadecimal
Witw 33 0

*1: Following shows the data symbols and the corresponding detail areas within the command

execution area.

Data symbol Area
Cw.l Start Slice No. of Execution Target
cw.1 Command No. to be executed
Argument 1
Cw.3 Argument 2

13
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1.3

14

Terms and Abbreviations

Unless otherwise specified, this documentation uses the following terms and abbreviations to explain

the head module.

Term/Abbreviation

Description

Head module

Generic term for the ST1H-PB MELSEC-ST PROFIBUS-DP head module,
ST1H-BT MELSEC-ST CC-Link head module.

PROFIBUS-DP Abbreviation for PROFIBUS-DP network.

CC-Link Abbreviation for Control & Communication Link system.
Master module Abbrewviation for the QJ61BT11N used as a master station.
RDMSG Generic term for G.RDMSG and GP.RDMSG.

Bus refreshing module

Module that distributes external system power and auxiliary power to the head
module and slice modules.

Power feeding module

Module that distributes external auxiliary power to slice modules.

Power distribution
module

Generic term for the bus refreshing module and power feeding module.

Base module

Generic term for a module that transfers data between the head module and
slice modules, and between the slice modules and external devices
(including wiring).

Input module

Generic term for modules that handle input data in units of bits.

Output module

Generic term for modules that handle output data in units of bits.

Intelligent function
module

Generic term for modules that handle input/output data in units of words.

/O module

Generic term for input modules and output modules.

Slice module

Generic term for power distribution modules, I/O modules, and intelligent
function modules that can be mounted on base modules.

MELSEC-ST system

Generic term for a system thatis thatis composed of a head module, slice
modules, an end plate and end brackets.

External power supply

Generic term for external system power and auxiliary power.

GX Configurator-ST

Generic product name for SWnD5C-STPB-E. (“n” denotes Version 1 or later.)

Configuration software

Software used to set slave parameters for head modules and slice modules
in PROFIBUS-DP. (e.g. GX Configurator-DP).
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Term definition for CC-Link

The following explains the meanings and definitions of the terms used in this documentation when

using CC-Link.

Term/Abbreviation

Description

Cyclic transmission

A communication method by which remote I/O data and remote register data
are transferred periodically.

Master station

This station controls the entire data link system.
One master station is required for one system.

Local station

A station that has a programmable controller CPU and can communicate with
the master station and other local stations.

Remote I/O station

Aremote station that can only use bit data. (Input from or output to external
devices)
(AJ65BTB1-16D, AJ65SBTB1-16D or others).

Remote device station

Aremote station that can use both bit and word data. (Input from or output to
external devices, analog data conversion) (ST1H-BT, AJ65BT-64AD, AJ65BT-
64DAV, AJ65BT-64DAI or others)

Remote station

Generic term for remote I/O stations and remote device stations.
Controlled by the master station.

Link special relay (for CC-Link).

SB Bit data that indicate the module operating status and data link status of the
master/local station.
Link special register (for CC-Link).

SW Data in units of 16 bits, which indicate the module operating status and data
link status of master/local station.

RX Remote input (for CC-Link).
Bit data that are input from remote stations to the master station.

RY Remote output (for CC-Link).
Bit data that are output from the master station to remote stations.
Remote register (Read area for CC-Link).

RWr Data in units of 16 bits, which are input from remote device stations to the
master stations.
Remote register (Write area for CC-Link).

RWw

Data in units of 16 bits, which are output from the master station to remote
device stations.

Remote net Ver. 1 mode

Select this mode when extended cyclic setting is not needed or when the
0QJ61BT11 is replaced with the QJ61BT11N.

Remote net Ver. 2 mode

Select this mode when creating a new system with extended cyclic setting.

1/0 data

Data transferred between the head module and the master station.

Bitinput area

Bitinput data of each module.
Input data are sent from the head module to the master station through
remote input (RX).

Bit output area

Bit output data of each module.
Output data are received from the master station to the head module through
remote output (RY).

Word inputarea

Word (16-bit) input data of an intelligent function module.
Input data are sent from the head module to the master station through
remote register (RWr).

Word output

Word (16-bit) output data of an intelligent function module.
Output data are received from the master station to the head module through

area remote register (RWw).
-Cr n Information that indicates a command result.

—ICommand result Lyys information is stored in Setting data (area starting from (D1) + 1) of the
area

RDMSG instruction of the master station.

15
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Term/Abbreviation Description
Information for executing a command.
Command

This information is stored in Setting data (area starting from (S2) + 1) of the

execution area RDMSG instruction of the master station.

Number of occupied I/O  JThe area, which is equivalent to the occupied I/O points, is occupied in Br Bit]

oints . .
p input area / Bit output area.

The number assigned to every 2 occupied I/O points of each module.

The numbers are assigned in ascending order, starting from “0” of the head
module. (The maximum value is 127.)

This is used for specifying a command execution target.

The number that shows where the slice module is physically installed.

The numbers are assigned in ascending order, starting from “0” of the head
module. (The maximum value is 63.)

This is used for specifying a command execution target.

Slice No.

Slice position No.

Start slice No. The start slice No. assigned to the head module and slice modules.
Generic term for requests that are executed by the master station for reading
Command each module’s operation status, setting intelligent function module command

parameters or various controls.

Generic term for parameter setin commands or GX Configurator-ST.
Command parameter All of the parameters set for the head module and slice modules are
command parameters.

Processing time for the head module to refresh the input or output status of
each slice module.

ST bus cycle time

16
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Term definition for PROFIBUS-DP

The following explains the meanings and definitions of the terms used in this documentation when
using PROFIBUS-DP.

Term/Abbreviation Description
0QJ71PB92V Abbreviation for the QJ71PB92V PROFIBUS-DP master module.
QJ71PB92D Abbreviation for the QJ71PB92D PROFIBUS-DP interface module.
A1SJ71PB92D Abbreviation for the A1SJ71PB92D PROFIBUS-DP interface module.
AJ71PB92D Abbreviation for the AJ71PB92D PROFIBUS-DP interface module.

Abasic version of PROFIBUS-DP.
The following functions are executable:

PROFIBUS-DPVO " 1/0O data exchange

" Diagnostic information notification
etc.

A PROFIBUS-DP version for which the following functions have been added to
the basic functionality of PROFIBUS-DPVO

PROFIBUS-DPV1 " Acyclic communication

" Alarm function
etc.

A PROFIBUS-DP version for which the following functions have been added to
the PROFIBUS-DPV1 functionality

" Time stamping

PROFIBUS-DPV2

etc.
GX Configurator-DP SWnD5C-PROFID-E type products. ("n" means version 4 or later.)
Master station Class 1 master station that communicates I/O data with slave stations.
Slave station Adevice that exchanges I/O data with a DP-Master (Class 1). (ST1H-PB, etc)
Repeater Device that connects PROFIBUS-DP segments.
Bus terminator Terminator thatis connected to both ends of each PROFIBUS-DP segment

Address assigned to the master station/slave station.

FDL address The FDL address is set within the range from O to 99.

Extended diagnostic Diagnostic information specific to each DP-Slave

information Each of DP-Slaves notifies of it to the DP-Master when an error is detected.
The slave station parameter (including user parameter) set by the master

Slave parameter station.

The setting items are described in the GSD file.

The electronic file that includes description of the slave station parameter.
GSD file The file is used when setting slave parameters by configuration software,
which is supported by the master station.

Data sent from the head module to the master station.
The data consists of the following areas.

- Bit Input Area (head module version A only)
* Information Area

Input data Error Information Area (head module version Aonly)
@ Module Status Area (head module version Aonly)
Command Result Area (head module version Aonly)

- Word Input Area

17
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Term/Abbreviation

Description

Data that the head module receives from the master station.
The data consists of the following areas.

- Bit Output Area (head module version Aonly)
" Request Area

Output data Error Clear Area (head module version A only)
System Area (head module version Aonly)
Command Execution Area (head module version A only)
- Word Output Area
1O data Data (input data, output data) transferred between the head module and the

master station.

Global control

This function enables synchronization command transmission for /O data
from a DP-Master (Class 1) to DP-Slaves.

Bit input area

Bit input data of each module.

Bit output area

Bit output data of each module

Word inputarea

Word (16-bit) input data of an intelligent function module.
In the case of analog input module, the digital output data value is stored.

Word output

area

Word (16-bit) output data of an intelligent function module.
In the case of analog output module, the digital setting data value is stored.

Information area

Bit/Word input data for checking each module status and command execution
results.

Requestarea

Bit/Word output data for requesting each module to clear errors/to execute
commands.

Number of occupied I/O
points

The area, thatis equivalent to the occupied I/O points, is occupied in Br Bit

Input Area/ Bit Output Area.

No. assigned to every 2 occupied I/O points of each module. This numbering
starts by assigning "0" to the head module and then proceeds in ascending

Slice No. . .

order. (The maximum value No. is 127).

The No. is used for specifying the execution target.

Requesting from the master station in order to read the module status, to set/
Command

control the intelligent function module command parameters.

ST bus cycle time

Processing time for the head module to refresh the input/output status of each
slice module.

Bus cycle time

PROFIBUS-DP processing time for the master station to perform cyclic

transfer with each slave station.
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1.4 What's new in version 1.08J7?

Version 1.08J introduces a number of new features to improve the functionality and
usability of GX Configurator-ST, such as:

e Support for Microsoft® Windows® 7 32-bit and 64-bit operating systems.

19
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1.5 Notes for upgrading users

If you have upgraded from the previous version of GX Configurator-ST, you can still reuse
the files that you created with the last version. These files can be opened normally, and
will be upgraded automatically when they are saved.

_ /@wint

Although PROFIBUS-DP files created in this version can be reopened in the
last version of the software, it is generally advisable not to switch between
versions of the software when configuring a file. After saving a file once in
the current version of GX Configurator-ST, opening it in earlier versions is
not recommended.

o /@ﬁnt

GX Configurator-ST 1.06G will only partially work with the new PROFIBUS-DP head
module.

Head module set to PROFIBUS-DP version A:

If the head module is set to version A, there will be no problem as GX Configurator-ST
1.06G is fully compatible with this head module version.

Head module set to PROFIBUS-DP version B:

If the head module is set to version B, GX Configurator-ST 1.06G cannot communicate
with the head module due to changes to the internal structure. Attempting to connect to
the head module will display the error below.

B MELSOFT GX Configurator-ST

i Cannot communicate with Head module For one of the Following reasons:
i * Bad connection to the head module.

* The preparation of communication environment is bad.
To Fix this, try:

¥ Checking the connection to the head module
* Closing other communication software applications and trying again,

<ES: 10000002 =

[
! |

20
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The user interface is very similar to the versions that you have used before, but now when
you start the application you will be taken through the first configuration steps with a
‘wizard' interface. In the main configuration display, the module list from the previous
version is now just the bottom left section of a larger ‘'module configuration' window, which
also shows a graphical display of the configured system, a list of modules for addition and
details of the module selected to be added.

To read more about these features, see the sections shown below:

Feature PROFIBUS-DP description

First steps using the wizard Creating a new project

The module configuration window  |Screen layout and display switching

If you are stuck while using the application, press to show the relevant section of the
help file.

21
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2.1

Overview

MELSOFT

GX Configurator-ST is the configuration software dedicated to the MELSEC-ST system.

Features

(1) Project creation of MELSEC-ST system

(a) Uploading module data to create project

A project can be created easily by uploading the system configuration and parameters

from the MELSEC-ST system.

-

T Al

P

14K ik €]
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(b) Changing system configuration to edit project
A project can be edited by changing the system configuration, e.g. adding or
rearranging modules.

Vo b bt el i, B
Terenovs Fe curerd mdde. selsct Dele

Rearrange
Ehte:Flean. | Cumerd o Machis Hame =
1 1 STIFSD |
2 5 STITIETEZ

] 2 STIVIETE2
7 STIAIGOET

(2) Monitoring MELSEC-ST system
(@) MELSEC-ST system status can be easily checked.
GX Configurator-ST provides an image to show the statuses of the head/slice modules
that comprise the MELSEC-ST system on the “System Monitor” screen. Therefore,
these module statuses can be checked easily.

M System Monitor E”E”E
Module Infarmation Select Module
Madule Mame : ST1H-PB Disp_lfay
Label Mame  : [FastligR
Base Module : Lo

Commupication Status With baster Station

Mo Communication

Module Status
- fodule System Ermar |:| fodule Warning - fodule Change

| No.
Module Statuz

[o] 1 [z[3[a]

ooooooo
R e s o

Manitor Switch
a Stop

Forced Output Test Maode

OFF o OFF

Input/Output Forced Output
Monitar... Test...
Oftset/Gain Module Detail
Setting.. Infarmation..
Online Moduls Parameter
Change... Setting...

Close |
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(b) VO module or intelligent function module can be changed online from

GX Configurator-ST

By using online module change, the faulty /O module or intelligent function module can
be changed with normal module without the PROFIBUS-DP or CC-Link network being
stopped.

GX Configurator-ST allows online module change to be made easily by screen-guided
operation without operation of the head module switches.

PROFIBUS-DF
or CC-Link
network

PROFIEUS HH| == HEEEH | HE B e B |BEE
or CC-Link MELSEC-8T system

(c) Output test can be done without affecting PROFIBUS-DP or CC-Link

network

In a forced output test, outputs can be tested using the Bit Output,
Word Output and Error Clear of the head module or slice module.

The user can specify any Bit Output, Word Output and

Error Clear.

As only the Bit Output, Word Output and Error Clear are

used for the forced output test, output data not used in the test are not affected.
In the forced output test, therefore, an output test can be conducted without affecting
the PROFIBUS-DP or CC-Link network.

Head madule or glica module

DES FEERETE e e e i ’rOtIiDuttastisdoneon
PROFIBUS any uzar-spacifted
or CC-link data.
+ [Bwe.n] Bit Output
« [Ww.n | Word Quiput
- [Ew.n] Exror Clear

PROFIBUS-DP
or CC-ink
network
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3)

Parameter setting of slice module

(&) Parameter setting of intelligent function module
The "Parameter Setting" screen displays a list of module parameters.
Parameter setting can be made on this list.
As it includes functions to upload and verify data, and to check the setting errors, the
parameters can be confirmed easily.

B Parameter, Setting No.3

odule Information
Slice Mo. 5
Module Name ST1AD2
Cancel
Label Mame
Ease Module ST1B-4IR2
Online
Select Data Target Memaory | Fiam -
SekctAl | Releasesl |
Upload | Download | Werify |
Charinel: CH1 - Drefault | Enar Check |
Select Itemn Setting ' alue -
L1 |Input range setting 4 ta 20 md -~ |
L1 |Setting range 4o 20 mé -
L1 | Time/number of times specification Mumber of timez -
1 |5ampling process/averaging process setting Sampling -
L1 |Alarm output setting Dizahle -
1 |Disconnection detection setting Dizable -
1 |A/D conversion enable/dizable setting Enable -
L1 |50/60Hz natch filker specification Dizable -
1 |Average time/average number of times setting 4
1 |Upper upper limit value 4000
1 |Upper lower limit value 4000
L1 |Lower upper limit value 1]
L1 [Lower lower limit value 0 -
| v

MELSOFT
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(4) Power supply capacity check
A check can be made to see if the sum of 5VDC internal current consumption required
by each module is within the 5VDC maximum rated output current of the bus refreshing
module.
A power supply capacity check example is shown below.

Power, Distribution Check

a
Mo, | Supply Currenth] | Congumption(a)] | R ezult ,._--"‘"‘H.‘H{ }

1 2.000 1.800 ok,
16 2000 2 280 ERROR -# (b)

43 2.000 1.145 OE. h&

Cloze

(@ The check result is "OK" since the sum 1.800A of 5VDC internal current
consumption required by the head module No. 0 and slice modules No. 2 to 15
is not greater than the 5VDC maximum rated output current 2.000A of the bus
refreshing module.

(b) The check result is "ERROR" since the sum 2.280A of 5VDC internal current
consumption required by the slice modules No. 17 to 42 is greater than the
5VDC maximum rated output current 2.000A of the bus refreshing module.

(c) The check result is "OK" since the sum 1.145A of 5VDC internal current
consumption required by the slice modules No. 44 and later is not greater than
the 5VDC maximum rated output current 2.000A of the bus refreshing module.

(5) Byte pack check (PROFIBUS-DP head module version B only)
A byte pack check is automatically done with PROFIBUS-DP head module version B.
This check ensures in offline mode that the configuration is correctly set up with byte
packed modules.

26
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2.2

Howdol..?

This section will list things that you may wish to achieve with the software, and the
different ways in which these can be done. There may be several ways to get the same
result, for example modules can be added or deleted using several different methods.

How do I...?

Instructions

Create a new system

Creating a new project

Set up the communication port

Transfer setup dialog

Read the configuration from the SLICE
hardware

Get system

Use the module configuration window

Details of module configuration window

Add modules to the configuration

Adding the module with the "Add module"
screen

Adding the module with the "Wizard area"

Delete modules from the configuration

Deleting a module

Deleting all modules

Rearrange the modules in the configuration

Drag and drop modules

Rearrange modules

Drag and drop

Set module parameters

Parameter setting

Download parameters to several modules
at once

Parameter block write

Compare parameter details with those
stored in another project file

Verifying the projects

Compare parameter details with those on
the SLICE hardware

Uploading / downloading the parameters

Copy modules from another configuration
file

Copying the module information

Use GX Configurator-ST for diagnostics

System monitor

Show module details (address ranges)

Module detail information

View module input/output data

Input/Output monitor

Test / calibrate module outputs

Forced output test

Set offset/gain settings for a module

Offset/gain settings

Change the head module type after the
system has been configured

Change head module type
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How do I...?

Instructions

Swap modules while the system is running
(Online module change)

Online module change

Set module options

Option settin

Change module labels

Option settin

Print the configuration

Printing the project data

Check the total power consumption

Power distribution check

Use the toolbar

Details of toolbar

Use the status bar

Status bar

Change to/from edit/online mode

Edit mode operation procedures / Diagnosis

mode operation procedures

Reset the head module

Reset the head module

View the PROFIBUS-DP network
parameters

PROFIBUS-DP network parameter monitor
(PROFIBUS-DP only)

Read the point mode and ‘without Wr' /
'‘without Ww' settings from a connected
system

Reading input/output data settings
(PROFIBUS-DP only)

Change the head module protocol version

Change PROFIBUS-DP head module
protocol version (PROFIBUS-DP only)

View the master station data
communication parameters / data area

Master station data communication monitor

Rearrange the open windows

Display switching and window rearranging
operations

Find out what an error means

Error messages
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3 System Configuration

3.1 System Configuration

MELSOFT

The following shows the configuration where a personal computer is connected to the MELSEC-ST
system.

A C o rator - TG

o] i L e
- iyt

*1 : Use either of the following cables as the RS-232 cable.

Manufacturer name Model name
Mitsubishi Electric QC30R2
Beijer ELECTRONICS SC-Q QC30R2

29
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Operating Environment

The operating environment of GX Configurator-ST is indicated below.

ltem

Description

Computer main unit

CPU

Required
memory

Refer to the following table "Used operating system and performance required for
personal computer".

Hard disk free

60MB or more

space
Disk drive CD-ROMdisk drive
Display 1024 x 768 dot or more resolution

Operating system

Microsoft® Windows® 2000 Professional Operating System (English version)
Microsoft® Windows® XP Professional Operating System (English version) "% 2
Microsoft® Windows® XP Home Edition Operating System (English version) " 2
Microsoft® Windows Vista® Home Basic Operating System (English version) "
Microsoft® Windows Vista® Home Premium Operating System (English version) "2
Microsoft® Windows Vista® Business Operating System (English version) "2
Microsoft® Windows Vista® Ultimate Operating System (English version) "

Microsoft® Windows Vista® Enterprise Operating System (English version) "
Microsoft® Windows® 7 Home Premium Operating System (English version)
Microsoft® Windows® 7 Professional Operating System (English version)
Microsoft® Windows® 7 Ultimate Operating System (English version)
Microsoft® Windows® 7 Enterprise Operating System (English version)

*1:"XP compatibility mode" and "Fast user switching"” are not supported.
*2: 64-bit OS for Windows® XP and Windows Vista® are not supported.
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Used operating system and performance required for personal computer

Operating system

Performance Required for Personal Computer

CPU

Required memory

Windows® 2000 Professional

Pentium® 133MHz or more

64MB or more

Windows® XP
Professional

Windows® XP Home

"XP compatibility mode"
and "Fast user switching"
are not supported.

Pentium® 300MHz or more

128MB or more

Pentium® 300MHz or more

128MB or more

Edition

Windows Vista® Home Basic Pentium® 1GHz or more 1GB or more
Windows Vista® Home Premium Pentium® 1GHz or more 1GB or more
Windows Vista® Business Pentium® 1GHz or more 1GB or more
Windows Vista® Ultimate Pentium® 1GHz or more 1GB or more
Windows Vista® Enterprise Pentium® 1GHz or more 1GB or more

Windows® 7 Home Premium

Pentium® 1GHzor more

1GB or more (32-bit)
2GB or more (64-bit)

Windows® 7 Professional

Pentium® 1GHz or more

1GB or more (32-bit)
2GB or more (64-bit)

Windows® 7 Ultimate

Pentium® 1GHz or more

1GB or more (32-bit)
2GB or more (64-bit)

Windows® 7 Enterprise

Pentium® 1GHz or more

1GB or more (32-bit)
2GB or more (64-bit)

I /@uint

» The following features are not available for use with Windows® XP, Windows Vista® and
Windows® 7. If used, this product may not function normally.

Application startup in Windows® compatibility mode
Fast user switching
Remote desktop

Large fonts (detailed setting in Screen properties)

¢ On Windows Vista® and Windows® 7 authority of USER or higher level must be used.
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Function list

Function list

The functions of GX Configurator-ST are indicated below.

Function Description Reference Section
Sys.tem configuration Registers modules into the system by model name. 'Editing the project’
setting

Parameter Setting

Sets the parameters to the intelligent function module.

'Parameter setting'

Option Settings

Sets the label name, base module etc. for the module.

'‘Option setting'

Power Distribution
Check

Checks whether the 5VDC internal current
consumption of the bus refreshing module is
sufficient.

'Power distribution check’

System Monitor

Monitors the statuses of the head and slice modules.

'System monitor'

Module configuration,
parameter upload/
download

Uploads/downloads the module configuration and
parameters.

'Downloading and
uploading the parameters'

Input/Output Monitor

Monitors the input data and output data.

'Input/Outlput monitor'

Forced Output Test

Tests the Bit Output, Word Output

and Ew.n Error Clear of the head module or slice
module without stopping the PROFIBUS-DP or CC-
Link network.

Forced output test'

Offset/Gain Setting

Sets the offset and gain values of the intelligent
function modules (ST1AD2-V, etc.).

'Offset/Gain setting of
intelligent function modules'

Reset Head Module

Resets the head module.

'Reset head module'

Change head
module type

Changes the head module type (in edit mode).

'‘Change head module type'

Change head
module protocol

Changes the head module protocol version (in edit
mode) - PROFIBUS-DP only.

'‘Change PROFIBUS-DP
head module protocol

version version'
Module Detail Shows the module detail information and monitors , - .

. . Module detail information
Information the corresponding module error status.
Online Module Changes the I/O module or intelligent function module] .~ . .

. ) Online module change

Change online from GX Configurator-ST.
PROFIBUS-DP Monitors the slave parameters and PROFIBUS-DP

Network Parameter
Monitor

network parameters sentfrom the master station of
PROFIBUS-DP to the MELSEC-ST system to show the
results for confirmation.

'PROFIBUS-DP network
parameter monitor'

Master Station Data
Communication

Monitor

Monitors I/O data between the master station and
head module.

‘Master station data
communication monitor'
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4.2

Menu list

This section explains the menus of GX Configurator-ST.

The menu screens in this section are different from the actual ones.
Actually, some menu items are not selectable depending on the operation status of

For the purpose of explanation, all the menu items are shown as selectable.

|
‘ GX Configurator-ST.
|

[File] menu
The [File] menu includes project file operation, printand
- other functions. For more information, refer to the following
Mew... Chrl+M sections:
Cpen. .. Chrl+0 ]
Close New - create a new project
Open - open an existing project
Save Cirk5 Close - close the project
save As... Save - save the project
] Save as - save the project with another name
Werify, .. - . .
c Verify - compare modules with another project
OR Copy - copy module information from another project
Print. . ChpP Print - pr_intthe project data _
Recentfiles - open a recently-used project
1 Sample. st Exit - close GX Configurator-ST
2 Sample.st
3 Sample. st
4 Sample. st
Exit
[Edit] menu
;- 5 The [Edit] menu includes the functions for module
" configuration setting and parameter setting. For more
Undo Chrl4+-Z information, refer to the following sections:
Redo el
Undo - reverse the last edit operation
add... Chrl+Insert Redo - reverse the last undo operation
Rearranae. .. Add - add a module to the configuration
Rearrange - change the order of modules
Delete Ctrl+Delete Delete - delete a module
&l Delete Shift+Del All delete - delete all modules
Parameter setting - change module parameter settings
Parameter Setting... Fa Option - change module options
Change head module - change head module type
Cpion. . . F10 Power distribution check - test power consumption
Change head module
Power Distribukion Check,

33
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[View] menu

The [View] menu includes the function to display/hide each
screen.

todule Configuration

Initialize Module Configuration View Position ) . ) . )
Refer to 'Display switching and window rearranging

operations' for details of each menu item.

Systern Monikar

Toolbar
Skakusbar

[Mode] menu

m The [Mode] menu includes the functions to switch between
the edit mode and diagnosis mode.
* Edit Fz
Diagnasis F3 Refer to 'Edit mode operation procedure’ for details of the

[Edif] menu item.

Refer to 'Diagnosis mode operation procedure’ for details
of the [Diagnosis] menu item.

[Online] menu

The [Online] menu includes the functions for connection to
the head module and online operation of the head module.
Transfer Sefup... For more information, refer to the following sections:
Get Jyskem o
(Get Input/OutpUt Data Settings Transfer setup - select communication portto use
Get system - read configuration from connected MELSEC-
Inpukioutpat Manitar.., ST system

Forced Qutput Test. .,

Get input/output data settings - read input/output data
Offset/Gain Setting. ..

settings from MELSEC-ST system (PROFIBUS-DP only)
Parameter Block \Write. .. Input/Output monitor - monitor module input/output data

Forced output test -
Reset Head Module Forced output test - test outputs / error clear

Offset/Gain setting - change offset/gain settings
Parameter block write - download parameters as a batch

Reset the head module - restart the head module

|[Diagnostics] menu
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The [Diagnostics] menu includes the functions to diagnose
the system. For more information, refer to the following
sections:

Module Detail Infarmation. ..
Online Module Change. ..

PROFIBUS-DP Mekwiork Parameter Monikar ...

) - ) Module detail information - show more details of a module
Master Station Daka Communication Monitar. ..

'Online module change' - swap outa module

'PROFIBUS-DP network parameter monitor' - view or export|
network parameter data

'Master station data communication monitor' - view head
module data areas
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[Window] menu

Window

Cascade

Tile Yertically

Tile Horizontalky
Arrange Icons
Close all windows

v

1 Sysktem Maonibor
2 Parameter Setting Mo.4

The [Window] menu includes the functions to change the
screen layout of GX Configurator-ST.

Refer to 'Display switching and window rearranging
operations' for details of each menu item.

menu

[Help]

Conktents
ket Operation Lisk,..

Aboutk, .,

The [Help] menu includes the functions to show the online
help, operate the GX Configurator-ST keys and confirm the
software version.

Contents Shows the help file starting at the cd

Key Operation List Shows the key operation list page.

About Shows the version number, copyrig
information.
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5 Operation Procedures

5.1 Precautions when using GX Configurator-ST

This section provides precautions when using GX Configurator-ST.

(1) A communication error may occur if communication is made with the MELSEC-ST system
after setting of the resume function, suspend setting, power-saving function or standby mode
of the personal computer.

For this reason, do not set any of these functions before starting communication with the
MELSEC-ST system.
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5.2 Edit mode operation procedure

Create a new project, and edit and download it to the MELSEC-ST system.

!

Start GX Configurator-ST .. Refer to 'Starting GX Configurator-ST

'

Is a new project No
created?
Yes
... Refer to 'Opening an existing
Open the existing project I project’
Connect the personal computer and
head module ... Refer to
‘Transfer setup'
l Set the system configuration I Refer to 'Editing the project’
Get various information from the
head module ... Refer to
‘Get system’
Set the parameters of the intelligent . .
i function module ... Refer to 'Parameter setting
Set the parameters of the intelligent ... Refer to
function module . .
Parameter setting
Connect the personal computer and , ,
l head module ... Refer to 'Transfer setup
Download the various information to \ o
the MELSEC-ST system ... Refer to 'Parameter block w rite!
Printthe project data ... Refer to 'Printing the project data’

5.3 Diagnosis mode operation procedure

Confirm the error status and take corrective action, or perform the monitor/test, etc. of /O data.

38



5 Operation Procedures MELSOFT

(1) Preparations for diagnosis mode
Make preparations for operation in the diagnosis mode.
Perform the following operation before starting operation in the diagnosis mode.

< Start ;

] .. Refer to 'Starting GX Configurator-ST
Start GX Configurator-5T

Connect the personal computer and -~ Refer to Transfer setup’
head module

Get various information from the .. Refer to ‘Get system
head module

] ] ... Refer to 'System monitor'
Change to the diagnosis mode

!

End

(2) Diagnosis mode operation procedure
Perform the operation explained in the reference section for each purpose of use.
Before starting the diagnosis mode operation, perform the operation in (1) of this section.

Purpose of use Reference section

To monitor the MELSEC-ST system.
To confirm the module where an error occurred.

'System monitor'

To confirm the error definition. 'Module detail information’

To setthe offset and gain values. Offset/Gain setting of mtlelllgentfunctlon
modules

To confirm the /O data. 'Input/Output monitor'

To conduct the forced output test. 'Forced output test'

To monitor the master station data communication. Masier station data communication

monitor'
. ' -
To monitor the PROFIBUS-DP Network Parameters. el e i
monitor
To reset the head module. 'Reset head module'
To change the module online. 'Online module change'
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Installation and uninstallation

This chapter explains how to install and uninstall GX Configurator-ST.

Installation

Installation procedure

( Installation start ;

Installation of product
- Register the user name and company
name .. Refer to 'Installing GX Configurator-ST'

- Register the product ID

'

Start of GX Configurator-ST
- Check that GX Confiqurator-ST has been
installed correctly.

( Completion ;

| .. Refer to 'Starting GX Configurator-ST'

MELSOFT
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6.1.2 Installing GX Configurator-ST

The following indicates how to install GX Configurator-ST.
Microsoft® Windows® XP Professional Operating System is used for explanation in this section.

m_Bhint

(1) Before starting installation, exit all other applications operating on Windows®.

(2) The installer may not work normally because the update program of the operating
system or another companies software such as Windows® Update and Java Update
may start automatically. Please install the driver after changing the settings of the
update program not to start automatically.

(3) When installing GX Configurator-ST on any of the following operating systems, log on
using an administrator account (computer manager).

* Microsoft® Windows® 2000 Professional Operating System
* Microsoft® Windows® XP Professional Operating System

* Microsoft® Windows® XP Home Edition Operating System
* Microsoft® Windows Vista® Home Basic Operating System
* Microsoft® Windows Vista® Home Premium Operating System
* Microsoft® Windows Vista® Business Operating System

* Microsoft® Windows Vista® Ultimate Operating System

* Microsoft® Windows Vista® Enterprise Operating System

* Microsoft® Windows® 7 Home Premium Operating System
* Microsoft® Windows® 7 Professional Operating System

¢ Microsoft® Windows® 7 Ultimate Operating System

* Microsoft® Windows® 7 Enterprise Operating System

(4) Check whether or not GX Configurator-ST has been installed on the personal computer. If
it has already been installed, uninstall it, restart the personal computer, and then install
this software.

(1) Installing GX Configurator-ST
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& GX-ST Installer

File Edt View Favortes Tooks Help F]

Qo - @ - F Osesrsh [ rocers | [T

setup
File and Folder Tasks Setup Launcher
¥ pitsubishi Electric Europs by,
3 Make a new falder -
&8 Publish this folder to the
Wab

{52 Share this Folder

Other Places

@ Desktop

() My Documents

W My Computer
8 My Network Places

Details

'

(To the next page)

1) After powering on the personal computer,
start Windows®.

2) Start Windows® Explorer and click the drive
where the disk is inserted. Double-click
"Setup.exe" (@).

To display Windows® Explorer, choose
[Start] = [All Programs] = [Windows
Explorer].
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(From the previous page)

User Account Control ==
N
@ An unidentified program wants access to your computer

Don't run the program unless you know where it's from or you've used it
before.

< Cancel

I'den't know where this program is from or what it's for.

setup.exe
Unidentified Publisher

< Allow

Itrust this program. I know where it's from or I've used it before.

() Details

User Account Control helps stop unauthorized changes to your computer.

'

i GX Configurator ST 1.08J - InstallShield Wizard X

wWelcome to the InstallShield Wizard for GX
Configurator 5T 1.08]

The InstallshisldiR) Wizard will install G¥ Configuratar 5T 1,08
on your computer, To continue, dick Next,

WARNING: This pragram is protected by capyright law and
international treatizs,

Next = ] [ Caneel

5 GX Configurator, ST 1.08J - InstallShield Wizard

License Agreement "-' i

Please read the Following license agreement carefully,

ENDUSER LICENSING AGREEMENT for the MELSOFT software package #

The software package contains software under copyright. Use of the
software without prier conclusion of this licensing agreement is illegal
and subject to prosecution by MITSUBISHI ELECTRIC EUROPE B.V. This
licensing agreement is concluded upen the user signing the enclosed
ENDUSER SOFTWARE SERVICE CARD. This agreement is concluded
het MITSUBISHI ELECTRIC EUROPE B.V. and the enduser,
hereinafter referred to as "Licensee™.

1 Puw maane of thic aaraarmant MITCIIRICHI FI ECTRIC FIHROPFE B A V

()1 accept the terms in the license agreement

(01 do not accept the terms in the license agreement

[ < Back ” Next = ] [ Caneel

'

(To the next page)

3) (When using Windows Vista® or Windows®
7)
When the screen on the left is displayed,
click “Allow”.

4) On the left screen, click the Next button.

5) Read and agree to the licence terms.

Then, click the Next button.

Note: This dialog is only shown for
European product versions.
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(From the previous page)

5 GX Configurator, ST 1.08J - InstallShield Wizard

Customer Information

Please enter your information,

User Name:
‘User

Crganization:

‘Company

Serial Mumber:

[ < Back ” Next = ] [ Caneel

5 GX Configurator, ST 1.08J - InstallShield Wizard

Destination Folder 1 "
Click Nezxt ka install ko this Falder, or dick Change to instal to a different Folder, I <
Install GX Configurator ST 1.087 ta:
CAMELSEC G Configurator 5T 1.087%
[ < Back ” Mesk = ] [ Cancel

i GX Configurator, ST 1.08J - InstallShield Wizard

Ready to Install the Program

The wizard is ready to begin installation. <

Click Install to begin the installation.

IF yiou want ko review o change any of your installation settings, click Back, Click Cancel to
exit the wizard,

[ < Back ” Install ] [ Cancel

'

(To the next page)

6) Enter a user name, company name and
serial number (where applicable), then

click the Next button.

7) Specify an installation destination folder.

Then, click the Next button.

The default is set to "C:\MELSEC\GX
Configurator ST 1.**". ("**" represents a
version number.)

To change the default setting, click the

Change button and specify a preferred

drive and folder.

8) Clicking the Install button will start
installation.
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(From the previous page)

i GX Configurator, ST 1.08J - InstaliShield Wizard 3] 9) The left screen indicates that the installation
InstallShield Wizard Completed is Completed-

Click the Finish button.

The Installshisld Wizard has successFully installed GX
Configurator ST 1,081, Click Finish ko exit the wizard,

< Back Caniel

!

(Completion)

Installing GX Configurator-ST registers the icon as shown below.

All Programs B | G MELSOFT Application f8 G Corfigurator ST 1,081 ¢ | e gl Me de =y @ W3]

) . Ta MELFAMSweb Homepage
ﬁ| Lag Off (D) | Turn OFF Computer

Uset's Manual

'J start

REMARK

When any of the following operating systems is used, the registered icon is placed in the menu that
appears by selecting [Start] > [Programs] - [MELSOFT Application].

* Microsoft® Windows® 2000 Professional Operating System
* Microsoft® Windows® XP Professional Operating System

* Microsoft® Windows® Vista Operating System

* Microsoft® Windows® 7 Enterprise Operating System
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6.2

Uninstallation

This section explains the operation for removing GX Configurator-ST from the hard disk.
The screens used for explanation in this section are those of Windows® XP Professional.
Though they differ slightly from the screens of Windows® 2000 Professional or like, refer to

REMARKS and perform installation.

¥ Control Panel

= ‘ Pick a category

B swicch to Classic View .
See also [ >

& Windows Update
@) Help and Suppart:

ecurity Center

B Add or Remove Programs

(To the next page)

1) Double-click "Add or Remowve Programs" on
the Control Panel.
To display the Control Panel, choose
[Start] > [Control Panel].

REMARKS

When using any of the following operating
systems, double-click "Add or Remowve
Programs". To display the control panel,
choose [Start] > [Settings] = [Control
Panel].

* Windows® 2000 Professional
* Windows® XP Professional

For Windows Vista® and Windows® 7, click
"Uninstall a program" on the Control Panel.
To display the Control Panel, select [Start]
-> [Control Panel].

2) Choose "Change or Remowve Programs" and
then "GX Configurator ST Version 1.
* (Y rapresents a version number).

After selection, click the L RE&Move

button.
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(From the previous page)

Add or. Remove Programs

\_‘.:J Are you sure you want ko remove G Configurator ST 1,083 From your compuker?

‘es ] [ Mo

'

User Account Control ==

@ An unidentified program wants access to your computer

Don't run the program unless you know where it's from or you've used it
before.

setup.exe
Unidentified Publisher

< Cancel

I'den't know where this program is from or what it's for.

2 Allow

Itrust this program. I know where it's from or I've used it before.

() Details

User Account Control helps stop unauthorized changes to your computer.

!

(Completion)

3) Confirm that the program should be
uninstalled.

Clicking the button starts
uninstallation.

Clicking the button stops

uninstallation.

4) (When using Windows Vista® or Windows®
7)
When the screen on the left is displayed,
click "Allow".
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This section explains how to start GX Configurator-ST from the start menu.

All Programs B

rator ST 1.081 ¥

FEESVEINA 3 G Configurator ST 1.081
To MELFANSweb Homepage:
User's Manual

£ MELSOFT GX Configurator-ST

Fle Edt View Mode Online Disgnostics Window Help

] T e e = T e

M Module Configuration

For the new system, do you want to:

W Head the system from the,

I~ Open an existing fle

I Build the system configuration offine

1) Mowe the cursor from [Start] >
[All Programs *1] >
[MELSOFT Application].

*1: [Programs] is displayed when any of
the following operating systems is
used.

* Windows® 2000 Professional
* Windows® XP Professional

2) Click [GX Configurator ST **]
("**" represents a version number).

3) GX Configurator-ST starts.
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REMARK

Multiple GX Configurators-ST can be started to use.

Since different projects can be opened on multiple GX Configurators-ST, multiple projects can be
browsed simultaneously.

The same project cannot be opened from multiple GX Configurators-ST.

When multiple GX Configurators-ST are started, GX Configurators-ST started second and later have
the following restrictions.
1) The diagnosis mode cannot be used.

The [Mode] - [Diagnosis] menu (@\) cannot be clicked.
2) Get System cannot be executed.

The [Online] > [Get System] menu (Iﬁ) cannot be clicked.
3) Parameter Block Write cannot be executed.
The [Online] - [Parameter Block Write] menu cannot be clicked.
4) Parameter upload, download and \erify cannot be executed on the Parameter Setting screen.

The | Upload ‘ ‘ Download ‘ and |Verify ‘ buttons cannot be clicked.

GX Configurator-ST started first can perform the following operation since the abowve restrictions do
not apply.

Even when GX Configurator-ST started first is exited, the above restrictions still apply to all

GX Configurator-ST instances that have started.

To remowe the restrictions, restart GX Configurator-ST after exiting all the remaining GX Configurator-
ST instances.
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6.4  Exiting GX Configurator-ST

This section describes how to exit GX Configurator-ST.

(1) From menu

=" MELSOFT GX Configu
Edit View Mode Onli

MNew. .. Chrl4+N
Open... ChHrl4+0 L
on F Click the [File] = [Exit] menu.
GX Configurator-ST ends.
dule
1 samplel
2 sample2

(2) From "Titlebar"

& MELSOFT GX Configura

aliru
Move LJ
= | Click 8 and choose [Close].

= Minimize | . . . " "
Alternatively, click £ at the right end of the "Titlebar".

O Maximize

X Close Alt+F4 |t

m_Boin

(1) While the print preview is displayed, GX Configurator-ST cannot be exited.
Exit GX Configurator-ST after closing the print preview.

(2) Do not restart or shut down your personal computer during GX Configurator-ST operation.
Exit GX Configurator-ST before restarting or shutting down the personal computer.
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REMARK

When a project is newly created, or modified but not yet saved, a dialog box appears asking whether
the project will be saved or not.

When not saving it, click the button.

When saving it, click the button.
When saving a new project, name the project.
Refer to 'Save as' for details.
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7.1

Screen layout and display switching

This chapter explains the screen layout of GX Configurator-ST and the display switching of each
area.

Screen layout

The screen layout of GX Configurator-ST is shown below.

Titlebar

Screen minimize button

Menubar Screen maximize button

Dropdown menu Exits
Toolbar GX Configurator-5T

Module
configuration Window
window
Bo [She| Sobdehae | BINEL [SoF ] W0 [=wFED | Libebaw -
Statusbar
Name Description

Displays the file name of the open project.

When two or more GX Configurator-STs have been started, "Edit Mode only" is

displayed before each file name of the second and later ones.

£ MELSOFT GX Configurator-ST Edit Mode only

Titlebar ' - ' ' - -

When "Window" on GX Configurator-ST is maximized, the name of that "Window"

is displayed.

&' MELSOFT GX Configurator-ST {Untitled) - [Parameter Setting No.3]

Menubar Clicking each menu opens the corresponding "Dropdown menu". Then clicking a

"Dropdown menu" item will execute the corresponding function of

GX Configurator-ST.
Dropdown menu Refer to 'Menu list' for details.

Click any of the buttons to execute the corresponding function of GX Configurator-
Toolbar ST.

Refer to 'Details of toolbar' for more information.
ESL?;” minimize Click this button to minimize GX Configurator-ST.
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Name

Description

Screen maxmize
button

Click this button to maximize GX Configurator-ST.

Exits GX Configurator-
ST

Click this button to exit GX Configurator-ST.

Module configuration

This initially shows a configuration wizard. Once a configuration is being edited it
will display a list of modules registered to the project, graphicallyand as a list.
Double-click a module to setthe parameters.

Right-click the module to display the menu, and select a menu item to execute the

window corresponding function.
Use ‘drag and drop’ in the graphical displayto rearrange modules.
Use the ‘Wizard’ area to add modules.
Refer to 'Details of module Configuration window' for more information.
Displays the "Parameter Setting" screen, "Result Verify"* screen, etc. Use \ﬂh
Window to switch to the next window, or ++ to switch to the previous
window.
When the mouse pointer is moved over each "Dropdown menu" item, the
corresponding explanation is displayed.
The following information is also displayed.
Statusbar « Current mode of GX Configurator-ST

« Station number or FDL address of the connected head module in the diagnosis
mode

Ready Diagnosis Maode FDL address 42

7.2  Display switching and window rearranging operations

The following table shows how to display/hide bars and how to arrange windows.

Operation Description

[View] = [Module Configuration Window] [screen.

Displays or hides the "Module Configuration Window"

This operation can be performed in the edit mode only.

View Position]

[View] = [Initialize Module Configuration

Returns the display position of the "Module Configuration
Window" screen to the initial status.
This operation can be performed in the edit mode only.

[View] = [System Monitor] This operation can be performed in the diagnosis mode

Displays or hides the "System Monitor" screen.

only.

[View] = [Toolbar]

Displays or hides the "Toolbar".

[View] = [Statusbar]

Displays or hides the "Statusbar".

[Window] = [Cascade]

Overlays multiple "Windows" opened on GX Configurator-ST.

[Window] > [Tile Vertically] Displays multiple "Windows" vertically.

[Window] > [Tile Horizontally] Displays multiple "Windows" horizontally.

[Window] - [Arrange Icons] Arranges the icons to which windows have been minimized.
Closes all "Windows".

[Window] = [Close All Windows] When a "Window" is being edited, a confirmation message
is displayed.

54



7 Screen layout and display switching

MELSOFT

7.3

Details of toolbar

The buttons included in the Toolbar will be explained.

D& E| & -

| 0 e m| | [he 16 | i

Button Name Description Reference Section
. ! i
D New Creates a new project. —g_(:reatm_ a'new
project
| ' . . e
E- Open Opens the existing project. Opening an existing
project
Sawves the open project, whether it is new or existed . .
Sawve . Save
previously.
% Print Prints the module configuration, module information 'Printing the project
list, and module detail information of the open project. data’
K™} |Undo Restores to the status prior to the last operation. 'Undo’
4 ([Redo Restores to the status prior to the "Undo" operation. '‘Redo'
+u Add Adds a slice module to the project. '‘Adding the module'
:E: Delete Deletes the slice module from the project. 'Deleting a module'
E All Delete |Deletes all slice modules from the project. 'Deleting all modules'
Is= Setting ets the parameters of the intelligent function module. arameter setting
.= Parameter S h fthe intelli functi dul P .,
B |Edit Switches to the edit mode. —
I@ Diagnosis |Switches to the diagnosis mode. —
H9 [Get Uploads the system configuration and the parameters 'Get system'
Let system
t& System |of each module from the head module.
L
l About Displays the software version of GX Configurator-ST. —
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7.4

56

Details of module configuration window

The module configuration window provides a ‘wizard’ to guide the user through the system
configuration. When GX Configurator-ST is first started, this will show the options for creating a

system:

Module Configuration

For the new system, do you want to;

[v Bead the system configuration frarm the communication pork

[ Open an existing file

[ Build the systern configuration offline

Creating a new configuration is described in 'Creating a new project'.

When the configuration is being edited, the window changes to show four separate panes:

M Module Configuration

[ ¢ |5 1617 |l wliili2]1

Rack
L display

140 Occupation Paints  Bit

24 wiord

27 G5D Version: [B | |with carmmand 2

Mo [Slice]|  Module Name

UnusedBits|  BiHEX) | BwHEX] | WiHEX) | WwHEx] | LabelName <]

0 0 STIH-FE 000-12F  00.0-12F —
1 2 ST1PSD g g g

2 B} 5T1x2-DE1 B 13.0-131 2 2

4 12 STIv2R2 [} m g

5 13 STIv2R2 [} g g

B 14 5714024 5 2 148-177  140-14F

7 16 STIDAZY 17.8-187  16.0-18F

8 13 ST1DAT 188-197  14.0-1CF

3 20 ST1551 198-1C7  1E.0-1EF -

To add a moduls before or after the current position, sefect it
frarn the list and click Add"
To remove the curent module, select Delete’.
~
ST1RD2 -
571551 Wizard
sTITDZ area
#- Resarved E
€ Add before + Add after
Delete Add
Mame: STIDAZ-Y
Description:  Analog Dutput module, 2 Outputs, Yoltage, 12 Bit, 1 Module width
Slaks: 1 Wr.0 Bt Module ready
e J : Convert setting completed flag
Slices: 2 J System Area (Fixed to 0)
Bri b Wr.0 : £ Area (Fixed to 0)
B ww.of INfOMAtion “iedtany
i 1 W0 by W] requesk
. W0 Bit 37 otput enable/disable flag
W 3 W, 0 Bik 4: CHz autput enable/disable Flag
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Name Description
Displays a graphical representation of the assembled system. It can be used to
Rack display edit module details or rearrange modules using drag and drop.
The displayitems are described in 'Details of rack display.
Shows the details of the modules, with the address ranges that they will use and
Module list anylabel names assigned to them. The displayitems are described in 'Details of
module list'.
This is a continuation of the wizard screen shown when GX Configurator-ST first
Wizard area starts, and can be used to add or delete modules. For more information, see
'Details of wizard area'.
. This shows the details of the module selected for addition in the wizard area. The
Information area . ) ) - . . . \
displayitems are described in 'Details of information area'.

ii' HELPAN OPERATION

You can

resize the areas by selecting the bars between them, and then clicking and

dragging with the mouse. The size of each area will be saved when the application exits, and

restored

the next time the program starts. It can be reset from the View' menu 'Initialize

module configuration view position' item.

The following shortcut keys are available for use when the module configuration window is

active:

Key

Description

+

Switch to the rack display.

Switch to the module list

+
[]fir]f[=]

Switch to the wizard area

= |z ==
:

Switch between panes, in the order:
Rack display 2 Module list >Wizard area = Rack display

Switch between panes in reverse order:
Rack display = Wizard area = Module list 2 Rack display
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7.4.1 Details of rack display

Displays a graphical representation of the assembled system. This can be useful to provide a quick
visual check for errors, as the graphical display should look like the physical hardware.

DISPLAY/SETTING SCREEN
\ 21 - ST T e e, e

LSRN
Other
modules

Selected
item
[highlighted)

Ty

1 e b Numbers
u

L

Firzt power
supply

noamon
T u

7—‘

" Head
module

i |IC-1F  R-0G | 02-0d

@ DISPLAY/SETTING DATA

Item Description

The rack starts at the left side with the head module, which always occupies
slot number zero. This should normally be followed by an ST1PSD bus
refreshing module, which is always required to provide power to the head
module and the first modules immediately after it.

The graphic for each module is shown in two parts; the upper half depends on
the module type, and the lower half shows the 'base module' which may be
different depending on the type of wiring used.

Modules Left click on a module to select it. It will automatically be selected in the
module list as well. Many actions in the [Edit] menu require a module to be
selected first.

Right click on a module to selectitand show a menu similar to the [Edif]
menu — referto 'Editing the project for details of each menu item. If the
module has a configuration error (such as consuming more power than the
last power supply will provide), this will be shown at the top of the menu.
Clicking on the item will show help on the error.

If there are more modules in the configuration than the window can display,
Scroll bar there will be a scrollbar under the rack which can be used to view the
remaining modules
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7.4.2

Details of module list

This shows a list of modules in the configuration.

fCC-Link systems]

DISPLAY/SETTING SCREEN

3 EaAa E To add a module befare or after the current position, selsct it

from the list and click Add'
Toremove the current module, select Delete’

STivaTEs
Occupied
bit aword limit

STIX1BTEDET-S1FL
= Inteligent moduls

Occupied
bits / words

STIVZTPES
4 Max. Bit 48 Max. Word &

Vet 1 Remote device station  Exp. cyclic setting Single Excl. station count T2

d
i 1/0 Oceupation Painl 28

Module Name [ BiHEX) | Bw(HEX) [} Conﬁgt]turation E(;;_pand;d =]
STIPSD § - setting cyclic setting
ST1DAT 00-03 - 00-01
S;;T;i;l;? 0413 : - s, voltage, 12 B, 1 Moduls width
- = : Selected
2 module
—

ST1TD2 08 - 0B 14-17 00-01
ST1X4-DE1 0C - OF -

ST1AD2V 12-15 18-18 02-03 2 ~

No. [Siice|

/ 1 ]2
2 |3
140 Decup 3 5
Mode | pri 4 13
Mo. |l 5 15
1 6 17
? 719
. L8 20

5 1

E 1

7 19

g 2

12-15 18-18 0z-03 - vl

/

E DISPLAY/SETTING DATA

Item

Description

1/0 Occupation Points (Bit)

The total number of bits used by all the modules in the configuration.

I/0 Occupation Points
(Word)

The total number of words used by all the modules in the configuration.

Max. Bit

The limit on the number of input/output bits with the current optimisation
mode, extended cyclic and stations settings.

Max. Word

The limit on the number of input/output words with the current optimization
mode, extended cyclic and stations settings.

Mode

This gives the optimization mode currently selected, either ‘priority high
speed’ (use more stations so data is read faster) or ‘priority min.

stations’ (reduce the number of stations used at the cost of reading the data
more slowly). This can only be changed for the SLICE system by setting a DIP
switch on the head module itself, although the selection can be changed here
to see what the effect of switching mode would be. When you switch to
diagnostics mode, the current DIP switch setting will be read from the SLICE
hardware.

Configuration setting

This shows the configuration setting you will need to correctly configure the
head module in GX Works2, GX Developer or GX IEC Developer.

Exp. cyclic setting

Byincreasing the number of cycles taken to read the data, the number of
stations used can be reduced, however this means that the data will take
longer to read in total. This value is calculated based on the optimization
mode setting.
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ltem

Description

Excl. station count

The number of stations used for communications. Using more stations
increases the speed at which data is read, but reduces the number of other
devices that can be used on the CC-Link bus. This value is calculated based
on the optimization mode setting.

Listarea

This shows a list of modules in the configuration.

Double click on a module to editits parameter settings (see 'Parameter
setting' for more details).

Left click on a module to selectit—the same module will automatically be
selected in the rack display as well. Many actions in the [Edit] menu require a
module to be selected first.

Right click on a module to selectitand show a menu similar to the [Edit]
menu — refer to 'Editing the project for details of each menu item. If the
module has a configuration error (such as consuming more power than the
last power supply will provide), this will be shown at the top of the menu.
Clicking on the item will show help on the error.

You can alter the widths of columns in the module list by moving the mouse
pointer over the dividing line between two column headings:

When the cursor changes to a vertical double line with arrows on each side,
click and hold the left mouse button, then drag the column divider to its new
position and release the mouse button. The changes you make to the column
widths will be remembered and reapplied each time the application is started.

No the position number for the module, starting with the head module at position
' 0 and the first ST1PSD power supply at position 1.

Slice The Slice position of the module. Some modules can occupy more than one
slice, so this does not always match the number.

Module

Name The type of module, for example ST1PSD.

Br(HEX) The input bitrange used by the module

Bw(HEX) The output bit range used by the module

Wr(HEX) The input word range used by the module

Ww(HEX) The output word range used by the module
A user-defined label for the module. This can be useful to identify modules

Label Name when there are several modules of the same type in the system. For example,
two similar input/output modules could be labelled 'Cabinet 1 wiring' and
‘Cabinet 2 wiring' to tell them apart.

=P

In CCHlink systems, the address ranges are sometimes referred to differently. CClink's

‘RX and 'RY'

ranges are equivalent to the 'Br' and 'Bw' ranges shown in GX Configurator-

ST and CC-link's 'RWr' and 'RWw' ranges are equivalent to 'Wr' and 'Ww'.
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[PROFIBUS-DP systems]

DISPLAY/SETTING SCREEN

Module Configuration,

o | 0] 3 |+ lsl6]7]slsli0]n]iz]13] 14 | 7o .add a module before or after the current postion, select it

from the list and click ‘Add"
= Toremove the curent module, select Delete’

Occupied
bits / words

1/0 Occupation Points Bt | 24 Word| 27 GSD Version: [g W

No. [Slice] ModuleName [UnusedBits|  BiHEX) [ BwiHEX) | WilHEX) | WwHEX) [ LabelName [ =]
00 ST1H-PB : : 00.0-12F | 00.0-12F ||
/| 2 STIPSD - - - -
ooeeall 2 [ 3 ST1%2-DE1 3 13.0-13.1 - - -
T 3 : ST1X16-DE1 - o 2 2 “puts, Woltage, 12 Bit, 1 Module width
:ED 4 12 STIY2A2 3 13.0-131 : 5 e
o fl S L1 stveRe | 6 EEREE - (. moaue
2 B 14 ST14D24 - - - 148-17.7 | 140-14) S e
NN | 7 16 STIDA2Y - . . 178-187 | 160-18F System faea (fixed to )
; 1 8 |18 ST1DAT : o a 188-197 | 1A0-1CF Systom Area (fixed to 0)
e 1L38 20 5T1551 : : : 198-1C7 | 1E0-1EF Tl G e onbedable flag
7

CHE cutput enablefdisable Fag
8 STIDAT o o o 188-197 | 140-1CF
20 571551 s s s 198-1C7 | 1E0-1EF -

@ DISPLAY/SETTING DATA

Item Description

The total number of bits used by all the modules in the configuration. This

cannot be more than the point mode limit (see 'Ogtion setting'z.

1/0 Occupation Points (Bit)

I/0 Occupation Points The total number of words used by all the modules in the configuration. The
(Word) limit on the number of words used varies depending on the point mode.

This dropdown gives information about the protocol version the offline
GSD version configuration is currently set to. By selecting a different value (Version Aor B),

the configuration can be changed.
PROFBUS-DP version A:

This gives the number of points read when communicating with the
PROFIBUS-DP master station. Lower numbers mean that the data is read
Head module mode more frequently, butless data can be read in total. Larger numbers allow
more data to be read, but not as often.

PROFIBUS-DP version B:
This controls whether the head station is used with or without commands.
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Item Description
This shows a list of modules in the configuration.
Double click on a module to edit its parameter settings (see 'Parameter
setting' for more details).
Left click on a module to selectit—the same module will automatically be
selected in the rack display as well. Many actions in the [Edit] menu require a
module to be selected first.
Right click on a module to selectitand show a menu similar to the [Edit]
menu — refer to 'Editing the project' for details of each menu item. If the
module has a configuration error (such as consuming more power than the
last power supply will provide), this will be shown at the top of the menu.
Clicking on the item will show help on the error.
Listarea You can alter the widths of columns in the module list by moving the mouse

pointer over the dividing line between two column headings:
When the cursor changes to a vertical double line with arrows on each side,
click and hold the left mouse button, then drag the column divider to its new
position and release the mouse button. The changes you make to the column
widths will be remembered and reapplied each time the application is started.

No The position number for the module, starting with the head module at position

' 0 and the first ST1IPSD power supply at position 1.

Slice The Slice position of the module. Some modules can occupy more than one
slice, so this does not always match the number.

Module
The type of module, for example ST1PSD.

Name P ' P

.. |JHead module version B only
U d bit . . . .
nusedbiis The number of bits available to use with byte packing

Br(HEX) The input bit range used by the module

Bw(HEX) The output bit range used bythe module

Wr(HEX) The input word range used bythe module

Ww(HEX) The output word range used by the module
A user-defined label for the module. This can be useful to identify modules

Label Name when there are several modules of the same type in the system. For example,
two similar input/output modules could be labelled '‘Cabinet 1 wiring' and
‘Cabinet 2 wiring' to tell them apart.
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7.4.3 Details of wizard area

The wizard area is a continuation of the wizard page which is shown when GX Configurator-ST first
starts. It can be used to add or delete modules.

DISPLAY/SETTING SCREEN

To add a module before or after the current pogition, select it
fram the list and click ‘add"
el Toremove the cument module, select Delete’,

Information

-11
=T = Inteligent modules
: message

ST1aD2
STIADZ [without ')

ST1AD2A Coected
— y ST'I.-’-‘-.DE-V[wit
ST1DAT

STIDAT - [withaut Y]

" Add before Add after

Add
pozition

delste
buttonz

E DISPLAY/SETTING DATA

ltem Description
Information message This shows advice on the current function of the buttons.

This shows the available modules for addition, categorised by type. When a
Module tree module is selected, its details are shown in the information area — see
'‘Details of information area'.

Select this if new modules should be added before the currently selected
Add before . . .
module in the rack display/ module list.

Select this if new modules should be added after the currently selected
Add after ) . .
module in the rack display/ module list.

If there are no modules left other than the head module and first bus
Back button [notshown]  lrefreshing module, the button will allow you to return to the head
module selection page of the wizard.

This can be used to delete the module which is currently selected in the
module list/rack display.

Add button Adds a module to the configuration.

Delete button
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7.4.4 Details of information area

When a module is selected for addition in the wizard area tree, the information area shows the
details of the module.

fCC-Link systems]
DISPLAY/SETTING SCREEN

Jo] 1 | 2 [3]4]5]6] 7 T e TRl S 7 e D e o Uy, s
from the st and click ‘dd
Ta remove the current moduls, selsct 'Delste’

= Inteligent modules
ST14DZ1
ST1AD2Y

S5 Module 11-F01
) name ST1DAZY
MName: STIDA1-1
Description:  Analog Output module, 1 Output, Current, 12 Bit, 1 Module width

Slats: 1 Br Bit 1: Module ready
Slices: ! Br Bit 2: Convert setting completed flag
ices: 2 Br Bit 3: System Area (fixed to 0)
140 Occupation Points— Bit | 30 Word 2 Max Bit | 48 Max Word E| Br: 4 ! . Br Bit 4: System Area (fixed to 0)
Mode | Priority high speed | Mer.1 Remote Device Station  Exp. cyclic sefting Single Bw: 4 e Syster ArobE ule width
No. [Slice] ModuleName | BiHEX) | Bw(HEX] | “WiHEX) | Module W - Buw Bit 2: Convert settiniy~eguest
] 0 STIHET . . . detail W 2 Bw Bit 3: CH1 output enabi -edflag
2 STIPSD . . ealls ' Buw Bit 4: System Area (Fixes ]

3 | STIXISDE1 00-0F -
Status bit

1
2 . . ,

3 [n sT1AD2Y 10-13 00-03 | 00-O -

43 ST1XZDET 14-15 - - - Module detail

5 14 ST1DATH 16-13 04-07 - 00-01 graphic E— —

E | 16 STIX4DET 141D - - -

7 |18 | STIVIBTEZ = . . \

E DISPLAY/SETTING DATA

Item Description
Name The module name (type)

Areadable description of the module - this can be useful to identifya module
when two modules have similar names

A graphical representation of the top part of the module as it will appear in the

Description

The module graphic

rack
Slots The number of slots that will be occupied by the module
Slices The number of slices that will be occupied bythe module
Br The number of input bits occupied
Bw The number of output bits occupied
Wr The number of input words occupied
Ww The number of output words occupied
Status bit detail This gives more detailed information about the status bits used by the module
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i- /@aint

In CC-link systems, the address ranges are sometimes referred to differently. CClink's
'RX and 'RY' ranges are equivalent to the 'Br' and 'Bw' ranges shown in GX Configurator-
ST and CC-link's 'RWr' and 'RWw' ranges are equivalent to 'Wr' and 'Ww'.
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[PROFIBUS-DP systems]
DISPLAY/SETTING SCREEN

B Module Configuration,

Mo [o] 1 | 2 [3]4]5]6] 7 To add a module before or after the current pasition, select it
= l from the fist and click ‘dd'

Toremove the current module, select Telste’

ST14D21
ST1AD2H withaut Win)
ST14024

STIAD2{without ]

i
= Inteligent madules
|

ST1DA1-1
Description:  &nalog Output module, 1 Output, Current, 12 Bit, 1 Module width

Slots: 1 Br it 1: Module ready
Br Bit 2: Convert setting completed flag
Slices: 2 Br Bit 3 System Area (fixed to 0)
1/0 Decupation Points— Bit | 52 Ward 2 GBSO Version: |4 | [256-pt mode - Br: 4 b Br Bit 4: System Area (fixed to 0)

No. [Slice] ModuleMame | BilHEX) | BwHEX) | WiHER] | WalHEXI | B 4 Bw Bit 1: System AreSi [
0 0 STIHFE o003 00-03 - Modul Wr: 2 Bw Bit 2: Convert settiny equest
1z STIPSD 04-05 04-05 = LCellE Bw Bit 3: CHI output enabi, edflag
2 | 3 STIXI6DE1 05-15 06-15 E details Wy 2 Bw Bit 4: System Area (fixed )]
EN KT STIADZY 1619 1619 00-01
413 STIM2DET 1418 1618 - - Status bit
5 |14 STIDAT 1C-1F 1C-1F = w-0 detail
G ST14DE 2 = =

16 20-23

ST1Y16-TE2

E DISPLAY/SETTING DATA

ltem Description
Name The module name (type)

Areadable description of the module - this can be useful to identifya module
when two modules have similar names

A graphical representation of the top part of the module as it will appear in the

Description

The module graphic

rack
Slots The number of slots that will be occupied by the module
Slices The number of slices that will be occupied bythe module
Br The number of input bits occupied
Bw The number of output bits occupied
Wr The number of input words occupied
Ww The number of output words occupied
Status bit detail This gives more detailed information about the status bits used by the module

66



7 Screen layout and display switching MELSOFT

8 Project creation

This chapter explains how to create the project of GX Configurator-ST.
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MELSOFT

8.1 Creating a new project

® PURPOSE

Creates a new project.

BASIC OPERATION

(1) When GX Configurator-ST is first started, a ‘wizard’ page is shown automatically.
If you have a configuration file open, you can also return to this page by clicking

the [File] = [New] menu (D) or pressing the + IEl keys on the
keyboard.

M Module Configuration

For the nevs spstem, do pou want to:

v Bead the system configuration from the communication pork

[” Open an existing file

[~ Build the spstem configuration offine

(2) Select ‘Build the system configuration offline’ and click to show the

protocol selection page.

M Module Configuration

B[(=1[ES)

Fleasze zelect the protocol used by the head module, then click 'Mext'

G50 Yersion

{* “erzion B withaut command
" ersion B with command
" Wersion A

<< Back | Mext > |
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3)

Select the protocol used by the head module (PROFIBUS-DP for the ST1H-PB
module, or CC-Link for the ST1H-BT module). For PROFIBUS-DP the protocol
version (A, B with command, B without command) can also be selected using

radio buttons. After selecting the protocol and version, click .

This displays a new project on the "Module Configuration Window" screen.
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8.2 Opening an existing project

® PURPOSE

Reads a sawed project.

2 BASIC OPERATION

(1) Either:
Click the [File] = [Open] menu (ﬁ) or press the + @ keys on the

keyboard, or
At the first wizard page (normally shown when GX Configurator-ST starts), select

‘Open an existing file’ and click .

(2) On the opened screen, select the project to be opened, and click the
button. This displays the selected project on the "Module Configuration Window"
screen.

DISPLAY/SETTING SCREEN
Open @gj

Look in: | 3 SLICE | o5 B~
_JEMP

_] samplel

File name: || DOpen

Files of type: | GiX Configurator-ST File[*.st) | Cancel

E DISPLAY/SETTING DATA
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Item Description
Look in Select the directory that stores the project to be opened.
File name Set the file name of the project to be opened.
button Opens the project specified at "File name".
Cancel button Closes this screen without opening the project.

8.3 Closing the project

PURPOSE

Closes the currently open project.

BASIC OPERATION

(1) Click the [File] = [Close] menu.

(2) When closing a project that includes unsaved changes, i.e., newly created project
or changed existing project, a screen appears asking whether the project will be
sawved or not.

MELSOFT GX Configuraior-S5T

' E Save changes bo {Unkitled)'?
L

When not saving it, click the button.

When saving it, click the button.
When saving a new project, nhame the project.
Refer to 'Save as' for details.

(3) When closing an unchanged existing screen, the following screen appears asking
whether the project will be closed or not.

MELSOFT GX Configurator-ST (3¢

] "_n.' Do vou want to close the file?
L

Click the button to close the project.
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8.4  Saving the project
8.4.1 Save

PURPOSE

Sawes the open project, whether it is hew or existed previously.

BASIC OPERATION

Click the [File] > [Sawe] menu (E) or press the + keys on the keyboard.
For a new project, name and sawe it.
Refer to 'Save as' for details.
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8.4.2 Save as

PURPOSE

To name and save the open project.

BASIC OPERATION

(1) Click the [File] > [Sawe As] menu.
(2) On the opened screen, select the destination directory, set the file name, and click

the button.

DISPLAY/SETTING SCREEN

Save As @
Savein: | = SLICE j £% Ea-
CIEMP
[*] sample1
File pame: |
Save aslype: |GX Configurator-ST File["st) = Cancel

@ DISPLAY/SETTING DATA

Item Description
Save in Select the directory that stores the project.
File name Set the file name of the project to be saved.
Save button Saves the project with the file name specified at "File name".
Cancel button Closes this screen without saving the project.
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8.5 Verifying the projects
Verify two projects against each other to check whether the parameters are consistent or not.

There are the following two different verify methods.

(1) n:nverify
Verify all modules of the same No. between the open project and saved project.
Refer to 'n:n verify' for details of the verify operation.
Refer to 'Verify result' for details of the erify result.

(2) 1:nverify
Select one module from one of two projects, select multiple modules from the other project,
and erify the one module of the former project against the multiple modules of the latter
project.
Refer to 1:n verify' for details of the verify operation.
Refer to Verify result’ for details of the verify result.

8.5.1 n:nverify

® PURPOSE

Verifies all modules of the same No. between the open project and saved project.

BASIC OPERATION

(1) Clicking the [File] = [Verify] menu displays the "Verify" screen.
(2) Open the <<Verify All Modules>> tab.

(3) Click the Browse button and specify the erification destination project.

(4) Clicking the Execute button starts verify, closes this screen, and displays the

result.
Refer to 'Verify result’ for details.
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DISPLAY/SETTING SCREEN

Verify

Yerification D estination File

Drive/Path |E:\MELSEE'\SLIEE

MELSOFT

Cloze |

File M arme |'\-"erif_l.J5 arnpledb

Werify All Modules | verify Selected Modules

Werify all
modules tab

Yerification Source

Mo, | Slice bd cduile: M ame i
1] 1] STIH-BT
1 2 ST1PSD
2 3 ST1DAZY
3 5 ST1RD2
4 7
5 ¥ Source
G modules
7 .INEL‘,I_HEI"It file
a 15 ST1551
9 17 ST1DAZY
10 ] 19 ST1RDZ2
11 21 ST1DAZY -

Browse. .. |

Execute
Werification Destination
Ma. | Slice Module Mame —
1] i STIHEBT
1 2 ST1PSD
2 3 ST1DAZY
3 ] STIRDZ
4 7 1AD 2N
5 8¢ Destination 531
B | 11 modules
7 1§\I‘t_arget filer]
a 15 T1551
9 17 STIDAZY
0 | 19 STIRDZ
11 21 STIDAZY -
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@ DISPLAY/SETTING DATA

Item Description
Verification Destination File  |Specify the verification destination project.

Displays the drive and directory that stores the verification destination

Drive/Path
project specified with the Browse button.

Displays the file name of the verification destination project specified with
the

button.

Specifies the project.
MOWSE | ytton Operation is the same as opening the existing project.
Refer to 'Opening an existing project for details.

File Name

Close button Closes this screen without verifying the projects.
<<Verify All Modules>> tab Performs n:n verify.
Execute button [Verifies the projects, closes this screen, and displays the verify result.
*1 Refer to Verify result’ for details of the verify result.

Verification Source *2  |Displays a list of all modules of the open project.

Verification Destination *2 |Displays a list of all modules of the verification destination project.

*1: The Execute button cannot be clicked if the open project and \erification destination project

differ in system configuration.

*2: As this verification is conducted to check parameter inconsistency, the module without
parameters is grayed out and is not verified.
The module with uploadable parameters is \erified, even if the parameters are not editable.
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8.5.2 Verify result

ﬂb PURPOSE

Confirms the erify result displayed by n:n verify or 1:n verify.

) BASIC OPERATION

(1) The module having inconsistent parameters in the verify result is displayed red in
the verified module list.
To display the inconsistent parameters, click the module displayed red.

(2) To change the parameters, double-click or select the corresponding module and
click the ‘ Parameter Seﬂmg ‘ button.

(3) To close this screen, click the & button.

DISPLAY/SETTING SCREEN

VYerification Source Fle: |Untitled
Verlfication Destination File: [E:\ME LSECHSLICE \sample?
MofSic) | ModueNamelSie) | MoDst) | ModueMamelDs) | Mimatchltems | = . .

5 STIADZY 2 STIXIEDE] | Verified module list

5 3 STIVIE-TPES oo o

G STiDAZY -

Parameter Setting. ..
Inconsistent parameter list

Mo, Item Vesify Sowce Seiting Yalue

erify Destir

1 Average number 4 8

2 Upper upper imit vaiue 4000 2000
3 Upper lower bmit vale 4000 2000
4 Lower upper imit value -4000 -2000
5 Lower lower fmit value -4000 -2000
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@ DISPLAY/SETTING DATA

Item

Description

Verification Source File

Displays the file name of the verification source project.
"Untitled" is displayed when a newly created and unsaved project has
been set.

Verification Destination File

Displays the file name of the verification destination project.

Verified module list

Displays a list of modules verified.

The module having inconsistent parameters is displayed red.
Double-click that module to change its parameters.

Refer to 'Parameter setting’ for details.

No. (Src) Displays the No. of the verification source module.
Module Name (Src) Displays the model name of the verification source module.
No. (Dst) Displays the No. of the verification destination module.

Module Name (Dst)

Displays the model name of the verification destination module.

Mismatch Items

Displays the number of items whose verify resultis inconsistent.
"----"indicates that the "Module Name(Src)" and "Module Name(Dst)" are
different modules.

| Parameter Setting |

button

Changes the parameters of the module selected in the verified module
list.

Refer to 'Parameter setting’ for details.

The targetis an open project.

Inconsistent parameter list

Displays the parameters that were inconsistent as a result of verify in the
module selected in the verified module list.

No.

Displays the serial number.

Item

Displays the parameter name.

Verify Source Setting
Value

Displays the parameter value of the verification source module.

Verify Destination
Setting Value

Displays the parameter value of the verification destination module.

MELSOFT
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8.5.3 1:nverify

PURPOSE

Selects one module from one of two projects, selects multiple modules from the other
project, and erifies the one module of the former project against the multiple modules
of the latter project.

BASIC OPERATION

(1) Clicking the [File] - [Verify] menu displays the "Verify" screen.
(2) Open the <<Verify Selected Modules>> tab.

(3) With the Browse button, specify the verification destination project.

(4) With the "Select Verification Source File" radio button, select the project that
includes the verification source module.

(5) With the button, select the verification source module.

(6) With the | Add ‘/ | Delete | button, select the verification target module.

(7) Clicking the Execute button starts erify, closes this screen, and displays the

result.
Refer to Verify result' for details.

DISPLAY/SETTING SCREEN

Select
wverification

source file 4
B
Werify selected w
modules tab

Yerification Destination File
Drive/Path :  |CMAELSECKNSLICE

Close

File Mame : [VerifySample3b

Start
comparizon

Werify &ll Modules  Yerify Selected Modules

Select Verification Source File

* Opened File

" Werification Target File

Execute

Opened File Select whick file to use Verification Source Module
3z the zource Selected
Mo, | Slice Module Mame ™= Mo, | Slice b odule M arme FOUMCE
a a ST1H-FB N 3 1 ST1ADZ module to
- comoare
1 2 STIPSD Add N
2 £ Sl Werification Destination Module
Madules in -
current file Mo, | Slice Module Wame
g 11 | ST14D2M
Werification Target File
- Selected target
Mo, | Slice td odule Marne - o modules] to
ol o 5T1H-PE Delete compare againzt
1 2 STIPSD R
2 3 ST10AZN Add
Modules in
destination file
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@ DISPLAY/SETTING DATA

Item

Description

Verification

Destination File

Specify the verification destination project.
Operation is the same as performing n:n verify.
Refer to 'n:n verify for details.

Close],

utton

Closes this screen without verifying the projects.

tab

<<Verify Selected Modules>>

Performs 1:n verify.

Select Verification
Source File

Select the project thatincludes the verify source module.

* When "Opened File" is selected, select the verification source module
from the open project.

* When "Verification Target File" is selected, select the verification source
module from the project specified at "Verification Destination File".

Execute |, uon

Verifies the projects, closes this screen, and displays the verify result.
Refer to Verify result’ for details of the verify result.

Opened File *1

Displays a list of all modules of the open project.

button

Adds the selected module to the "Verification Source Module" or

"Verification Destination Module".

The addition destination changes depending on the selection of "Select

\erification Source File".

* When "Opened File" is selected, the selected module is added to
"Verification Source Module".

« When "Verification Target File" is selected, the selected module is
added to "Verification Destination Module".

*1: As this verification is conducted to check parameter inconsistency, the module without
parameters is grayed out and is not erified.
The module with uploadable parameters is verified, even if the parameters are not editable.

ltem

Description

Verify Selected Modules

*1

Verification Target File

Displays a list of all modules of the verification destination project.

button

Adds the selected module to the "Verification Source Module" or

"Verification Destination Module".

The addition destination changes depending on the selection of "Select

\erification Source File".

* When "Opened File" is selected, the selected module is added to
"Verification Source Module".

« When "Verification Target File" is selected, the selected module is
added to "Verification Destination Module".

Verification Source

Displays the module selected as the verification source.

Module Only one module can be selected for this item.
Verification Destination . o
Module Displays the modules to be verified.

button

Deletes the selected module.

*1: As this verification is conducted to check parameter inconsistency, the module without
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parameters is grayed out and is not verified.
The module with uploadable parameters is \erified, even if the parameters are not editable.
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8.6  Printing the project data

PURPOSE

Prints the module configuration, module information list and module detail information of
the open project.

BASIC OPERATION

(1) Click the [File] > [Print] menu (é) or press the +[P] keys on the
keyboard.

(2) Make settings on the opened screen, e.g. select the printing details (Module
Configuration, Module Information List or Individual Module Information (Module
Detail Information, Parameter)).

(3) Click the button to start printing.

Refer to 'Print examples' for the printing result.

82



8 Project creation

DISPLAY/SETTING SCREEN

MELSOFT

Print module
configuration
page

Print modules

[v Module Configuration

todule Turning Pogition =5 Aligrment

modules

Print module s =
infu:urr_natiu:un
st [v Module Information List

v Individual Module Infarmation [Module Detail Information, Parameter]

Print
individual

vertically / horizontally

* Print the module name by columnar witing

" Print the rodule name by horizonkal writing

1
o Add module
ko print

zelection

2 ST1PSD

3 ] ST'I.-'l'-.DEI
4 7 ST1DAT

ﬂ

Remove
module from
print zelection

b odules
available to
prifk

Frirt

Frirt F'rewew

Frinter Setup Fage Setup |

Select /

Frint R ange
rodule
Al Modules
1 Selected Modules The module ta print
Modules to - -
pririt - all ar Mo |Slice |  Module Name Mo. | Slice | Module Name
just selected n n ST1H-FB 1] 0 “T1H-PE
ST1PSD

M odules

printing

Cloze

zelected for

zetup
printer

Set up page ¢
headingz

Send bo Show
Drinter presies
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@ DISPLAY/SETTING DATA

84



8 Project creation MELSOET

Item Description

Module Configuration Check this item to print the module configuration.

Setthe number of modules to be arranged horizontally when the module
Module Turning Position configuration is to be printed.
This item is available only when the "Module Conﬁguration" is checked.

Module Information List Check this item to printthe module information list.

Individual Module Information
(Module Detail Information,
Parameter)

Check this item to print the detail information of the modules specified at
"Print Range".

Alignment Select the print orientation for the module names.

Printthe module name [Prints the module names vertically.
by columnar writing

17112

78]
A==
T|g|®
32| =

Printthe module name [Prints the module names horizontally.
by horizontal writing

0 1 2

5T1H-P ST1X16
o sTIRSD 7] 1)

Setthe modules to be printed when the detail information of individual
modules is to be printed.

Print Range This item is available only when the "Individual Module Information" is
checked.
All Modules Prints the detail information of all modules.
Selected Modules Pr_lnt:c, the detail information of the modules displayed in "The module to
print".
button Adds the module selected in the left side listto the end of "The module to

print' as the module to be printed.

button Withdraws the module selected in "The module to print’ from the modules
to be printed, and deletes it from "The module to print".

| Printer Setup ‘button Sets the printer.
Refer to 'Setting up the printer' for details.

‘ Page Setup |butt0n Sets the page layout. .
Refer to 'Setting a page layout' for details.

Print button Starts printing.

‘ Print Praview ‘ button Closes this screen and displays a printimage.
Refer to 'Previewing a printimage' for details.

Close button Closes this screen without printing.
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8.6.1 Setting up the printer

PURPOSE

Selects a printer for printing and sets the paper size, the printing orientation, and other
printing format-related items.

BASIC OPERATION

(1) Click the ‘ Printer Setup ‘ button on the "Print" screen to display this screen.
(2) Select the printer for printing, and set the paper size, print orientation, etc.

(3) To close this screen, click the button.

DISPLAY/SETTING SCREEN

Print Setup

Prirter

Mame: &dobe LP-9200PS3 Properties.., |

Status: Ready
Type: &dobePS EPSOM LP-3200P5 3
Where: -

Comment;

Paper Orient ation

Siee:  |Ad | @ Portiait

L
Source: | Autornatically Select LJ (" Landscape
Network.... ] 8 Cancel
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@ DISPLAY/SETTING DATA

Item

Description

Printer

Selects a printer for printing.

Properties | ,uton

Clicking this button displays the properties dialog box.
The printer property option is used to make the basic settings of the
printer.

Sets the size of the paper for printing and the paper feed method of the

Paper printer.
The setting range depends on the printer.
Orientation —
Portrait Characters will be printed along the paper feed direction.
Landscape Characters will be printed across the paper feed direction.

button

Click this button when connecting to the shared network folder.
This item is displayed only when any of the following operating systems is
used.

» Microsoft® Windows® 2000 Professional Operating System

* Microsoft® Windows® XP Professional Operating System

* Microsoft® Windows® XP Home Edition Operating System

» Microsoft® Windows Vista® Basic Premium Operating System
» Microsoft® Windows Vista® Home Premium Operating System
» Microsoft® Windows Vista® Business Operating System

» Microsoft® Windows Vista® Ultimate Operating System

» Microsoft® Windows Vista® Enterprise Operating System

* Microsoft® Windows® 7 Home Premium Operating System

* Microsoft® Windows® 7 Professional Operating System

* Microsoft® Windows® 7 Ultimate Operating System

» Microsoft® Windows® 7 Enterprise Operating System

OK

button

Click this button after the printer setting is completed.

Cancel |y ion

Cancels the settings and closes this screen.

i- _Boiny

For the property setting of the printer, please read the manual of the used printer carefully
since the setting changes depending on the printer maker and model.
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8.6.2 Setting a page layout

ﬂb PURPOSE

Makes settings related paper, page number, header, and so on.

) BASIC OPERATION

(1) Click the ‘ Page SEtUp ‘ button on the "Print" screen to display this screen.
(2) Set the paper, page number, header, etc.

(3) To close this screen, click the button.

DISPLAY/SETTING SCREEN

Paper
zelection

Page Setup

Preview of

Paper page with
these settings
Size(Z) L [ N — gy
Frint Qrientation Marginz [mm] E E
Print . o T :
@n ! &+ Partrait Left [L] Right [R] |20

" Landscape Top(T) |28 Bottom [B] |25

Fage Mo. Setting

Common Header Setting

Haw to
print page Page No. Format |N':'”E j [~ Header Edit Header...

numbers i
Mo, Position Center -
| J Common Footer Setting

Initial ¥ alue 1 _|:I B Baslier Edit Faater. .

i

L

Page
footer text

Setup
printer

ak | Cancel | Frinter Setup[P]... |
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@ DISPLAY/SETTING DATA
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Item

Description

Paper

Sets paper size and paper feed method.

Print Orientation

Sets the orientation of printing on paper.

Margins

Sets the margins of the page.

Page No. Setting_;

Setthe page num ber.

Page No. Format

Select the page number format.

« "**."indicates thata page number will printed on pages, starting from
the initial value.

« "**[xx_"indicates that a page number and the total number of pages will
be printed.

» Set"None" to print no page numbers.

No. Position

Sets the position of page numbers.

Initial Value

Sets the page number to be printed on the first page. This can be useful if
you are printing the configuration as an appendixto another document.

Common Header Setting/
Common Footer Setting

By checking the check box, a header will be printed on each page.

Click the Edit header button, and the "Header Edit" dialog box as
shown below will be displayed.
| akK |

Cancel |

Alternatively, clicking the Edit header button displays the "Footer Edit"

dialog boxlike the Header Edit dialog box.

The header (or footer) can be edited within the range of 64 characters x
seven lines.

Lines and images cannot be edited, and characters cannot be decorated.

Preview This shows a graphical representation of how the page will look using the
current settings such as landscape / portrait, margins, etc.
OK button Click this button after the page setting is completed.

Cancel |y ion

Cancels the settings and closes this screen.

| Printer Setup | pu1on

By clicking this button, the printer dialog boxwill be displayed.
Select the printer for printing and click the button.

2)X]

Page Setup
Frinted

(TEPPS . o e LP-5200F53

Propesties...

Status: Ready

Type: AdobePS EPSON LP-9200P5 3
‘Where:

Commeni:

Metwark. .,

Cancel
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« If the print characters are small, reduce the value of margin setting.

MELSOFT

* When the mouse button is clicked while the shape of the mouse pointer is @ the
window zooms in.

When the mouse button is clicked while the shape of the mouse pointer is [% the

|- data is disilaied in the standard scale.
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8.6.3 Previewing a printimage

PURPOSE

The image of the entire page when it is printed will be displayed.

BASIC OPERATION

(1) Clicking the ‘ Print Preview ‘ button on the "Print" screen displays the print
image of the entire page.

(2) To return to the "Print" screen, click the button.
(3) To end the image display, click the Close button.

DISPLAY/SETTING SCREEN

= MELSOFT GX Configuraton-ST C:WMELSEC\SLICEWerifySample3a.st

| Cloze |

| QnePagel Zoom |n |

Pages 1-2 Edit Mode
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@ DISPLAY/SETTING DATA

Item Description
M button Ends the image display and starts the print.
Zoom In button The displayed image will be enlarged by clicking this button.
Data will be displayed in three different scales.
\M button The displayed image will be reduced by clicking this button.
\%‘ button Ends the image display.

_ /@int

When the mouse button is clicked while the shape of the mouse pointer is @l the
window zooms in.

When the mouse button is clicked while the shape of the mouse pointer is [% the data is
displayed in the standard scale.
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8.6.4 Print Examples

Print examples are shown below.
(1) Module Configuration

(@ When "Print the module name by columnar writing" is set

Module Configuration

=
s
[ X
[

gd-HILS
asdiLs

I-Z20¥T.LE
I-TYALLS & =

A-TWITLS

(b) When "Print the module name by horizontal writing" is set

Hodule Configuratlon

0 1 2 1 PR
4
¢mf
STLH-B ETLDAZ | ST1ADZ | ET1
;. ST1PSD| L .

;
1
)

(2) Module Information List

Medules Inforsatissn List

Input fSutput docupation Pointe

Bit S0

Word 4

Mo. | Slice |Module Hame | Bz (HEX) | Bw(HEX) |Wr({HEX) |®w (HEX) |Laben nm|
o] o STIN-PB | ©0-03 | 00-02

1 2 ETLIPED 04 -05 0d-05 - -

L.',,.,'._-' -~ e —— “##ﬂh# f
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(3) Individual Module Information

Module Detail Informaticn

Module Hame : ST1H-FB

Label Hame
Eame Module:
Ha. r 0
Slica Hs. r 0
Be {HEX] r Q0=03
Erw (HEX} 1 00-03
Wr (HEX} 1=
W (HEX 1=
PREARSCHE
Item Betting Valus |
faEput status at medule srror SEop
Ext_Diag information Enable
S R T
—n A
-
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9 Editing the project

This chapter explains how to edit the project of GX Configurator-ST.

i- /@int

Always add the power distribution module to the project.

9.1 Adding the module

9.1.1 Adding the module with the "Add module" screen

PURPOSE

Adds a slice module to the project.

BASIC OPERATION

(1) Execute any of the following operations to display the "Add Module" screen.
Click the [Edit] > [Add] menu ().

Press the Ctrl + | Insert keys on the keyboard.

In the “Module Configuration Window”, right-click the list in the "Module list" or
“rack display” area, and click [Add] from the menu.
(2) Set the adding position and model name of the module on the "Add Module"

screen, and click the button.
(3) To close the "Add Module" screen, click the Close button.
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i- _Boiny

Perform the operation with the "Module Configuration Window" screen open. ‘

To display the "Module Configuration Window" screen, choose the [View] -
[Module Configuration] menu.

If adding the module would cause the power consumption to be exceeded for the power
supply module which senes the new module, you will be shown a warning message
which provides an opportunity to cancel the addition.

This warning is only shown once — it will not be shown if the power supply module was
already overloaded before the module was added.

_ /@wint

(PROFIBUS-DP protocol version B only)

If adding the module would use more unused bits than there are available, you will be
shown a warning message which provides an opportunity to cancel the addition.

MELSOFT GX Configurator-ST

!j Wearning - there are nok enough unused bits available,
L]

IUnused bits available: 2, Required: 4

Select 'OK' ko add the module anwway,
] 4 | Cancel |

This warning is only shown once — it will not be shown if the available unused bits had
been exceeded before the module was added.
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DISPLAY/SETTING SCREEN

Add in
this glot

Add at end
af rack

[hzert Pazition

" LastPosiion % Mo, |Mo.1:STIPSD |

Select Module Type of
module
" Input/Output Module * |nteligent Module

" Power Distribution Module " Reserved Byte

|5T14D2Y -
Add Close | b

MELSOFT
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@ DISPLAY/SETTING DATA

Item Description
Insert Position Set the position where the slice module will be inserted.

Sets the inserting position to the last line.
Example: When the module is added to the last line.

Before addiion Aftar addition

Last Position

2 ST I
1 SIDIGDHET | . 1% DE.1%
1 ATWIRRER . 1R 1E.3%

1
F

i 1k HTHFC &% e ol

5 s ELAL P F T B I mn -

Select the "No." radio button and select the inserting position from the list.
Example: When the module (ST1Y16-TPE3) is added to No. 3

Before adgdition Aftar addition
STROSE |03 pR the module Na.3
-i_'ll"ﬁlh . ': . ﬂ'lﬂtﬁrm“ be
Sier xx xa oo | Incremented by 1.
Select Module Selectthe model name of the slice module to be added in the pull-down menu.
:\qgajggmpm Displays the input/output modules in the pull-down menu to enable selection.
Intelligent Displays the intelligent function modules in the pull-down menu to enable
Module selection.
Power Displays the power distribution modules in the pull-down menu to enable
Distribution P _ys P P
selection.
Module
Reserved

(PROFIBUS-DP [Displays the reserved byte modules in the pull-down menu to enable selection.
version B only)

button *1 Adds the slice module to the project.

Close button Closes this screen without adding the slice module.

*1: The slice module cannot be added in excess of the Maximum Input/Output points of the head
module.
Refer to 'Option setting' for the Maximum Input/Output points.
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9.1.2 Adding the module with the "Wizard area"

ﬂb PURPOSE

Adds a slice module to the project.

BASIC OPERATION

(1) Ensure that a module has been selected in the “rack display” / “module list” area —
left clicking on a module will select it.

(2) Select the type of module to be added from the tree in the "wizard area" of the
“Module Configuration Window” screen. When you hawe selected a module, its
details will be shown in the “information area” of the “Module configuration
window”.

(3) Select either “Add before” or “Add after” to determine where the module will be
inserted relative to the selected module.

(4) Click the button in the “wizard area”.

i- _Boint

Perform the operation with the "Module Configuration Window" screen open. ‘

To display the "Module Configuration Window" screen, choose the [View] 2>
[Module Configuration] menu.

If adding the module would cause the power consumption to be exceeded for the power
supply module which serves the new module, you will be shown a warning message
which provides an opportunity to cancel the addition.

This warning is only shown once — it will not be shown if the power supply module was
already overloaded before the module was added.
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fCC-Link systems]

DISPLAY/SETTING SCREEN

To add a module befare ar after the curent pozition, select it
from the lizt and click ‘4dd.
To remove the current module, select 'Delete’.

ST1+1616-DET-51-FAL ”
= Intelligent modulez

ST1ADZ2

ST1ADZY

ST1DAT

ST10AT-FO

cTARMOY FOd

" Add before (¢ Add after

Delete Add
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@ DISPLAY/SETTING DATA

Item

Description

Insert Position

Set the position where the slice module will be inserted.

Inserts just before the currently selected module (to the leftin the rack
display).
Example: When the module ST1Y16-TPE3 is added before slot No. 4.

Before addition Aftor addition
B | B | wWeHER] = Ha u | Modds Hare | BUHE) [ BfHE) | WiHES] = Viith this addition
— ] 0 F-1 N
Add before R A A —— : : the module Ne.3
B - o SR “~ orlater will be
Y e % .‘.I ety e = | Incremanted by 1.
Note: You cannotinsert a module before the head module. Avalid
configuration must always start with a head module followed by an
ST1PSD bus refreshing module.
Inserts just after the currently selected module (to the right in the rack
display).
Example: When the module (ST1Y16-TPES3) is added after slot No. 2.
Before addition Aftor addition
Add after Biee) | B | wifries] - w =
E — e ' _ Vutth this addition,
3 'Ielﬁ\-.';::'” E:: -:F . EE .i [T -qsm‘z i '; -2 . - the MUb 'Ih'a
Con e ww ww we *Ea.: B s wr oma or later will ba
Lo RSS2 2 ] incementeaby o

Select Module

Select the model name of the slice module to be added from the tree.

1/0 module

Expand this heading to show input/output modules.

Intelligent module

Expand this heading to display the intelligent function modules in the tree.

Power module

Expand this heading to display the power distribution modules to enable
selection.

button *1

Adds the slice module to the project.

*1: The slice module cannot be added in excess of the Maximum Input/Output points of the head

module.

Refer to ‘Option setting' for the Maximum Input/Output points.
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[PROFIBUS-DP systems]

DISPLAY/SETTING SCREEN

To add a module befare ar after the current pazition, select it
from the lizt and click ‘4dd'
To remove the current module, select 'Delete’.

= Inteligent modules ~
ST1aD2
ST1ADZ- [withaut b
ST1ADZ
ST1ADZ without 'whe)

ST1D&T - without /)

CTARAMA L oA

" Add before (¢ Add after

Delete Add
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@ DISPLAY/SETTING DATA

Item

Description

Insert Position

Set the position where the slice module will be inserted.

Inserts just before the currently selected module (to the leftin the rack
display).
Example: When the module ST1Y16-TPE3 is added before slot No. 4.

Before addiion After addiion
Add before
—
Added to tha last
line.
Note: You cannotinserta module before the head module. Avalid
configuration must always start with a head module followed by an
ST1PSD bus refreshing module.
Inserts just after the currently selected module (to the rightin the rack
display).
Example: When the module (ST1Y16-TPES3) is added after slot No. 2.
Add after Berforg addition After addition

Yitth this addition,
the module Na.3

2 T1FE ] I i [ B
15 0 . - - 2 16 15 3 .
n 5TH " BT 1] ST . -5 .
o e e | W e or lter will be
14 STIOA2Y C-1F  iC-1F 5 2 STIADEY 3 »E ™ m
. I.‘.I 2w ®3 xd - Incremented by 1.
; 5

Select Module

Select the model name of the slice module to be added from the tree.

1/0 module

Expand this heading to show input/output modules.

Intelligent module

Expand this heading to display the intelligent function modules in the tree.

In PROFIBUS-DP systems, some intelligent modules can be selected
with the ‘Wr’ or ‘Ww’ range switched off. These modules will have an extra
entry followed by either “without Wr” or “without Ww".

Power module

Expand this heading to display the power distribution modules to enable
selection.

Reserved (PROFIBUS-
DP version B only)

Expand this heading to display the reserved byte modules.

button *1

Adds the slice module to the project.

*1: The slice module cannot be added in excess of the Maximum Input/Output points of the head

module.

Refer to ‘Option setting' for the Maximum Input/Output points.
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_ /@oim

If the module cannot be added because the resulting number of /O bits, words or
intelligent modules would exceed the limits of the current point mode, the system will
check if there is another mode that would be suitable. For example, if more than 32
input/output bits are used in 32-point mode, it might still be possible to add the module
by switching to 64-point mode. If there is another suitable mode, a warning will be
shown:

MELSOFT GX Configurator-5T

. Tomake this change, the point mode must be set ko 'E4-pt mode’,
*-"/ Cio this niotw?

Answer to switch to the recommended mode and add the module, or to
cancel the addition of the module.

_ /@int

Maximum I/O point mode only applies to a head module with protocol version A.

For head module protocol version B (with or without commands) this value is
automatically adjusted more flexibly.
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(PROFIBUS-DP protocol version B only)

If adding the module would use more unused bits than there are available, you will be
shown a warning message which provides an opportunity to cancel the addition.

MELSOFT GX Configurator-ST B

T Wiarning - there are nok enough unused bits available,

!

o]

IUnused bits available: 2, Required: 4

Select 'OK' to add the module anwway,

Cancel |

This warning is only shown once — it will not be shown if the available unused bits had

been exceeded before the module was added.

MELSOFT
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9.2 Deleting a module

PURPOSE

Deletes the selected slice module from the project.

BASIC OPERATION

(1) Select the module to be deleted on the "Module Information List" screen.
(2) Execute any of the following operations.

* Click the [Edit] > [Delete] menu (:E:).

« Press the ‘ Cirl ‘ + ‘ Delete ‘ keys on the keyboard.
* Right-click the module to be deleted on the "Module Configuration Window"
screen “Module list” or “Rack display”, and click [Delete] from the menu:

4 7 To add a module
» H 1 frarn the lizt and

= l LLISECR R Undo Chrl+2 zthe o

I nodule:

Add... Chrl+Insert T1x1E

Rearrange. .. Hzi

D Chrl+Delete )

All Delete Shift+Del T1Y1g

T1%1E
Parameter Setting... Fa T1ve-
THAL T
Cptian. .. F10 =fore
Change head module
Power Distribukion Check D

* Click the Delete button in the “wizard area”:

To add a module
framm the lizt and o
Toremove the cu

= 10 modules
ST1#16-
ST1=20)
STTx4-D
ST1v16-
ST1v1E-
STIv2R

T AL T

" 4dd before

» Lelete

"

5
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(3) On the opened screen, confirm the slice module to be deleted, and click the

button. This deletes the module.
The module Nos. greater than the deleted module No. are decremented by 1.

i- _Boint

(PROFIBUS-DP head module version B only) ‘

Resened byte modules can only be selected and deleted from the Module list.

9.3 Deleting all modules

® PURPOSE

Deletes all slice modules from the project.

) BASIC OPERATION

(1) Execute any of the following operations.
« Click the [Edit] = [All Delete] menu (E).

« Press the | Shift| , | Delete keys on the keyboard.

* Right-click the list of the "Module Information List" screen, and click [All Delete]
from the menu.

(2) On the opened screen, click the button.

i- _Point

Perform the operation with the "Module Configuration Window" screen open. ‘

To display the "Module Configuration Window" screen, choose the [View] >
[Module Configuration] menu.
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9.4 Copying the module information

® PURPOSE

Copies the slice module from the saved project to the open project.
At this time, the parameters are also copied to the copied slice module.

BASIC OPERATION

(1) Click the [File] > [Copy] menu.

(2) Specify the copy source project with the Browse button.

(3) Select the slice module to be copied, set the inserting position at the "Insert

Position" section, and click the button.

(4) To close this screen, click the Close button.

i- _Boint

Perform the operation with the "Module Configuration Window" screen open. ‘

To display the "Module Configuration Window" screen, choose the [View] 2>
[Module Configuration] menu.

DISPLAY/SETTING SCREEN

Copy Source File
Drive/Path: |
File Mame: | Browse...
Inzert Position
Add
@+ Last Position Mo
| J Close
Mo, Slice Module M ame Label Mame Copy source project
corresponding module list
1 2 STIPSD R
2 3 ST1x16-DE1
3 Al ST1v1E-TFPEZ
4 19 STIPDD
] 20 ST1AD24
g 22 ST1DAZN
< | »
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E DISPLAY/SETTING DATA

ltem Description
Copy Source File Specify the copy source project.
Drive/Path Displays the drive and directory of the project.
File Name Displays the file name of the project.

Specifies the project.
The operation is the same as opening the existing project.
rowse button Refer to 'Opening an existing project' for details.
When the project is specified, the modules of the copy source project are

displayed in the "Copy source project corresponding module list".
Set the position where the slice module will be inserted into the open

Insert Position

project.
Last Position Sets the inserting position to the lastline.
No Select the "No." radio button and then select the insert position from the
' list.

Copies the slice module selected in the "Copy source project

button corresponding module list".

Copyis not executed when no slice module is selected.
Close button Closes this screen.

Copy source project
corresponding module list

Select the slice module to be copied.
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95 Undo

PURPOSE

Returns the following operations to the status prior to execution.
* Adding the module

* Deleting the module

* Deleting all modules

 Copying the module information

* Get System

BASIC OPERATION

Executing any of the following operations returns to the status prior to the last
operation.

« Click the [Edit] = [Undo] menu (¥™).

* Press the + keys on the keyboard.
* Right-click the list of the "Module list" or “Rack display” areas of the
“Module Configuration Window”, and click [Undo] from the menu.
Repeating this operation returns to the status of up to the tenth preceding operation.

m /@am

» Perform the operation with the "Module Configuration Window" screen displayed.
The "Module Configuration Window" screen is displayed when the [View] >
[Module Configuration] menu is selected.

¢ The operation history is erased when the project is closed.

When the project is closed, the operation performed before closing the project
cannot be returned to the previous status.

111



9 Editinc_] the project MELSOFT

9.6 Redo

PURPOSE

Returns to the status prior to the "Undo" processing in 'Undo'.

BASIC OPERATION

Execute any of the following operations.
« Click the [Edit] » [Redo] menu ().

* Press the + keys on the keyboard.

* Right-click the list of the "Module list" or “Rack display” areas of the
“Module Configuration Window”, and click [Redo] from the menu.

i- _Point

Perform the operation with the "Module Configuration Window" screen open. ‘

To display the "Module Configuration Window" screen, choose the [View] >
[Module Configuration] menu.

9.7 Rearranging the modules

9.7.1 Rearranging the modules with the Rearrange dialog

® PURPOSE

Rearranges the slice modules of the project.

i- _Boiny

The head module cannot be rearranged. ‘
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) BASIC OPERATION

(1) Execute either of the following operations.
« Click the [Edit] > [Rearrange] menu.
« Right-click the list of the "Module Configuration Window" screen “Rack display”
or “Module list” area, and click [Rearrange] from the menu.
(2) On the opened screen, select the slice module to be moved from among the slice

modules displayed in the list, and mowe it using the [Ue] / button.
(3) To close this screen, click the button.

i- _Boint

Perform the operation with the "Module Configuration Window" screen open. ‘

To display the "Module Configuration Window" screen, choose the [View] 2>
[Module Configuration] menu.

Avalid system will always have an STLIPSD module immediately after the head module. If the
modules are rearranged in such a way as to leave another module type in the slot after the
head module, you will be prompted to rearrange the modules again.

DISPLAY/SETTING SCREEN

Oid

Rearrange Ic
pozition

F e

pasition L After Bearr. | Current Mo, 4 adule Mame [I:;ltc;;eraucpk]
1 1 ST1PSD
2 ] ST1¥16-TE2 e
3 2 ST1v16-TEZ
4 7 ST1><1E-DE1 Do
3 3 ST1v2R2
h_*lu:wg dowiry
Selected : 7 0 ET1v1E-TEE 2 - [right i rack]

iterm

Ok, | Cancel |
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@ DISPLAY/SETTING DATA

Item Description
After Reaur. Displays the No. of the slice module after rearrangement.
Current No. Displays the No. of the slice module before rearrangement.
Module Name Displays the product model name of the slice module after
rearrangement.
Changes the positions of the selected slice module with the one above
button that. _ _ o o
When the selected slice module is at the top of the list, its position is not
changed.
Changes the positions of the selected slice module with the one below
button that. _ _ o o
When the selected slice module is at the bottom of the list, its position is
not changed.
OK button Validates the rearrangement and closes this screen.
Cancel button Cancels the rearrangement and closes this screen.

9.7.2 Rearranging the modules with drag and drop

In addition to the rearrange dialog, modules can be rearranged by dragging and dropping them
directly from the “Rack display” area of the “Module Configuration Window".

® PURPOSE

Rearranges the slice modules of the project. Using this method allows several modules
to be mowved at once.

i- _Boiny

The head module cannot be rearranged. ‘
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Click on the first module to
be moved. If more than
one module needs to be
moved, keep the left button
held down.

If you want to move a
block of modules, keep the
left mouse button held
down and drag to the last
module in the block.

The number field is
highlighted to show the
range of modules that are
currently selected.

Now all the modules are
selected, they can be
moved. Move the mouse
pointer over one of the
borders of the selected
modules, so that the
mouse pointer changes to
a picture of a rack with an
arrow underneath it, as
shown.

Click and hold the left
mouse button - the arrow
will disappear.

Click an the
firzt module

iEEE

10

a4
ii| Drag to zelect
‘ A rnore modules
'.\"G
The no. field iz

highlighted to ghow
the zelection

‘Hawver' aver the
border of the
gelected modules,
then click the |eft
mouze button

MELSOFT
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With the left mouse button
still held down, drag the
modules to their new
position. An outline border
is drawn around the
position where the
modules will be placed.

If the target position is not
visible, you can drag the
mouse pointer near to the
left or right edge of the
rack display to scroll the
display.

When the left mouse
button is released, the
modules will be moved to
the new position.

They will be automatically
selected again, so that if
the target position was
'missed’, they can be
quickly dragged again into
the right position.

i- _Boiny

Drag the
rnodules to their
niew position. .

The outline
barder shaws the
new pozitian

bodules are
moved ta the
niew pozition, and
zelected

MELSOFT

supply module, the drag action will automatically be cancelled. A valid system must
always start with a head module and a power supply module.

[ | int

(PROFIBUS-DP head module version B only)
Resened bytes can only be rearranged in the configuration using the rearrange dialog.

If you try to drag one or more modules to the left of the the head module or first power ‘
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9.8 Parameter setting

The following table shows the reference section for each parameter-related operation.
The operation can be performed on the "Parameter Setting" screen.
Refer to "Parameter setting" screen' for the operation to display the "Parameter Setting" screen.

Operation Reference Section
To set the parameters. 'Setting the parameters'
To upload the parameters.
To download the parameters. '‘Uploading / downloading /
To verify the parameters being edited and the parameters within the verifying'
module.
l’:)r;:geck the parameters being edited for errors and identify the parameter ‘Checking the parameters’
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9.8.1 "Parameter setting" screen displaying operation

1)

)

@)

118

BASIC OPERATION

The "Parameter Setting" screen displaying operation differs among the following (1) to

3).

In the edit mode

(@ When the "Module Configuration Window" screen is not displayed, choose the
[View] - [Module Configuration] menu to display the "Module Configuration
Window" screen.

(b) On the "Module Configuration Window" screen “Rack display” or “Module list” area,
select the module whose parameters will be set.

(c) Execute any of the following operations to display the "Parameter Setting" screen.
« Click the [Edit] > [Parameter Setting] menu (.

* Press the key on the keyboard.

» On the "Module Configuration Window" screen “Rack display” or “Module list”
area, right-click the module whose parameters will be set, and click
[Parameter Setting] from the menu.

» On the "Module Configuration Window" screen “Rack display” or “Module list”
area, double-click the module whose parameters will be set.

In the diagnosis mode

(@ When the "System Monitor" screen is not displayed, choose the [View] >
[System Monitor] menu to display the "System Monitor" screen.

(b) On the "System Monitor" screen, select the module whose parameters will be set.

(c) Execute any of the following operations to display the "Parameter Setting" screen.

« Click the [Edit] > [Parameter Setting] menu (.

* Press the key on the keyboard.

« On the "System Monitor" screen, right-click the module whose parameters will
be set, and click [Parameter Setting] from the menu.

« On the "System Monitor" screen, select the module whose parameters will be

set, and click the | Parameter Setting ‘ button.

When the "Result Verify" screenis open after project verify

Execute either of the following operations to display the "Parameter Setting" screen.
* On the "Result Verify" screen, double-click the module whose parameters will
be set.
« On the "Result Verify" screen, select the module whose parameters will be

set, and click the | Parameter Setting ‘ button.
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9.8.2 Setting the parameters

ﬂb PURPOSE

Sets the parameters of the intelligent function module.

) BASIC OPERATION

(1) When the module has the same parameters on multiple channels, select the
channel whose parameters will be set at "Channel".
(2) Set the parameters in the "Parameter list".

(3) Click the button to close this screen.

DISPLAY/SETTING SCREEN

M Parameter Setting No. 5

Module Infarmation
Slice Mo. : 8
~ Maduls
Module Mame : ST1AD2Y infarmation Cancel
Label Mame
Baze Module : ST1B-"4IR2
Online
Online operations
Select Data Target temaory |H'&M j
Select Al Release Al |
Upload | Download | Werify Check for
Channel Il
Setto #
Channel: CH1 - F'ar.;z:eter defaults Default ‘ Errar Check
Select Item Setting Value
L1 |Input range setting A0t 10 -
L1 |5Setting range A0 10Y -
L1 | Timenuarnber of times specification Mumber of timez -
1 |Samphng processdaveraging process sething Sampling -
L1 |Alarm output setting Dizable -
L1 |Dizconnection detection zetting Dizable -
1 |A/D conwversion enable/dizable sething Enable -
L1 |50/E0Hz notch filker specification Dizable -
L1 |Awerage timedaverage number of times setting 4
1 |Upper upper limit value A000
L1 |Upper lower limit value 4000
L1 |Lower upper limit value -4000
L1 |Lower lower limit value -4000
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@ DISPLAY/SETTING DATA

Item

Description

Module Information

Displays the information (start slice No., module name, label name, base
module name) of the target intelligentfunction module.

button

Validates the settings and closes this screen.

Cancel |, ,10n

Cancels the settings and closes this screen.

Channel

Specify the channel of the parameters to be displayed in the parameter
list.

Only when the intelligent function module has the same parameters on
multiple channels, this item is available.

button

Returns the parameters in the "Parameter list' to the default values.
Onlywhen the module has the parameters that can be changed, this item
is available.

Parameter list

Alist of the parameters of the intelligent function module is displayed and
can be edited.

For the types and applications of the parameters of the module, refer to
the manual of the corresponding intelligent function module.

Item Displays the parameter name.
. Editthe parameter.
Setting Value o
9 The parameter that cannot be edited is grayed out.
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9.8.3 Uploading/downloading the parameters or verifying the parameters being
edited and parameters within module

{b PURPOSE

Uploads/downloads the parameters, or verifies the parameters being edited and
parameters within module.

BASIC OPERATION

(1) When the module has the same parameters on multiple channels, select the
channel, whose parameters will be uploaded, downloaded or verified, at "Channel".
(2) Select the parameters to be uploaded, downloaded or \erified.
To make selection, mark the "Select" check box in the "Parameter list":

= e | et

st o s e .
1 |Debeeorersion” V?‘{disable setting Disable v’_l
- -

4 k
(3) At "Target Memory", select the memory as the target of upload, download or verify.

(4) To upload the parameters, click the button.

(5) To download the parameters, click the button.
(6) To verify the parameters, click the button.

(7) Click the button to close this screen.
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Bl Parameter Setting No.5

MELSOFT

DISPLAY/SETTING SCREEN

todule Information

Slice Ma. 19
) Modulg
Podule Name ST1aD2v infarmation Cancel
Label Mame
Baze Module ST1E-~4IR2
) Oriline
Online operatiohs
Select Data Target Memory  |Rak -
Select Al Release Al |
Upload | Download | erify Check for
Channel Elirules
Set ta
Charimel: CH1 Par?meter defaults Diefault | Error Check
it

Select Ikem Setting Value
L1 |lnput range setting A0t 10V -
1 |Selting range A0t 10V -
21 | Time/number of imes specification Mumber of imes -
1 |5Sampling process/averaging process setting S ampling -
L1 |Aldarm output setting Dizable -
1 |Disconnection detection setting Dizable -
1 |A/D conversion enable/dizable setting Enable -
1 |80/80Hz notch filker specification Dizable -
L1 |Average time/average nurmber of times setting 4
1 |Upper upper limit walue 4000
21 |Upper lower limit value 4000
1 | Lower upper limit value -4000
1 |Lower lower linit walue -4000
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@ DISPLAY/SETTING DATA

Item Description

Displays the information (start slice No., module name, label name, base
module name) of the target module.

Module Information

OK button Closes this screen.
Online Perform operation for the target module.
Select Data Select the parameters to be uploaded, downloaded or verified.
Select All _ _
button Checks all "Select" check boxes in the "Parameter list".
Release All
Unchecks all "Select" check boxes in the "Parameter list".
button
Target Memory Selectthe memory as the target of upload, download or verify.

Uploads the parameters of the target module from the memory selected

Upload at"Target Memory'.
button When the module has the same parameters on multiple channels, the

parameters of the channel selected at "Channel" are uploaded.
The uploaded parameters are displayed in the "Parameter list".

Checks the parameters for incorrect settings, and when they are correct,

downloads the parameters to the memory selected at "Target Memory".

Download When the module has the same parameters on multiple channels, the
button B N

parameters of the channel selected at "Channel” are downloaded.

If any parameter is incorrect, that parameter is not downloaded, and its

name under "ltem" is displayed red in the "Parameter list".

Verifies the parameters of the memory selected at "Target Memory" and
those in the "Parameter List".
Veri When the module has the same parameters on multiple channels, the
button " " o
parameters of the channel selected at "Channel” are verified.
If any parameter is judged as inconsistent as a result of verify, its name
under "ltem" is displayed red in the "Parameter list".

Specify the channel for which parameters will be uploaded, downloaded
or verified.

Channel .
Only when the module has the same parameters on multiple channels,
this item is available.
Displays a list of the parameters of the module.
Parameter list For the types and applications of the parameters of the module, refer to
the manual of the corresponding module.
Select Select the parameters used for the operation performed at "Online".
Displays the parameter name.
This item may be displayed red depending on the result of clicking the
Item

| Download ‘or ‘ Ve"fy ‘button.
For details, refer to the description of the corresponding button.

Displays the parameter value.
Setting Value Downloading is not allowed to the items displayed in gray, however,
uploading and verification is available.
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9.8.4 Checking the parameters for errors

® PURPOSE

Checks the parameters for errors and identifies the parameter errors.

=) BASIC OPERATION

(1) When the module has the same parameters on multiple channels, select the
channel, whose parameters will be checked for errors, at "Channel".

(2) Click the | Error Check | button to start an error check.
(3) Click the button to close this screen.

DISPLAY/SETTING SCREEN

M Parameter Setting No.5

Module Infarmation
Slice Ma. -
] Mu:udul,a
Module Mame : ST1ADZW information Canicel
Label Marme
Baze Module : ST1B-“4IR2
Onilire
Orline operations
Select Data Target Menmory |HAM j
Select Al Release Al |
Upload | Download | Werify Check for
Channel =R
Setto ?
Channel: CH1 - Pafi;‘:EtET defauilts Default ‘ Errar Check
Select Item Setting Value
1 |Input range setting AQto 10 -
L1 |Setting range A0 10Y -
L1 | Timerarmnber of times specification Mumber of times -
1 |Sampling process/averaging process setting S ampling -
L1 |Alarm output setting Dizable -
L1 |Digconnection detection zetting Dizable -
1 |A/D conwersion enable/dizable setting Enable -
L1 |50YE0Hz notch filter specification Dizable -
L1 |Awerage timedaverage number of times setting 4
1 |Upper upper limit value 4000
L1 |Upper lower limit value 4000
L1 |Lower upper limit value -4000
L1 |Lower lower limit value -4000
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@ DISPLAY/SETTING DATA

Item

Description

Module Information

Displays the information (start slice No., module name, label name, base
module name) of the target module.

OK button Closes this screen.
Specify the channel of the parameters to be checked for errors.
Channel Only when the module has the same parameters on multiple channels,

this item is available.

| Error Check | ion

Checks the parameters for incorrect settings.
If any parameter has an incorrect setting, its name under "ltem" is
displayed red in the "Parameter list", as in the example below.

= [l S TS, SEriy | =lea hd

[ D74 conversion enable/disable setting |Disable -

= (999999399 | -
4 | -

Parameter list

Displays a list of the parameters of the module.
For the types and applications of the parameters of the module, refer to
the manual of the corresponding_; module.

Item

Displays the parameter name.
This item may be displayed red depending on the result of clicking the

| Error Check |button.

| Error Check |button.

For details, refer to the description of the
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9.9 Option setting

® PURPOSE

Sets the label name, base module, etc.

) BASIC OPERATION

(1) Execute any of the following operations.
* Click the [Edit] = [Option] menu.

* Press the key on the keyboard.

« On the "Module Configuration Window" screen “Rack display” or “Module list”
area, right-click the module, where option settings will be made, and click
[Option] from the menu.

(2) On the opened screen, make option settings and click the button.

i- /@int

Perform the operation with the "Module Configuration Window" screen open. ‘

To display the "Module Configuration Window" screen, choose the [View] >
[Module Configuration] menu.
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fCC-Link systems]

DISPLAY/SETTING SCREEN

For head module

For slice module

Module Mame

Label N ame

Baze Module

STIH-BT Module Mame STIRDZ
|H'3‘E'El module Label Mame |
||| BaseModue  [STIB-4IR2 -]
C v [
Cancel ‘ Ok | Cancel

o]

@ DISPLAY/SETTING DATA

Iltem

Description

Model Name

Displays the product model name of the module for which option settings
will be made.

Label Name

Enter any character string within 32 alphanumeric characters.
As the label name is displayed on the "Module Configuration Window"
screen or is output for printing, itis useful for module management, etc.

Base Module *1

Select the base module for the slice module. GX Configurator-ST does not
distinguish between spring clamp (S) and screw (E) wiring types in the
base module.

Use Word Input Data

When the module has Mword input, this boxwill be checked. If the

word input data is optional for a module, it will automatically be
unchecked in CC-Link systems.

Use Word Output Data

When the module has word output, this boxwill be checked. If the

word output data is optional for a module, it will automatically be
unchecked in CC-Link systems.

OK button

Validates the settings and closes this screen.

Cancel |pyion

Cancels the settings and closes this screen.

*1: For applicable base modules, refer to the manual of the module used.
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i- _Boiny

Unlike PROFIBUS-DP systems, there is no selectable 'maximum input/
output points' setting for CC-Link systems. The maximum number of input /
output points is always fixed at 252 for CC-Link systems.
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[PROFIBUS-DP systems]

DISPLAY/SETTING SCREEN

For head module For slice module
Module Mame ST1H-FE Module Name ST1RDZ
Label Name  |Head module LabelName |
Base Module | ||| BaseModule  |ST1B-#IR2 |
b awirum [nput/Output Points |255-pt mode j
I I [+ I Use'wiord Output Data
ITI Cancel ‘ ’Tl Cancel

E DISPLAY/SETTING DATA

Item Description

Displays the product model name of the module for which option settings will
be made.

Model Name

Enter any character string within 32 alphanumeric characters.
Label Name As the label name is displayed on the "Module Configuration Window" screen
or is output for printing, itis useful for module management, etc.

Select the base module for the slice module. GX Configurator-ST does not
Base Module *1 distinguish between spring clamp (S) and screw (E) wiring types in the base
module.

Head module version A: Setthe Maximum Input/Output points for the head
Maximum Input/Output module.

Points Head module version B: This inputis not available as itis calculated
automatically.

When the module has Mword input, check this check boxto use the

Use Word Input Data -
word in
put.

When the module has word output, check this check boxto use the
Use Word Output Data

word output.

OK button Validates the settings and closes this screen.
Cancel button Cancels the settings and closes this screen.

*1: For applicable base modules, refer to the manual of the module used.
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9.10 Power distribution check

PURPOSE

Checks whether the sum of 5VDC internal current consumption required by the
modules is within the 5VDC maximum rated output current of the bus refreshing
module.

i- _Boint

For details of the calculation method used for this function, refer to the MELSEC-ST ‘

System User's Manual.

) BASIC OPERATION

(1) Execute any of the following operations.
* Click the [Edit] > [Power Distribution Check] menu.
» On the "Module Configuration Window" screen “Rack display” or “Module list”
area, right-click a menu and click [Power Distribution Check] from the menu.
(2) On the opened screen, confirm the check result.

(3) Click the Close button to close this screen.

i- _Point

Perform the operation with the "Module Configuration Window" screen open. ‘

To display the "Module Configuration Window" screen, choose the [View] >
[Module Configuration] menu.
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DISPLAY/SETTING SCREEN

Power Distribution Check

M. | Supply Current{a) | Consumption(s) | R e=zult |
1 2.000 1.005 Ok,
G 2.000 2075 ERROR

Cloze

E DISPLAY/SETTING DATA

Item Description
No. Displays the mounting position of the bus refreshing module.
Supply Current (A) alcs)glljallé/s the 5VDC maximum rated output current of the bus refreshing

Displays the sum of 5VDC internal current consumption of the modules

Consumption (A) powered by the bus refreshing module.

Displays the check result.

"OK" : The sum of 5VDC internal current consumption is not
greater than the 5VDC maximum rated output current of the
Result bus refreshing module.
"ERROR" :The sum of 5VDC internal current consumption is greater

than the 5VDC maximum rated output current of the bus
refreshing module.

Close bution Closes this screen.

i- _Boint

To find the exact slot where the power consumption was exceeded (i.e. the slot
which needs another power supply module installed just before it), look at the
module list, where the module will be highlighted in red.
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9.11 Change head module type

PURPOSE

Changes the head module type, i.e. from PROFIBUS-DP to CC-Link, or from CC-Link to
PROFIBUS-DP. This is not the same as 'online module change', and cannot be used to
change the head module while the system is live. It only changes the configuration that
is being edited.

_ /@wint

An alternative way to perform this change is to simply connect to a MELSEC-ST system
where the head module has already been replaced. If GX Configurator-ST detects that the
connected system is identical except for the head module, you will be prompted to read
the head module details from the system and continue.

) BASIC OPERATION

(1) Execute any of the following operations.
« Click the [Edit] > [Change head module] menu.
* On the "Module Configuration Window" screen “Rack display” or “Module list”
area, right-click a menu and click [Change head module] from the menu.

(2) In the confirmation dialog, select the new head module type from the list and then

click the LChaNge | pon,
Change head module

Select the new head module bype From the lisk and
then click "hanae' ko canfirm.

Change | Close |

(3) A warning will be shown about the Wr and Ww ranges. Read this carefully and then

select either to continue or to cancel.
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_ /@ﬁm

When you change from a PROFIBUS-DP head module to a CC-Link head module, the
parameter settings will be reset to defaults and all the modifiable ‘without Wr' and

‘without Ww' settings for intelligent modules will be reset to ‘without' (as this feature is not
used on CC-Link systems). This change is not rewersible, so if you change back to a
PROFIBUS-DP head module later, you will need to re-enter these settings.

i- _Boint

When you change from CC-Link to PROFIBUS-DP, the PROFIBUS head module ‘

version is automatically set to protocol "Version B without command".

To display the "Module Configuration Window" screen, choose the [View] -

Perform the operation with the "Module Configuration Window" screen open.
[Module Configuration] menu.
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9.12 Change PROFIBUS-DP head module protocol version
[PROFIBUS-DP systems]

This functionality applies to PROFIBUS-DP systems only.

{b PURPOSE

The head module protocol version can be changed to have old configurations reset to
newer ones.

i- it

To switch the ST-series head module from protocol version A to version B, an
applicable head module has to be used, and the configuration needs to be set up via a
GSD file and has to be downloaded to the PROFIBUS-DP master station.

) BASIC OPERATION

Select a head module protocol version from the combo box in the module list.

DISPLAY/SETTING SCREEN

Mo lo] 1 2] 3 l4ls]6l7|a]aln]n]li2]ia] 4] | T add 3 morde before or after the curent position, select it
== ||| from the list and click 'Add.
== I" To remove the curent module, select Delete’
1l STIDATLFDT
"l STIDAZN-FON
6sD 1RD2
T Calzeleelzelieleelee]ealea] 25 g > ol il el EEl e 51
el el EelER e el B B e B, Version Belleeles be

1/0 Occupation Points  Bit 24 Word 27 GSDVersion:|B | [with command |
No_ [Sice] ModuleName [UnusedBits|  BiHEX) [ BwiHEX) | WiiHEX) | wwiHEX) | LabelName [<]
D0 ST1H-FB - - - 00.0-12F | 00.0-12F -
/1] 1 ]2 STIPSD - - -
fp— 3 STIX2DE] 5 13013
TRE 3 T1X16-DE1 - 38-14.7 - . . “puts, Volkage, 12 Bit, 1 Module width
?E 4 |12 sTIV2R2 8 - 13.0-131
i 5 13 ST1Y2R2 3 : 138-1339 . Module resdy
> § 14 sTiAD2 - - - 148-177 14D-14F e e e
IEEE | 7 6 STIDA2Y . . . 17.8-187  160-18F System frea (fixed to 0)
o1l e 8 ST1DAT - - - 188-137 | 140-1CF System Area (ixed ta )
s 18 |2 5T1551 : : : 198-1C7 1E0-1EF i i ra
7 CH2 output enablefdisable flag

2 18 ST1DAT g g 188-187  1A0-1CF
20 ST1551 5 5 19.8-1C7  1E0-1E.F
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@ DISPLAY/SETTING DATA

Item Description
Displays the actual head module version.

GSD version . .
The setting can be changed to either Aor B.

For PROFBUS-DP head module version A:
With this combo boxthe actual point mode is shown or set (for offline
configuration).

Head module mode
For PROFBUS-DP head module version B:

With this combo box the actual mode (with or without command) is shown
or set (for offline configuration).

_ /@:int

If the head module is changed from version B to version A, all modules that are not
supported in version A (for example, reserved byte modules) will be removed from the
configuration. When changing to version A, a warning message will be shown giving
you the chance to cancel the change.
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After changing the head module version to B, the conversion dialog will be shown:

® PURPOSE

When changing from head module version A to B, resered bytes and byte packed
modules can automatically be inserted into the module configuration.

i- _Boint

These options are only available when switching from head module version A to B.

BASIC OPERATION

Check the required options, then click OK.

DISPLAY/SETTING SCREEN

Conversion

Settings

Set the inteligent module address at the beqginning of a word,
(WORD oriented masker)

[v Reserved Byte

Set byte pack for digital modules whenever possible.
v Byte Pack

Ik | Cancel |

@ DISPLAY/SETTING DATA

Item Description

Inserts reserved bytes ahead of intelligent modules to ensure their
address word is aligned.

Reserved Byte

Byte Pack Inserts a byte pack module whenever possible to save memory.

136



9 Editinc_] the project MELSOFT

10 Downloading and uploading the parameters

This chapter explains how to download or upload the parameters of each module.
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10 Downloading and uploading the parameters

10.1 Transfer setup

® PURPOSE

Sets the connection with the head module.

i) BASIC OPERATION

(1) Click the [Online] - [Transfer Setup] menu.
(2) Make setting and click the button.

DISPLAY/SETTING SCREEN

Transfer, Setup

CO Port ;
Transmizzion Speed © | 9.6kbps -
Tirneot : 5 “4 5]

E DISPLAY/SETTING DATA
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Item Description

Select the COM port connected with the head module.
(Setting range: COM1 to COM10, default *1: COM1)

Select the transmission speed.
Transmission Speed (Setting range: 9.6kbps, 19.2kbps, 38.4kbps, 57.6kbps, default *1:
9.6kbps)

When the external power supply of the MELSEC-ST system is switched off
or the head module is reset during communication with the head module,
it will take some time before a communication error is displayed.

The monitor displays Executing until the error is displayed.

The maximum time until the error is displayed can be found by the
following expression.

(Specified "Timeout" period) x 4

For example, when 5s was specified for "Timeout", (5s) x4 = 20s and the
error is displayed in a maximum of 20s.

(Setting range: 1 to 9, default *1: 2)

COM Port

Timeout *2

button Validates the settings and closes this screen.

Cancel button Closes this screen without making settings.

*1: When this screen is used the second or later time after installation of GX Configurator-ST, the
default is the value set when this screen was used the last time.

*2: If a communication error occurs during write to the ROM of each module, a maximum of 30s is
required before the error is displayed.

o /@oint

When a transmission speed of 19.2kbps or higher is set to "Transmission Speed", some
personal computers may be unstable, fail the communication and display the following
screen.

In this case, set a lower transmission speed.

(= x|

i Cannot communicate with Head module for one of the Following reasons:
‘“xr)

* Communications kimeout,

* The preparation of communication environment is bad.

* Cable errar.

* Cannot communicate with the transmission speed set up now.

To fix this, trv:

* Checking the cable and selected part number

* Setting transmission speed to a lower walue.

* Closing okher communication software applications and trying again.

<ES:0180840b >

K
e
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I /@int

GX Configurator-ST 1.06G will only partially work with the new PROFIBUS-DP head
module.

Head module set to PROFIBUS-DP version A:

If the head module is set to version A, there will be no problem as GX Configurator-ST
1.06G is fully compatible with this head module version.

Head module set to PROFIBUS-DP version B:

If the head module is set to version B, GX Configurator-ST 1.06G cannot communicate
with the head module due to changes to the internal structure. Attempting to connect to
the head module will display the error below.

B MELSOFT GX Configurator-ST

i Cannot communicate with Head module For one of the Following reasons:
i * Bad connection to the head module.
* The preparation of communication environment is bad,

To Fix this, bry:

* Checking the connection to the head module
* Closing other communication software applications and trying again,

<ES: 10000002 =

[
I

_ /@oim

This setting only applies to communications between GX Configurator-ST
and the communication port on the head module. It is independent from the
transmission speed used for communications between the master device
and the PROFIBUS-DP or CC-Link communication port on the head
module.
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10.2 Get system

PURPOSE

Uploads the module configuration and the parameters from each module. This can be
useful if you have a configured SLICE system, but do not have the configuration file that
was originally used to build it.

BASIC OPERATION

(1) Either:
o Click the [Online] > [Get System] menu (), or

o On the first wizard page (shown when GX Configurator-ST is started or after
selecting [File] = [New] ), select "Read the system configuration from the

communication port" then click the Next button.

(2) When the project is open, uploading the module configuration and the parameters
of each module erases the project information uploaded previously.
Hence, a screen appears asking whether data will be uploaded or not.

. Click the button to display the "Get System" screen.
In this case, the project information uploaded previously is erased.

. Click the button to stop processing.

(3) Set the data to be uploaded on the "Get System" screen, and click the
button to upload the module configuration and the parameters of each module.

(4) When upload is completed, the "Completed" message is displayed.

Click the button.
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DISPLAY/SETTING SCREEN

Execute to read the Module configuration
inforrnation?

v Read Parameter
+ RamM

ROk
" [The rmadule without ROk
will be read from R ]

k. | Cancel |

E DISPLAY/SETTING DATA

Item Description

Check this check boxto upload the parameters of each module.
Read Parameter The module configuration is uploaded regardless of the setting of this
item.

Uploads the parameters from the RAM of each module.
RAM This item is available onlywhen the "Read Parameter" check boxis
checked.

Uploads the parameters from the ROM of each module.
When the target module does not have the ROM, the parameters are

ROM uploaded from the RAM.
This item is available onlywhen the "Read Parameter" check boxis
marked.
OK b Validates the settings and closes this screen. On completion, the new
utton . . . . "
configuration will be available for editing.
Cancel button Closes this screen without making settings.
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10.3 Getinput/output data settings (PROFIBUS-DP only)

PURPOSE

Uploads the input/output data settings made using GX Configurator-ST from each
module.

The following two different input/output data settings are uploaded.
¢ Maximum Input/Output points of the head module

« Setting of whether the word input/ word output of the intelligent

function module are used or not

BASIC OPERATION

(1) Click the [Online] = [Get Input/Output Data Settings] menu.
(2) A screen appears asking whether the settings will be uploaded or not.

Click the El button to upload the input/output data settings.
(3) When upload is completed, the "Completed" message is displayed.

Click the button.
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10.4 Parameter block write

PURPOSE

Downloads the parameters to the modules in a block.

BASIC OPERATION

(1) Click the [Online] > [Parameter Block Write] menu to display the "Parameter
Block Write" screen.

(2) Select the target memory and parameters, and click the Download button.

(3) When download is completed, the "Download Completed" message is displayed.

Click the button.
(4) To close this screen, click the Close button.

DISPLAY/SETTING SCREEN

Preparing to download Downloading
Parameter Block Write ROM 7 RaM '§_| Parameter Block Write E'
Deselect al
meloct ol Select Data modules Target Memon [Ram - Select Data T arget Memory ’m
modules Select Al Rel Al Stop write
elec eleaze Download g et Select Al Releaze Al |:| Cancel
“wfiite to
Seleat | Mo Hodule Mam moﬂes% Select | Mo Module Mame Stal Ca-T-CEI )
o [ STIHFE ER STIHFE - I
i to y -] SrilED : = 5TIFSD
witete A= 2 ST1DAZY : ® | 2 ST1DAZY Complete
o | 3 SiTE02 - ¥ | 3 ST1ADZ Wiilng.. ~ |
= 4 | , STiDATI E 7 4 5T1DAT Wit 2 white status)
 Module list
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@ DISPLAY/SETTING DATA

Item Description

Select Data Batch-select the modules whose the parameters will be downloaded.

Select All| b ton Selects all modules.

Release All [pton Deselects all modules.

Select the memory where the parameters will be downloaded.

* When "RAM' is selected, the parameters are downloaded to the RAM of
each module.

Target Memory  When "ROM" is selected, the parameters are downloaded to the ROM of
each module.

 When "RAM/ROM" is selected, the parameters are downloaded to both
RAM and ROM of each module.

Download button Downloads the parameters of the module specified at "Select".

While the parameters are downloaded, this button cannot be clicked.

Cancel |, ,ton Stops download.

Only while the parameters are downloaded, this button can be clicked.

Selectthe module whose parameters will be downloaded, by clicking on
the 'Select button to the left of the module name, so that it appears

checked:
Select*1 1 4
L
No.*1 Displays the module No.
Module Name *1 Displays the module name.

Displays the download execution status.
Refer to (1) in this section for details of the execution status.

Close bution Closes this screen.

While the parameters are downloaded, this button cannot be clicked.

Status *1

*1: For the module whose parameters cannot be edited, this item is grayed out and is not
available, as parameter download is not necessary.

(1) Download execution status
Details of the download execution status are described below.

Display Description

Indicates the module that does not have parameters or to which
parameters are not downloaded.

Wait Indicates the status prior to download.
Writing... Indicates that download is in progress.
Complete Indicates that download is completed.
Error Indicates a failure in download.
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10.5 Offset/Gain setting of intelligent function modules

i- _Boint

For details of this function, refer to the manual of the used intelligent function module.

PURPOSE

Sets the offset value or gain value of the intelligent function module*1.
*1: The following gives the examples of the intelligent function modules to which the
offset or gain value can be set.

* ST1IAD2-V * ST1IAD2-I
* STIDA2-V * ST1DA1-I
* ST1IDA2-V-FO1 * ST1IDA1-I-FO1

For details, refer to the manual of the used intelligent function module.

BASIC OPERATION

(1) On the "System Monitor" screen, select the intelligent function module for which
the setting will be made.

(2) On the "System Monitor" screen, click the button of "Forced Output Test
Mode" to change the MELSEC-ST system to the forced output test mode.
When the MELSEC-ST system is changed to the forced output test mode, the
RUN LED of the head module flickers.

(3) Execute any of the following operations.
¢ Click the [Online] - [Offset/Gain Setting] menu.

« Right-click the module selected in (1), and click | Offset/Gain Setting | 4,
the menu.

« Click the [Offset/Gain Setting] button on the "System Monitor" screen.

(4) The dialog box appears asking whether or not the MELSEC-ST system will be
changed to the offset/gain setting mode.

Click the button to change the system to the offset/gain setting mode.
When the system changes to the offset/gain setting mode, the RUN LED of the
target intelligent function module flickers (at 0.5s intervals) and the module's
operation is stopped.

(5) Select the channel to be set at "Select Channel”, choose the wiring method of the
base module at "Connection Method", and select the value to be set from "Offset"
or "Gain".

(6) Set the offset or gain value adjustment amount, and click the button.
Repeat the operation in Step (6) until the desired value is reached.
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(7) Click the Save button to download the offset or gain value to that intelligent
function module.

(8) To close this screen, click the Close button.

(9) The dialog box appears asking whether or not the MELSEC-ST system will be
released from the offset/gain setting mode.

Click the button to release the system from the offset/gain setting mode.

REMARK

(@) Ifthe MELSEC-ST system is not in the forced output test mode after the operation
in Step (3) is performed, the dialog box appears asking whether or not the
MELSEC-ST system will be changed to the forced output test mode.

Click the button to change the system to the forced output test mode.

(b) Ifthe MELSEC-ST system is changed to the forced output test mode in (a), the
dialog box appears asking whether or not the MELSEC-ST system will be
released from the forced output test mode after the operation in Step (9) is

performed.
Click the button when releasing the system from the forced output test
mode.

Click the button when not releasing the system from the forced output test
mode.

DISPLAY/SETTING SCREEN

Offset/Gain Setting

b odule [nformation

Mo D2

Slice Mo. : 3 Module
Module Mame . ST1DAZA
Label Hame

Baze Module : STI1E-“4IR2

Select Channel

k-1 T o
Channel(s) + Dffset | a
o zet
" Gai ke gain
Write ko E<in |

Rk
Save all to

Clear
module
errars

Error Clear |
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@ DISPLAY/SETTING DATA

Item

Description

Module Information

Displays the information (No., start slice No., module name, label name,
base module) of the target intelligentfunction module.

Select Channel

Select the channel to which the offset or gain value will be set.

When multiple channels are checked, the offset or gain values will be set
to all the corresponding channels.

The channels displayed in this item change depending on the module of
the setting target.

For details, refer to the manual of the used intelligent function module.

Set the offset value adjustment amount.

Offset This item is available only when the "Offset" radio button is selected.
For details, refer to the manual of the used intelligent function module.
Set the gain value adjustment amount.

Gain This item is available onlywhen the "Gain" radio button is selected.

For details, refer to the manual of the used intelligent function module.

putton

Turns ON the IMI Error Clear to clear the error of the intelligent
function module.

Set

button

Applies the set value to the target module.

Save button

Validates the value set with the button.

button

Closes this screen and releases the system from the offset/gain setting
mode.

Releases the MELSEC-ST system from the forced output test mode if it
was notin the forced output test mode when this screen was opened.
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11  Monitor, Test

This chapter explains how to monitor and test the modules.

_ /@ﬁm

If during monitoring the PROFIBUS head module receives new configuration data (e.qg.
it is switched from version A to version B), all monitoring must be stopped and the
monitoring windows must be closed and reopened / restarted to awvoid indication

errors. |
|

11.1 System Monitor

PURPOSE

Monitors the statuses of the head module and slice modules.

BASIC OPERATION

(1) When the "System Monitor" screen is not displayed, click the [View] > [System
Monitor] menu to display the "System Monitor" screen.
This menu item is only available when the system is in “Diagnosis” mode. To
switch to “Diagnosis” mode, [Mode] - [Diagnosis].

(2) Monitor starts as soon as the "System Monitor" screen is displayed.

(3) To close this screen, click the Close button.

_ /@wint

The "System Monitor" screen is not displayed if the module configuration of the
MELSEC-ST system connected to the personal computer differs from that of the
project.

There is one exception to this - if the configurations are identical except for the head
module type, a message is shown giving the option to copy the head module details
from the live system and continue. This is intended to make it easier to reuse
configuration projects when changing the protocol type for a MELSEC-ST system.

Display the "System Monitor" screen after confirming that their module configurations
are the same.
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ii' HELPAN OPERATION

To identify the module where an error has occurred, execute the following operation on

the "System Monitor" screen.

(1) At "Select Module”, confirm the area displayed red or yellow.

(2) Click the | Display PDSitiDn| button corresponding to the area confirmed in (1).
(3) The module whose "Module Status" in the "Module display" is displayed red or

yellow is where the error occurred.

Scroll the "Module display" to identify the module whose "Module Status" in the
"Module display" is displayed red or yellow.

DISPLAY/SETTING SCREEN

B Sysiem Mantior

Commarization Shalus With Maghe

Module Slatus

.H-»-I-J.r Iil.|'|I|-n'|F|;r|| D Mml.h-'.v.-'.-ﬁh]

N
Madie Sesnus

O
O
O
[ Medids Change O
|
(|

Module o shor R TEE TR el

Modhie Hame : 5T14024 Dinglay elect

Ll Noaame Madule Posfion module

Rase Madde - ST1R-4iFy, OEtails B Cer - lange
— statug |

Start / stop
rorikoning

Wonios Swilch

Slop

Foiced Dutput Test Mods

Faorced
output kest
mode

[FF an | 0FF
I/ Dutpul | Ferced Qupedy
........... Wiorsl v Texst
Ditgat/Gain | Modn Ditad commands
Seitrg Inditration
Dk Mockde Paraimnites
Change. Setting
Llase _J
E DISPLAY/SETTING DATA
ltem Description

Module Information

Displays the information (module name, label name, base module) of the
module selected in the "Module display'.
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Item

Description

Communication Status With
Master Station

Indicates the status of communication between the head module and
master station.

"Communicating” : Communicating with the master
station

"Communication suspended” : Communication with the master
station suspended (Interruption)

"No communication” : Communication with the master

station stopped (No
communication)

Module Status m Red : System error
O Yellow :Warning
m Purple : Module being changed online

Displays the samples of the colors displayed under "Select Modules" and
under "Module Status" in the "Module display".

Module display

Displays the illustrative image of the MELSEC-ST system being
monitored.

When using the function specific to a certain module, click and select the
module from this item.

At "Module Status" above the module, the operating status of the slice
module is displayed.

Refer to (1) in this section for details of the module status.

Selected module

The currently selected module is shown with the slot number coloured in
grey. Click on a module to selectit.

Select Module Range

The numerals indicate the module Nos., and the color shows the
statuses of the modules in that range. The modules displayed in the
"Module display' can be changed.

Refer to (1) in this section for details of the module status.

| Display Position |

button

The numerals on the left of this button indicates the module Nos., and the
corresponding modules are displayed in the "Module display".

Monitor Switch

Starts/stops monitor.

button

Starts monitor.
This button is usable only while monitor is at a stop.

While monitor is executed, " * "flickers on the left side of this button.
Fanitar Switch

b onitarinig
indicator

StOP | putton

. Start S_t-:p_
rnakitaring rnatibaring
Stops monitor.

This button is usable only while monitor is executed.

Forced Output Test Mode

Sets/releases the MELSEC-ST system to/from the forced output test
mode, and displays the current mode status.

Forced Output Test Mode
OFF O OFF

ON

button

Sets the MELSEC-ST system to the forced output test mode.
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Item Description

OFF button Releases the MELSEC-ST system from the forced output test mode.

Monitors the input data and output data of the module selected in the

[ Input/Cutput Monitor|  ["Module display”.

Refer to 'Input/Output monitor' for details.

When no module has been selected, the error message is displayed and
monitor cannot be executed.

Runs a forced output test on the head module, output module or

| Forced Cutput Test| intelligent function module selected in the "Module display".

Refer to 'Forced output test' for details.

When no module has been selected, the error message is displayed and
the forced output test cannot be executed.

Sets the offset or gain value to the target intelligent function module which
| Offset/Gain Setting | is selected in the "Module display".

Refer to 'Offset/Gain setting of intelligent function modules' for details.
When no module has been selected, the error message is displayed and
the offset or gain value cannot be set.

Monitors the detail information and error status of the module selected in
_ _ the "Module display".

[ Module Detail |“fmmatm“| Refer to 'Module detail information’ for details.

button When no module has been selected, the error message is displayed and

monitor cannot be executed.

Performs the online change of the I/O module or intelligent function

| C@nline Module Change |[module selected in the "Module display.

Refer to 'Online module change' for details.

When no module has been selected, the error message is displayed and
online module change cannot be executed.

Sets the parameters to the head module, I/O module or intelligent function

‘ Parameter Setting | module selected in the "Module display".
Refer to Section 'Parameter setting' for details.

button

button

button

button

button .
When no module has been selected, the error message is displayed and
parameter setting cannot be executed.
Close button Closes this screen.

(1) Module status
Details of the module status are described below.

Display Description

mRed System error occurred.
For details of the error, refer to the manual of the corresponding module.

Warning occurred.

@ Yellow For details of the warning, refer to the manual of the corresponding
module.

m Purple Module being changed online

@ Gray Module not mounted
Gray is displayed for "Select Module" only.

O White Operating normally
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If the slice module is changed for another type of module during a monitor stop on this
screen and the monitor is then resumed, the items corresponding to the new module and
modules of the following Nos. are displayed red in the "Module Status" section.

MELSOFT
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11.2 Module detail information

® PURPOSE

Shows the module detail information, and monitors the corresponding module operation
status and error status.

BASIC OPERATION

(1) On the "System Monitor" screen, select the module to be monitored.
(2) Execute any of the following operations to display the "Module Detail Information”
screen and start monitor.
* Click the [Diagnostics] > [Module Detail Information] menu.
* Right-click the module selected in (1), and click [Module Detail Information] from
the menu.

« Click the | Module Detail Information | pytton on the "System Monitor"
screen.

(3) To update the operation status or error status, click the Refresh button.

(4) To close this screen, click the Close button.
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[CC-Link systems]
DISPLAY/SETTING SCREEN
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@ DISPLAY/SETTING DATA

Item Description

Displays the information of the module to be monitored.
This item includes the following information.
« Start slice No. *1
* Module name
* Label name
« Station No. *2
"---"is displayed if the Station No. set with the address setting switches
of the head module is outside the setting range.
For details, refer to "Current Error/Status” or "Error/Status Log" on this
screen.
» Base module name *1
Module Detail Information » Excl. station count*2 - the number of stations used for communications.
* Exp. cyclic setting*2 - the number of cycles taken to read the data.
*Version
The module version is displayed.
If a module does not support this, "- - -" is displayed instead.
+ Mode *2
« Communication baud rate *2
"--"is shown if the MELSEC-ST system is not communicating with the
master station.

. Bit Input *1/ Bit Output *1/ Word Input *1’ *3/
Word Output *1’ *3

Displays the current operation status or error information of the head
module.

Current Error/Status *2, *4

No. (HEX) Displays the error code in hexadecimal.
Current Error/Status Displays the operation status or error definition.

Displays the current operation status or error information of the target
module.

Current Error *1, *4

No. (HEX) Displays the error code in hexadecimal.
Current Error/Status Displays the operation status or error definition.

Displays the operation status or error history of the head module.

The latestlog is displayed in the top line (descending order).

This item displays up to five status or error logs. When information is
Error/Status Log *2, *4 added as the sixth status or error, the information is deleted in the order
from the oldest to the newest.

Switching off the external power of the MELSEC-ST system or resetting the
head module erases the data of this item.

No. (HEX) Displays the error code in hexadecimal.

Error/Status Log Displays the operation status or error definition.
Refresh button Updates the data of "Current Error/Status" and "Error/Status Log".
Close button Closes this screen.
Clear Log|pyton *2 Erases the data of "Error/Status Log".

The data of "Current Error/Status" are not erased.
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*1: This item is available for the power distribution module, I/O module or intelligent function module.
GX Configurator-ST does not distinguish between spring clamp (S) and screw (E) wiring types in
the base module.

*2: This item is available for the head module.

*3: *" is displayed for the Bit Input / Bit Output / Word Input /

Word Output when the target module does not occupy the corresponding area.
*4: For details of the errors, refer to the manual of the corresponding module.

i- /@am

In CCHink systems, the address ranges are sometimes referred to differently. CClink's
'RX and 'RY' ranges are equivalent to the 'Br' and 'Bw' ranges shown in GX Configurator-
ST and CC-link's 'RWr' and 'RWw' ranges are equivalent to 'Wr' and 'Ww'.

157



11 Monitor, Test MELSOFT

[PROFIBUS-DP systems]

DISPLAY/SETTING SCREEN
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@ DISPLAY/SETTING DATA

Item

Description

Module Detail Information

Displays the information of the module to be monitored.

This item includes the following information.

» Start slice No. *1

* Module name

* Label name

* FDL Address *2
"---"is displayed if the FDL address set with the FDL address setting
switches of the head module is outside the setting range (100 or later).
For details, refer to "Current Error/Status” or "Error/Status Log" on this
screen.

» Base module name *1

* Version
The module version is displayed.
If a module does not support this, "- - -" is displayed instead.

« Maximum Input/Output points *2

 Transmission speed *2
"--"is displayed when the MELSEC-ST system is not communicating
with the master station.

. Bit Input *1/ Bit Output *1/ Word Input*1’ *3/
Word Output *1’ *3

Current Error/Status *2, *4

Displays the current operation status or error information of the head
module.

No. (HEX)

Displays the error code in hexadecimal.

Current Error/Status

Displays the operation status or error definition.

Current Error *1, *4

Displays the current operation status or error information of the target
module.

No. (HEX)

Displays the error code in hexadecimal.

Current Error/Status

Displays the operation status or error definition.

Error/Status Log *2, *4

Displays the operation status or error history of the head module.

The latestlog is displayed in the top line (descending order).

This item displays up to five status or error logs. When information is
added as the sixth status or error, the information is deleted in the order
from the oldestto the newest.

Switching off the external power of the MELSEC-ST system or resetting the
head module erases the data of this item.

No. (HEX)

Displays the error code in hexadecimal.

Error/Status Log

Displays the operation status or error definition.

IMI button

Updates the data of "Current Error/Status" and "Error/Status Log".

Close | utton

Closes this screen.

Clear Log|pyton *2

Erases the data of "Error/Status Log".
The data of "Current Error/Status” are not erased.

*1: This item is available for the power distribution module, /O module or intelligent function module.
GX Configurator-ST does not distinguish between spring clamp (S) and screw (E) wiring types in

the base module.

*2: This item is available for the head module.
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*3: For the Word Input/ Word Output, "-" is displayed when the target module does

not occupy the corresponding area.
*4:. For details of the errors, refer to the manual of the corresponding module.

11.3 Input/Output monitor

® PURPOSE

Monitors the input data and output data of the module.

) BASIC OPERATION

(1) On the "System Monitor" screen, select the module to be monitored.
(2) Execute any of the following operations to display the "Input/Output Monitor" screen

and start monitor.
« Click the [Online] = [Input/Output Monitor] menu.
« Right-click the module selected in (1), and click [Input/Output Monitor] from the

menu.
« Click the [INput/Output Monitor | 1 t10n on the "System Monitor" screen.

(3) To close this screen, click the Close button.

_ /@wint

In CC-Link systems, the following areas are not available for I/O monitoring:

. Error Clear area

. Word Input area of intelligent output modules

. Word Output area of intelligent input modules
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DISPLAY/SETTING SCREEN
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@ DISPLAY/SETTING DATA

Item

Description

Monitor Switch

Starts/stops monitor.

button

Starts monitor.
This button is usable only while monitor is at a stop.

Fanitar Switch

. . . L] . . .
While monitor is executed, " ~ "flickers on the left side of this button.
Moniloring
indicatar _ Start
monitoring

Step | putton

Stop
manitoring
Stops monitor.

This button is usable only while monitor is executed.

Close | yutton

Closes this screen.

Module Information

Displays the information (start slice No., module name, label name) of the
module to be monitored.

Bit Data *1

Displays the input/output data of the target module in bit unit.

Word Data *1

When the target module is the intelligent function module, displays the

Word Input values and Word OQutput values.

Selecting the DEC or HEX radio button displays the values displayed
under "Value" in decimal or hexadecimal.

DEC: Decimal

HEX: Hexadecimal

*1: For details of each data, refer to the manual of the corresponding module.
*2: When the MELSEC-ST system is in the forced output mode, the values entered on the "Forced
Output Test" screen are displayed.

-

The rate at which values are updated on the "Input / Output Monitor" screen depends
on the following conditions:

* Transmission speed (refer to Transfer Setup)
e The number of open input/output monitor windows
e The status of the system monitor

To get the best input/output monitor performance:
¢ Do not open seweral input/output monitor windows
e Stop the system monitor
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The following refers to PROFIBUS-DP head module version B only

- DISPLAY/SETTING SCREEN

M [nput/Output Monitor No.4

Start / Stop
monitoring

Module Information

Slice Mo. 3 5 Modul
Module Mame  :  ST1DAZV R

details
Label Name :

Input /Output D ats

& DEC " HEX
Output D ata tem Value Input Data Item Value
Bit Output Area Caonvert setting request Mo request Bit Input Area Module ready Ready
CH1 output enable/disable flag) Disable Convert setting completed flag|No request
CH2 output enable/disable flag| Disable 'Word Input Area CH1 digital value 0
‘whord Output drea | CH1 digital value setting 0 CH2 digital value 0
Chz gtk setng [0 [ —|

Input / Qutput
data

Error Data

| Output Data I Item I Yalue I Input Daka lkem ‘Walue

Error Clear &rea Error clear request Mo request | Emor Information Area |CH1 emor information | Mo eror
CH2 emor infarmation | Mo emar
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@ DISPLAY/SETTING DATA

Item

Description

Monitor Switch

Starts/stops monitor.

button

Starts monitor.
This button is usable only while monitor is at a stop.

Fanitar Switch

. . . L] . . .
While monitor is executed, " ~ "flickers on the left side of this button.
Moniloring
indicatar _ Start
monitoring

Step | putton

Stop
manitoring
Stops monitor.

This button is usable only while monitor is executed.

Close | yutton

Closes this screen.

Module Information

Displays the information (start slice No., module name, label name) of the
module to be monitored.

/O data *1 *2 *3

Displays the input/output data of the target module.
When the target module is the intelligent function module, displays the

Word Input values and Word Output values.

Selecting the DEC or HEX radio button displays the values displayed
under "Value" in decimal or hexadecimal.

DEC: Decimal

HEX: Hexadecimal

Error Data *1

Displays error data of the target module

*1: For details of each data, refer to the manual of the corresponding module.

*2: When the MELSEC-ST system is in the forced output mode, the values entered on the "Forced
Output Test" screen are displayed.

*3: In the case of an intelligent module which does not have an input sending area, output data will
be displayed in the input area / fields for troubleshooting. For example, if the output data values
are not being sent correctly, this display can be used to confirm that the output data reached

the intelligent module.
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11.4 Forced output test

PURPOSE
Runs an output test on the Bit Output, Word Output and

Error Clear bits of the head module and slice modules without stopping the PROFIBUS-
DP or CC-Link network.

BASIC OPERATION

(1) On the "System Monitor" screen, select the module to be monitored.

(2) On the "System Monitor" screen, click the button of "Forced Output Test
Mode". This displays a screen asking whether or not the MELSEC-ST system will
be changed to the forced output test mode.

Click the button to change the MELSEC-ST system to the forced output
test mode.
When the MELSEC-ST system is changed to the forced output test mode, the
RUN LED of the head module flickers.

(3) Execute any of the following operations to display the "Forced Output Test" screen.
* Click the [Online] - [Forced Output Test] menu.
* Right-click the module selected in (1), and click [Forced Output Test] from the

menu.

* Click the | Forced Cutput Test | button on the "System Monitor" screen.
(4) On the "Forced Output Test" screen, select the forced output test item and set

data, and click the button to start the forced output test.
(5) When the forced output test is completed, the "Completed" message is displayed.

Click the button.
(6) To close this screen, click the Close button.

(7) On the "System Monitor" screen, click the button of "Forced Output Test
Mode" to release the MELSEC-ST system from the forced output test mode.
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(1) If any of Conwert setting request, | Bw.n+3| , | Bw.n+2| cHO output
permission ON/OFF, and Ww.n , [Ww.nt 1| oy gigital value setting is

changed in the forced output test, fully ensure safety before starting the test as the
analog output will change.

(2) When the communication between the MELSEC-ST system and master station is

disconnected, changing the Bw.n+1 Convert setting request of the intelligent
function module, whose cHU cLEAR/HOLD/IPRESET setting is set to HOLD, from

ON to OFF in the forced output test turns the Word Output value to 0.

In this case, the Word Output value will not return to the held value if the
forced output test mode is canceled.

i- it

In CC-Link systems, the following areas are not available for forced output tests: ‘

MELSOFT

. Word Output area of intelligent input modules

REMARK

(@) Ifthe MELSEC-ST system is not in the forced output test mode when the

button is clicked in (4), a screen appears asking whether or not the
MELSEC-ST system will be changed to the forced output test mode.

Click the button to change the system to the forced output test mode and
start the forced output test.

(b) When the MELSEC-ST system was changed to the forced output test mode in
(a), a screen appears asking whether or not the system will be released from the
forced output test mode after the operation in Step (6) is performed.

Click the button when releasing the system from the forced output test
mode.

Click the button when not releasing the system from the forced output test
mode.
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DISPLAY/SETTING SCREEN

M Forced Output Test No.4

F
Select /

deselect all

items

tadule Infarmation Set output
Slice Mo . 5 dobos
Module Mame @ ST1DAZY
Label Marme
Bit Data
Output D ata Select Item Name Yalue
Bit DutEutAree Ll |Conveit setling request Ma request -
L1 |CH1 output enable/disable flag | Disable v
L1 |CH2 ouwlput enable/disable flag | Disable -
Bit
data
‘wiord D ata
¢ DEC ( HEX
Dutput D ata Select Itemn Mame Y alue
word Output Area L1 |CH1 digital value setling 0
L1 |CH2 digital value setling 0
Enor Clear Data-
Output D ata Select ltem Mame Walue
Eror Clear Area 1 |Emor clear request Mo request -
1 Ermor clear
\\_ data
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@ DISPLAY/SETTING DATA

Item

Description

Select All| puton

Checks all "Select" check boxes of "Bit Data" and "Word Data". A'tick' is
shown to indicate thatthe parameter is selected, as shown in the picture
below.

Select 4
ol [Cons

L

Release All |, ,ton

Unchecks all "Select" check boxes of "Bit Data" and "Word Data".

button

Runs a forced output test on the Bit Output, Word

Output*2 and (in PROFIBUS-DP only) Error Clear whose "Select"

check boxes are checked.

( Error Clear bits are available for PROFIBUS-DP only)

When the forced output testis completed, the "Completed" message is
displayed.

button

Closes this screen.

The screen to release the MELSEC-ST system from the forced output test
mode is displayed if the system was notin the forced output test mode
when this screen was opened.

Module Information

Displays the information (start slice No., module name, label name) of the
module on which a forced output test will be conducted.

Bit Data *1

Select the bit data on which a forced output test will be conducted by
checking the corresponding "Select" check box, and set the bit value to be
output at "Value".

Word Data *1 *2

Select the word data on which a forced output test will be conducted by
checking the corresponding "Select" check box, and set the word value to
be output at "Value".

Selecting the DEC or HEX radio button changes the input format of "Value"
to decimal or hexadecimal.

DEC: Decimal

HEX: Hexadecimal

Error clear data

Select the error clear data on which a forced output test will be conducted
by checking the corresponding "Select' check box, and set the word value
to be output at "Request".

*1: For details of each data, refer to the manual of the corresponding module.
*2: In CC-Link systems, word output data is not available for intelligent input modules.
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11.5 Master station data communication monitor

11.5.1 Master station data communication monitor

PURPOSE

Monitors the input/output data between the master station and head module of the
PROFIBUS-DP or CC-Link system.

BASIC OPERATION

(1) Click the [Diagnostics] = [Master Station Data Communication Monitor] menu to
display the "Master Station Data Communication Monitor" screen and start
monitor.

(2) At "Select Area", select the I/O data to be displayed in the "Data display".

(3) To save the monitored data into a text file, click the button to stop monitor,

and click the | Copy to File | button.
Refer to 'Saving the communication data' for details.

(4) To close this screen, click the Close button.

DISPLAY/SETTING SCREEN

Master, Station Data Communication Monitor

Area

filker
display
format lirW'old Data tonitor ‘é Start / stop
(" DEC(signed) ¢ DEC{unsigned] (= HEX \ Stop | moritaring

address [FlE|D]c]e

Export data to
file

Copy ta File | Cloge ‘

Bit Input Area

Word Select Area

[ 1] 0] word Dara
H4440
HOGO0
HOGO0
HOGO0
HOGO0
HOGO0
HOGO0
HOGO0
HOGO0
HOO00

o HOOO0

T HoOoo
HOO00
HOO00
HOO00

D00 HOoon

o
oo |
- |
Ex
[ |
N
o |
I |

Drata in bit
format

Lot it | vilar I a-iile Tl SRl ar i o
Lot Il e e R el e Tle e e R o
Lt B o Lo Lo Lo o o Lo )

o D D D D D D (D D D D D

(T T D D D D D D DD D D D D D
pec it e o o B Bk o b Lo B o I o i o o L o B
(D D D D D D D D D DD D D D DD
g iNb e I G R R T e e R o e T e T
OOOOOODOOOOOOOO—';
cocloococococlo oo ool oo ol
(D D D D D D D D D DD D D D DD
g iNb e I G R R T e e R o e T e T
et e e e B b T B e S L BB o T o S e R ]
(T T D D D D D D DD D D (D D D D
pec it e o o B Bk o b Lo B o I o i o o L o B
(D D D D D D D D D DD D D D DD

it e o i ar)
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[CC-Link systems]
E DISPLAY/SETTING DATA

Item Description

From among the following items, select the I/O data to be displayed in the

"Data display".
Bit Qutput Area : Bit Output Area

*
Select Area *1 Word Output Area : Word Output Area

BitInput Area : Bit Input Area
Word Input Area : Word Input Area

Saves the monitored data into a text file.

- Refer to 'Saving the communication data’ for details.
| CDW to File | button While monitor is executed, this button is not usable.

Save the data after clicking the button to stop monitor.

Close button Closes this screen.
Changes the representation of the word values in the text file to be saved
Word Data with the

| CDW to File | button and in the "Data display".

DEC(signed) Displays the values in signed decimal.

DEC(unsigned) Displays the values in unsigned decimal.

HEX Displays the values in hexadecimal headed by "H".
Monitor Starts/stops monitor.

Starts monitor.
This button is usable only while monitor is at a stop.

button

tanitar Switch

While monitor is executed, " * "flickers on the left side of this button.
h:iorjitoring )
indicator _ Chart S_top_
rakitaring rnatibaring
Stop | button Stops monitor.

This button is usable only while monitor is executed.

Displays the data in the data range selected at "Select Area".
Data display *1 "Address" is the offset address of the data selected at "Select Area", with
Address 0 set as the start address.

*1: For details of the I/O data, refer to the Head Module Manual.
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[PROFIBUS-DP systems]

E DISPLAY/SETTING DATA
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Item Description

From among the following items, select the I/O data to be displayed in the

Select Area *1

"Data display".
PROHFBUS-DP version A:

All Area
Bit Output Area

Error Clear Area

System Area

Command Execution Area

Word Output Area

Bit Input Area

Error Information Area

Module Status Area

Command Result Area

Word Input Area
PROFBUS-DP version B:

1 All /O data

: Bit Output Area

: Error Clear Area

: System Area

: Command Execution Area
: Word Output Area

: Bit Input Area

: Error Information Area

: @ Module Status Area

: Command Result Area

: Word Input Area

All Area :All /O data
Output Area : Output Area only *2
Input Area - Input Area only *2

| Copy to File |, uon

Saves the monitored data into a text file.
Refer to 'Saving the communication data' for details.
While monitor is executed, this button is not usable.

Save the data after clicking the button to stop monitor.

Close | puiion

Closes this screen.

Word data

Changes the representation of the word values in the text file to be saved
with the

| CDW to File | button and in the "Data display".

DEC(signed)

Displays the values in signed decimal.

DEC(unsigned)

Displays the values in unsigned decimal.

HEX

Displays the values in hexadecimal headed by "H".

Monitor

Starts/stops monitor.

button

Starts monitor.
This button is usable only while monitor is at a stop.

Fanitor Switch

. . . ® . . .
While monitor is executed, " " flickers on the left side of this button.
Monitoling
indicator _ Srart
monitaring

StOp | putton

Stop
manitoring
Stops monitor.

This button is usable only while monitor is executed.

Data display *1

Displays the data in the data range selected at "Select Area".
"Address" is the offset address of the data selected at "Select Area"”, with
Address 0 set as the start address.
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*1: For details of the I/O data, refer to the Head Module Manual.

*2: In PROFIBUS-DP version B systems, the input/output area layout depends on the configuration
details (for example, byte packing).

REMARK

When confirming the data for each module, use the "Input/Output Monitor" screen.
Refer to 'Input/Output monitor' for details.
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11.5.2 Saving the communication data

PURPOSE

Saves the I/O data, which were monitored on the "Master Station Data Communication
Monitor" screen in 'Master station data communication monitor', into a text file.

BASIC OPERATION

(1) On the "Master Station Data Communication Monitor" screen, click the
button to stop monitor, and then click the | Copy to F“e| button.

(2) Set the destination directory and file name, and click the Save button to save
the monitored data into a text file and close this screen.

DISPLAY/SETTING SCREEN

Capy to fil 7]
Sawe iy [ 3 SLICE - - E e E-
___'IBFP
| Masher
Fie rame: | Savs
Save as ype: | Morser clal sl 1) =] Carel |

@ DISPLAY/SETTING DATA

Item Description
Save in Select the directory that stores the monitored data.
File name Set the file name of the monitored data.
Save button Saves the project with the file name specified at "File name".
Cancel button Closes this screen without saving the project.
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(1) Example of text file for saving data
The following shows an example of the text file for saving data.
I MasterStationCommsOutput.txt - Notepad E]@

File Edit Format ‘iew Help

@¥ Configurator-sT Master Station Data Communication Monitor
Monitor Data : All Area

QOO 0000000000 O0OOO0OO0OO00 @ HOOQOD
ool - 00000 OQOO0OO0OO0O0O0O0O000 P HOODO
QO02 - 0000 O0CQO0OO0OO0O0OO0OO0Q0O0O00 ¢ HOOOOD
Q003 - 0000 O0QCQO0O 000000000 ¢ HOOOOD
oopd - 00 0000000000000 0 ¢ HOOOD

11.6 PROFIBUS-DP Network Parameter Monitor (PROFIBUS DP only)
11.6.1 PROFIBUS-DP Network parameter monitor

PURPOSE

Confirms of the slave parameters and PROFIBUS-DP network parameters sent from the
master station of PROFIBUS-DP to the MELSEC-ST system.

BASIC OPERATION

(1) Click the [Diagnostics] 2 [PROFIBUS-DP Network Parameter Monitor] menu to
display the "PROFIBUS-DP Network Parameter Monitor" screen and start
monitor.

(2) To save the monitored data into a text file, click the button to stop monitor,

and click the | Copy to File | button.
Refer to 'Saving the PROFIBUS-DP network parameter data' for details.

(3) To close this screen, click the Close button.
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DISPLAY/SETTING SCREEN

Start / ztop
mohitaring

tanitor

= | *

PROFEIBUS-DP Network Parameter Monitor
file

Copy ta File | Close ‘

| Stop |

Address

ol1]alzs]als]s]lz]ala]lale]c

lolelr

MELSOFT
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oo
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an
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a0
oo
oo
oo
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an
a0
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a0
oo
oo
oo
an
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o0
oo
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oo
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oo
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oo
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oo
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oo
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o0
(ale]

a0
oo
oo
[a1v]

a0
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g
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g
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M etwork,
parameter data

E DISPLAY/SETTING DATA

ltem

Description

Monitor

Starts/stops monitor.

button

Starts monitor.
This button is usable only while monitor is at a stop.

While monitor is executed, " * "flickers on the left side of this button.

Fonitor Switch

~— B Stop
Maritaring
indicator Chart
mohitaring

Sto

button

Stop
manitoring
Stops monitor.

This button is usable only while monitor is executed.

| Copy to File |, ,uon

Saves the monitored data into a text file.
Refer to 'Saving the PROFIBUS-DP network parameter data' for details.
While monitor is executed, this button is not usable.

Save the data after clicking the button to stop monitor.

Close | puiton

Closes this screen.

Data display *

1

Displays the slice module parameters and PROFIBUS-DP parameters
sent from the master station of PROFIBUS-DP to the MELSEC-ST system.
"Address" is the offset address of the monitored parameter, with Address

0 set as the start address.
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*1: For details of the data, refer to the manual of the used master station or configuration software.

11.6.2 Saving the PROFIBUS-DP network parameter data

{b PURPOSE

Sawes the data, which were monitored on the "PROFIBUS-DP Network Parameter
Monitor" screen in PROFIBUS-DP network parameter monitor' into a text file.

) BASIC OPERATION

(1) On the "PROFIBUS-DP Network Parameter Monitor" screen, click the
button to stop monitor, and then click the | Copy to F“e| button.

(2) Set the destination directory and file name, and click the Save button to save
the monitored data into a text file and close this screen.

DISPLAY/SETTING SCREEN

Capy Io file [ /%]
Saveine [ L SLICE B = =

___’lﬂl"F

*| Masher

Flerame: | Sevs
Save as jpe [Morstor dlalal” 1) | Corcel |

E DISPLAY/SETTING DATA

Item Description
Sawve in Select the directory that stores the monitored data.
File name Set the file name of the monitored data.
Save button Saves the project with the file name specified at "File name".
Cancel button Closes this screen without saving the project.
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(1) Example of text file for saving data

The following shows an example of the text file for saving data.

£ ProfibusDPnetParamMonitor.txt - Notepad

oooo
000l
ooo2
o003
0004
0005
0006
Qoov
ooos
o009

000B
QooC

Fil=  Edit
= Configurator-sT

0004

Format

oo
oo
oo
oo
oo
oo
oo
oo
oo
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oo
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oo
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oo
oo
14
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oo
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oo
oo
oo
oo
oo
oo
oo
oo
oo
4]
oo
oo

oo
o]4]
oo
oo
oo
oo
oo
oo
oo
oo
(]4]
oo
oo

oo
oo
oo
oo
oo
oo
oo
oo
oo
oo
oo
oo
oo

oo
Qo
oo
oo
oo
oo
]4]
oo
oo
oo
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]4]
oo
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oo
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oo
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oo
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oo
oo
oo
oo
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oo
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oo
oo
oo
oo
]4]
oo
oo
oo
4]
]4]
oo
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oo
oo
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4]
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12  Online module operation

This chapter explains the functions for operating each module from GX Configurator-ST in the online
mode (where the MELSEC-ST system and personal computer are connected).

12.1 Reset head module

® PURPOSE

Resets the head module from GX Configurator-ST.

BASIC OPERATION

(1) Click the [Online] > [Reset Head Module] menu.
(2) When there is a window being monitored, a screen appears asking whether monitor
will be stopped or not.

Click the button to stop monitor.

(3) A screen appears asking whether the head module will be reset or not.

Click the El button to reset the head module, and check the LED status (on/
off) to see if the head module has been reset.
While the head module is reset, all LEDs are off. When reset is completed, the
LEDs turn on again.
Confirm that all LEDs turn on after they have turned off once.

(4) A screen appears asking whether a reset request has been issued to the head
module or not.

Click the button.

(5) When monitor is stopped in Step (2), a message appears asking whether monitor
will be resumed or not.

Click the button to resume monitor.
Click the button to keep monitor stopped.
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12.2 Online module change

(1) Online module change function
The I/O modules (except ST1X1616-DE1-S1) and intelligent function modules can be
replaced without stopping the MELSEC-ST system.
An online module change can be executed by operation of the head module buttons or from
GX Configurator-ST.
This section explains how to perform an online module change from GX Configurator-ST.

12.2.1 Precautions for online module change
The precautions for the online module change are given below.

(1) To perform the online module change, the system configuration must be appropriate for
execution of the online module change.
For details, refer to the MELSEC-ST System User's Manual, "3.4 Precautions for System
Configuration”.
Executing the online module change in an inappropriate system configuration may result in
malfunction or failure.
In such a system configuration, shut off all phases of the external power supply for the
MELSEC-ST system to replace a slice module.

(2) Be sure to perform an online module change in the procedure given in ‘Procedures for online

module change'.
Failure to do so can cause a malfunction or failure.

(3) Before starting an online module change, confirm that the external device connected with the
slice module to be removed will not malfunction.

It is recommended to set O (OFF) to Bit output and Word output of the

slice module to be replaced in advance.

(4) Only the slice modules of the same model nhame can be replaced online.
It is not possible to replace with/add the slice module of different model name.

(5) Only one slice module can be replaced in a single online module change.
To replace multiple slice modules, perform an online module change for each module.

(6) This function is available for I/O module (except ST1X1616-DE1-S1) and intelligent function
module; not available for power distribution module and base module.
Shut off all phases of the external power supply before installing or removing the power
distribution module and/or the base module.
Failure to do so may result in damage to all devices of the MELSEC-ST system.

(7) While an online module change is in execution (while the head module's REL. LED is on), no
command can be executed to the slice module being replaced online.
If a command is executed to such a slice module, an error will occur.

(8) To change parameters of a slice module that is in execution of online module change (while the
head module’s REL. LED is on), wait until the online module change is completed.
If any parameter setting is changed during online module change, upon completion of the
online module change, the modified setting is overwritten with the parameters saved into the
head module and does not take effect.

(9) During an online module change, the ERR. LED of the head module turns on only when an error
related to the online module change occurs.
It will not turn on or flicker when any other error occurs.
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(10) While an online module change is being executed (while the REL. LED of the head module is
on), the following data of the slice module being replaced online all turn to 0 (OFF).

. Bit Input
. Error Information (PROFIBUS-DP only)

. Module Status (PROFIBUS-DP only)
. Word Input

(11) When the communication with the master station is disconnected, replacing the output module

online, whose CLEAR/HOLD setting is set to HOLD, turns the Bit Output value to 0
(OFF).

After the online module change is finished, the Bit Output value will not return to the
held value.

(12) When the forced output test is executed on the slice module being replaced online, only

Error Clear can be tested ( Error Clear bits are available for PROFIBUS-DP

only).

Bit Output and Word Output cannot be tested.
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12.2.2 Procedures for online module change

This section explains the procedures for the online module change.
Replace a module online as shown below.

Is the online module change
executable in the system
configuration? *]

Has the preparation been
done for the online module
change?*?

=
=]
——— - —————— ———

Is disconnection from the No
external device pussible?*3
Yes Online module change is not executable. Shut off
all phases of the external power supply for the
MELSEC-5T system and replace the slice module.
Execution of online module change
|Preparﬁti|:|n for the slice module replacement | ... Refer to 'Online module change from GX Configurator
ST'. 1) to 3).
|Discunnec:1iun from the external device | ... Refer to the corresponding SLICE module manual. "
|Slice module replacement | ... Refer to 'Online module change from GX Configurator
ST'. 5) and 6).
|C|:|nnec:1i|:|n to the external device after replacement | ... Refer to the corresponding SLICE module manual. "3
|0peratiuns after connecting the external device | ... Refer to 'Online module change from GX Configurator-
ST, 8) to 10).

'

End

*1: Refer to the MELSEC-ST System User's Manual, "3.4 Precautions for System Configuration".
*2: Refer to "Preparations for online module change" in the corresponding slice module manual.
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*3: Refer to "External device connection and disconnection procedures for online module change".

12.2.3 Online module change from GX Configurator-ST

Here is an explanation of how to replace a module online from GX Configurator-ST.

_ /@wint

If a slice module different from the target one is selected by mistake, restart the operation as
instructed below.
(1) To restart the operation at step 3)

Click the Cancel button on the screen to terminate online module change.

(2) To restart the operation at step 4)

Click the Next button without executing online module change, continue to step 10)
and then terminate online module change.
(3) To restart the operation at step 8)

Mount the removed slice module again, click the Next button, continue to step 10) and
then terminate online module change.

| Preparation for replacing slice module |

SRR [EE] 1) Select the slice module to be replaced online on the
e e e "System Monitor" screen.
::h:::::u STIB-aRz Clor
Comewricstion 5istz With Maste Station Sdn a s“ua D
O
Ma Conrnscaion madula =
s Siaius =
[ Hodue e B[] Miodule wamieg [ Hosuis Change o0 :
(]
Mo, { 5] 1 R E = :

Manior Swich

-

sep |

Forced Oupd Ted Mode
OFF o oFF |

Ingdupik
M.

Difoatiisin | Mochie Dtad

Sottng Infmeaion.
Drdint Mockie | Pussnates

Charge Zating

Chain |

Fobced Outpuk:
Teal..
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2) Click the | Online Module Change | button on the

"System Monitor"screen.
Then, confirm that the RUN LED of the selected
slice module is flashing at 0.25s intervals.

REMARKS

| nput/Cutput Forced Qutput
kd anitar. . Test...
OffzetiGain tadule D etail
Setting... |nformation...
Online Maodule Parameter
Change... I%_ Setting...
Cloze

'

(To the next page)
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In addition to above, the following operations are also
available.

e Select [Diagnostics] = [Online Module Change].

¢ Right-click the slice module selected at step 1), and

click | Cnline Module Change | on the menu.
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(From the previous page)

Online Module Change
Target Module
Mo, H
Slice No. g

Module Name © ST1DAT]

Label Mame

BaseModule : ST1B-4IR2

Details of mods
selected for
teplacement

Start Onling Module Change.

1.Please confim the madule.
2.Please click "Next" button,

Bbort changs

Cancel

£

'

(To the next page)

3) Confirm that the slice module displayed as "Target
Module" is the slice module to be replaced and click

the Next button.
(a) Clicking the LIN®Xt| putton validates the

settings and the following will be performed.

¢ Puts the head module into the online module
change mode.

e Sawes the parameters of the target slice
module into the head module.

(b) After clicking the Next button, confirm the

following module statuses.

e The REL. LED of the head module is on.

e The RUN LED of the target slice module is
off.

e The "Module Status" indicator of the target
module has turned purple (m). This applies
only when monitoring from the "System
Monitor" screen.

(c) If the parameters cannot be read from the slice
module, the REL. LED and ERR. LEDs of the
head module will turn on, and an error message
will appear on the screen at step 8).

In this case, confirm the error details and take
corrective action.

For how to read error codes and error code
details, refer to the Head Module Manual.

When not executing online module change, click

the Cancel button.
(@) Clicking the Cancel button causes the

screen to show that online module change is
cancelled.

Clicking the button returns to the step 1).
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Disconnection from external device
4) When the left screen appears, disconnect the

Target Module

Mo, o4

Slice No. :

Module Name © ST1DAT]
Label Mame -

BaseModule : ST1B-4IR2

Execute Onling Module Change:
1 Please exchange the module
2 Please click "Next" button.

online.

(To the next page)
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external device from the slice module to be replaced

For details, refer to "External device connection and
disconnection procedures for online module change”
in the corresponding slice module manual.

- /@int—

If the disconnection procedure given in the rele\
slice module manual cannot be executed, shut
phases of the external power supply for the ME
ST system to replace the slice module.

Replacing slice module

5) Remove the slice module to be replaced from the

base module.

6) Mount a new slice module with the same model

name as the one of the remowved.
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(From the previous page)

| Connection to external device after replacement

7) After mounting a new slice module, connect it to the
external device.
For details, refer to "External device connection and
disconnection procedures for online module
change".

oooo®so
oooooo

N\

| Operations after external device connection |

8) After connecting the external device, click the
Next button on the screen in step 4).

(a) Clicking the Next button performs the

following.

e Checks whether the module name of the
newly mounted slice module is the same as
that of the removed one.

o Writes the parameters saved into the head
module (at step 3)) to the newly mounted
slice module.

(b) After clicking the Next button, confirm the

following module statuses.

e The REL. LED of the head module is flashing.

e The RUN LED of the newly mounted slice
module is flashing (at 0.25s intervals).

Clicking the Cancel button, i.e., interrupting

online module change returns to step 1). In this
case, select the same slice module as selected
before, and complete online module change. Note
that selecting different one causes an error.
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Online Module Change
Target Module:
No. H::
Slice Ma. © 5
todule Hame : ST1DAZA
Label Name  :
Base Module : ST1B-4R2

)

Failed to write the parameter.
Please click "Next" button to operate with default parameters.

In case of changing the parameter settings, please close with “Cancal” button, writs parameters
with "Parameter Selling” and after that execute "Online Module Change" again.

et > I Cancel

'

(To the next page)

If the parameters could not be read from the
removed slice module in step 3), the REL. and ERR.
LEDs of the head module will turn on and the left
screen will appear in GX Configurator-ST.

In this case, confirm the error details and take
corrective action.

For how to read error codes and error code details,
refer to the Head Module Manual.

When step 10) has completed in this status, the
intelligent function module starts its operation with
the command parameters set as default.



12 Online module operation

(From the previous page)

Online Medule Change
Target Modules
Mo, 4
Slica Mo, 7
Module Mame : ST1DAT
Label Mame
Base Module : ST1B-*4IR2

Please click "Mext" button to start the changed module operations,

Online Module Change can be cancelled by "Cancel” button.

Online Module Change
Target Moduls
Mo, 4
Slica Mo,
Module Mame : ST1DA1
Label Name
Base Module : STIB-4IR2

Online Module Change is completed.

X

MELSOFT

9) Clicking the Next button releases the head

module from the online module change mode.

(@) Clicking the Next button performs the

following.

¢ Releases the head module from the online

module change mode.

¢ Restarts refreshing the I/O data, etc.

(b) After clicking the Next button, confirm the

following module statuses.

e The REL. LED of the head module is off.
e The RUN LED of the newly mounted slice

module is on.

e The "Module Status" indicator of the target

slice module has turned white (&). This
applies only when monitoring from the
"System Monitor" screen.

(c) If the head module cannot be released from the

online module change mode, both REL. LED
and ERR. LED of the head module turn on.

In this case, confirm the error details and take
corrective action.

For how to read error codes and error code
details, refer to the Head Module Manual.

When interrupting online module exchange, click

the button.

(a) Clicking the Cancel button, i.e., interrupting

(Completion)

online module change returns to step 1). In
this case, select the same slice module as
selected before, and complete online module
change. Note that selecting different one
causes an error.

10) The left screen appears showing that online module
change has been completed.

Click the Finish button.
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13 Reference

13.1 Key operations list

Some of the commonly-used menu items are also available on shortcut keys, listed

below.

File
Operation Contents Key operation
New Ctrl+ N
Open Ctrl+ O
Save Ctrl+ S
Print Ctrl+ P

Edit
Operation Contents Key operation
Undo Ctrl+Z
Redo Ctrl+Y
Add Ctrl + Insert
Delete Ctrl + Delete
All Delete Shift + Del
Parameter Setting Fo
Option F10

Mode

Operation Contents

Key operation

Edit F2
Diagnosis F3
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13.2 Error messages

1321

This section will list the error messages that can be shown by the program, with advice
on how to prevent or fix the errors.

Communication errors

These errors are shown when GX Configurator-ST has problems communicating with the
SLICE hardware.

Message

Cannot communicate with Head module for one of the following reasons:

e Communications timeout.

® The preparation of communication environment is bad.

e Cable error.

e Cannot communicate with the transmission speed set up now.

To fix this, try:

¢ Checking the cable and selected port number
e Setting transmission speed to a lower value.
¢ Closing other communication software applications and trying again.

Description

This message occurs when it is not possible to make a connection to the
SLICE hardware.

Causes and
actions

This message will be shown if the connection to the SLICE hardware
cannot be opened. This could be due to a hardware or software problem:

e Hardware issues may include power failure to the SLICE hardware, the
cable becoming disconnected, the wrong type of cable being used, or
the cable being plugged into the wrong device.

e Software issues may include another program using the
communication port where the cable is connected.

Message

Cannot communicate with PLC.

Description

There was a problem communicating with the SLICE hardware.

Causes and
actions

¢ This message may be shown if the SLICE hardware does not respond
within a reasonable time. Check that the SLICE hardware is powered
on and that the correct cable is connected to the correct port on the
intended device.
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Message

Cannot communicate with Head module for one of the following reasons:

¢ Bad connection to the head module.
e The preparation of communication environment is bad.

To fix this, try:

e Checking the connection to the head module
¢ Closing other communication software applications and trying again.

Description

There was an error when sending / receiving data to or from the SLICE
hardware.

Causes and
actions

This message will be shown if the connection to the SLICE hardware
cannot be opened. This could be due to a hardware or software problem:

e Hardware issues may include power failure to the SLICE hardware, the
cable becoming disconnected, the wrong type of cable being used, or
the cable being plugged into the wrong device.

¢ This error message will also be shown if you use an earlier version of
GX Configurator-ST (such as 1.06G) to connect to a head module
configured for PROFIBUS-DP version B. This does not work due to
changes to the internal structure.

e Software issues may include another program using the
communication port where the cable is connected.

Message

Set data exceeds the range. Execute again after confirming set data. The
range that can be setis 1 - 9.

Description

This message is shown on the "Transfer setup' dialog, when a timeout
value outside the range 1-9 is set.

Causes and
actions

¢ Change the timeout value to a number from 1 to 9, and try again.

Message

Cannot process because of monitoring. Please stop all monitoring and
execute again.

Description

Some online operations are not possible while monitoring is in progress.
This message is shown if one of these operations is initiated while
monitoring is in progress.

Causes and
actions

e Stop monitoring for the duration of the operation, and restart it
afterwards.
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13.2.2 Diagnostic errors

The errors in this section can occur when the system is in diagnosis mode.

Message This feature cannot be executed during monitoring. Please execute again
after stop monitoring.

Description |[This message is shown when the 'Copy to file' button is selected on the
PROFIBUS-DP Network parameter monitor or Master station data
communications dialog, but monitoring is still active.

Causes and |e Stop monitoring before saving the data to a file. Monitoring can be

actions restarted after the file has been saved.

Message The module for the setting has not been selected. Please select the
module that is to be set in the System Monitor.

Description  [This error is shown on the system monitor screen, when an action is
selected (such as module detail information) without any module
selected for it to work on.

Causes and |e Select the module to use for the action, then try again.

actions

Message There is no monitor data to write to the file.

Description  [This error occurs when the 'Copy to file' button is selected on the
PROFIBUS-DP Network parameter monitor or Master station data
communications dialog, but there is no data available to save to the file.

Causes and |e Try again when there is some data available to write.

actions

Message Cannot monitor the Input/Output Data of the specified module.

Description  |/O monitoring was selected for a module, but the module does not
support it.

Causes and |e The selected module may not have any I/O to monitor. Check that the

actions correct module has been selected, then try again.
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Message

The module for the setting has not been selected. Please select the
module that is to be set in the System Monitor.

Description

An attempt was made to start /O monitoring without first selecting a
module.

Causes and
actions

e Make sure that the correct module is selected by clicking on it in the
system monitor display, then try again.

Message

The head module does not match, but the other modules are correct.
Copy the head module details from the live system and continue?

Description

When attempting to switch to diagnostics mode, it was discovered that
the head module type of the live system does not match the head module
type in the configuration, although the remaining modules do match. This
could happen if (for example) the head module in an existing SLICE
system was replaced with a different type of head module.

Causes and
actions

You can either:

e Answer 'Yes' at the prompt, in which case the system will copy the
head module details from the live system and continue - if you have
replaced the head module but wish to reuse the module parameters in
an old configuration file, this is the correct option.

e Answer 'No' at the prompt, if (for example) a connection has been
made to the wrong SLICE hardware. The 'wrong system configuration'
error will be shown (as below).

Message

The module configuration differs from the mounting state. Please check
the module configuration and execute again. Module No. ....

Description

This message is shown when switching to diagnostics mode, if the
configuration of the attached SLICE hardware does not match the
configuration being edited. The message shows the first module number
which is different.

Causes and
actions

¢ Check that the communication cable is connected to the right serial
port and the right SLICE hardware - there may be a connection to a
different system. 'Transfer setup' can be used to change the serial port
used.

¢ Make sure that the configuration file is up to date, in case new modules
have been added since the last time it was saved.

e |f you do not need to keep any parameters in the local file, use 'Get
system' to read the details of the connected system from the port.
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Message The configuration has changed. Please close all monitoring windows
before reactivating. Otherwise several indication errors could occur.

Description  [This error occurs if the configuration of the ST-series head module is
changed while monitoring is active (e.g. switched protocol from Version A
to B) and the changed configuration was loaded into GX Configurator-ST.

Causes and |e Close all monitoring dialogs and start monitoring again.

actions

Message This will start monitoring of the Input/Output Monitor?

Description  |When you switch from edit mode to diagnostics mode, and there are I/O
monitor windows open from a previous diagnostics mode session, you
will be prompted to restart monitoring.

Causes and |Either answer:

actions o ,
¢ 'Yes' - to restart monitoring in these windows, or
¢ 'No' - in which case monitoring will not be switched on in the open /O

monitor windows.

Message This will stop monitoring of the Input/Output Monitor.

Description  |This is a warning shown when switching from diagnostics mode to edit
mode while there is an I/O monitor active.

Causes and |e There is no action to take - when you click 'OK’, the active /O monitors

actions will stop monitoring.

Message Module Detail Information cannot be executed in the specified module.

Description  |This error can appear on the system monitor dialog when an attempt is
made to start the 'module detail information’ dialog for a module whose
details cannot be shown.

Causes and |e Make sure that the right module is selected, by clicking on it in the

actions system monitor dialog, then try again.
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13.2.3 File errors

196

These errors may occur when there are problems opening or reading from a file.

Message The file cannot be opened because the selected file is damaged.
Description  [An attempt was made to open a file which appears to be corrupted.
Causes and |e There may be a problem reading the file from a network drive, or the file
actions may have become corrupted.

e |f you have a recent backup of the file, check if the backup is readable.

Message This file has been created in latest version of application. Cannot process
it in this application.

Description  |[This message may be shown if you have created a file in a newer version
of GX Configurator-ST than this one (1.08J), and attempted to load it into
this version.

Causes and |e Open the file with the version of GX Configurator-ST in which it was

actions created.

Message The file cannot be opened because the selected file is damaged.

Description | The file was found and opened, but discovered to be corrupt.

Causes and |e It will not be possible to read the file - load a backup copy if you have

actions one, or if you have access to the SLICE hardware, use the 'Get

system' feature to read the configuration from the hardware.

Message The following error occurred during processing of the file. ...

Description  [While processing the file, the operating system reported an error. The
error description returned by the operating system is shown at the end of
the message.

Causes and |e The message should show what the problem was, and from this it

actions should be possible to work out the correct action to take.

Message Cannot use the specified file because it is being write protected. Please
check the attribute and try again.

Description  [Permission was denied to use the file.

Causes and |e Make sure that the file has not been opened elsewhere

actions

¢ Check that the file is not write protected - files can sometimes be left
write protected when (for example) they are copied from a backup CD.
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Message Cannot find the file.

Description | The file to be opened was not found.

Causes and |e Make sure that the file exists, and is not (for example) on an

actions inaccessible network drive.

Message Cannot use the specified file because it is being used by some other
application.

Description  |Another application has the file open, so GX Configurator-ST cannot use
it.

Causes and |e Look for other files that may be using the file, then switch to the other

actions application and close the file.
¢ [f the file still appears to be locked and there is no application apparently

using it, rebooting the PC may fix the problem.

Message The allowable No. of characters has been exceeded. Set to less than 150
characters.

Description  [Afile name was selected which is too long to use.

Causes and |e Enter a shorter file name, then try again.

actions

13.2.4 Forced output/offset and gain errors

These errors can occur when using the forced output / offset and gain settings dialogs.
For more information, see 'Forced output test' and 'Offset/Gain setting of intelligent
function module'.

Message The module for the setting has not been selected. Please select the
module that is to be set in the System Monitor.

Description  [An attempt was made to start the forced output test dialog without first
selecting a module whose outputs are to be written.

Causes and |e Make sure that a module is selected by clicking on it in the system

actions monitor dialog, then try again.
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Message The selected module cannot execute the Forced Output Test function.

Description  [An attempt was made to start the forced output test dialog for a module
that does not support forced output tests (e.g. because it has no suitable
outputs).

Causes and |e Select a module which does support forced output tests, by clicking on

actions it in the system monitor dialog, then try again.

Message Cannot change into the Forced Output Test Mode because the
communication error has occurred. Please execute again.

If selecting the "Cancel” button, please reset the head module because
the last value may be outputted when you next execute the Forced
Output Test function.

Description |[This message is shown when trying to switch on the ‘forced output test'
mode, if there is a communication error before the operation can be
completed. Pressing 'OK" will retry the connection, or pressing '‘Cancel’
will abandon the attempt.

Causes and |e Check the connections and try again. As the message suggests, if you

actions select 'Cancel' it is advisable to reset the head module to make sure

that there are no 'left over' output values the next time you switch to
forced output test mode.

Message Head module is in the status of the Forced Output Test Mode. Do you
want to release the Forced Output Test Mode?

Description |This message is shown when the operating mode is about to be
switched from 'diagnostics mode' to 'edit mode’, while the ‘forced output
test' mode is active.

Causes and |e This is a warning message - if you wish to continue using forced output

actions mode, cancel the change.

Message This will release the Forced Output Test Mode. Is it OK?

Description  [This prompt is shown when closing a forced output test dialog window
while the test is active.

Causes and |Either answer:

actions

e 'Yes' - to switch off forced output test mode before returning, or

* 'No' - to leave the forced output test mode active
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Message Mode setting is in the Forced Output Test Mode. Do you want to close in
the Forced Output Test Mode?

Description  |[This message is shown when the project file is about to be closed, but
the 'forced output test' mode is active.

Causes and |e This is just a warning message - if you wish to continue using forced

actions output mode, use the ‘cancel’ option.

Message It is possible to set Offset/Gain only during the Forced Output Test Mode.
Change into the Forced Output Test Mode?

Description  |[This message is shown when trying to set the offset and gain settings for
a module, when the system is not in forced output test mode.

Cagses and |e Offset/gain settings can only be set in forced output mode. Answer

actions 'Yes' at the prompt to switch to forced output test mode, or 'No' to

cancel the operation.

Message The selected module cannot set Offset/Gain.

Description  [An attempt was made to change the offset/gain settings of a module
which does not have offset/gain settings to change (such as the head
module or a power supply module).

Causes and |e [t is likely that the wrong module is selected - make sure that the

actions correct module (one which has offset/gain settings) is selected, and

then try again.

Message The module to be set has not been selected. Please select a module to
be set in the System Monitor.

Description  [This message is shown when attempting to show the offset/gain settings
dialog without first selecting a module for which the offset/gain settings
should be changed.

Cayses and |e Make sure that a module has been selected by clicking on it in the

actions 'system monitor' dialog, then try again.

Message The Window is closed during Offset/Gain Setting Mode. Please open the
Offset/Gain Setting and close again.

Description | The offset/gain dialog window was closed unexpectedly while setting
offset/gain settings.

Causes and |e Open the offset/gain settings window and try the operation again.

actions
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Message Channel has not been selected. Please select a channel.

Description  [This error is shown on the offset/gain settings dialog, when trying to write
the settings without first selecting one or more channels.

Causes and |e Select the channel(s) to which the new setting values should be

actions applied,

Message Please set the Offset/Gain Value.

Description |On the offset/gain settings dialog, the 'Set' button was used without
entering a valid value.

Causes and |e Make sure that a valid number has been entered for the new offset/gain

actions value, then try again.

Message Value input is out of range.

Description  |The value entered for the offset or gain setting is out of range, i.e. itis
below the lower limit for values, or above the upper limit for values.

Causes and |e Enter a value which is within the limits, then try again.

actions

Message Please select an Output Data.

Description  [On the forced output test dialog, the 'settings' button was clicked without
first selecting one or more outputs.

Causes and |e Make sure that at least one output is selected (checked) and try again.

actions

Message The value besides the range is set as the setting value.

Description  [This error is shown on the forced output dialog, if the output value
selected is not permitted. The value may be lower than the minimum
permitted, higher than the maximum permitted, or too large for the data
type (e.g. when trying to store a 32-bit value in a 16-bit setting).

Causes and |e Enter a value within the permitted ranges, then try again.

actions

13.2.5 Module addition and copying errors

200

These errors may be shown when new modules are being added to the system, or
copied from another file.
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Message Cannot add the module. Modules can be added to the maximum of ....

Description  |No more modules can be added to the system - the limit on the number
of modules in a SLICE system has been reached.

Causes and |e You may be able to reduce the number of modules needed by using

actions different types of modules.

e |f there is no way to reduce the number of modules needed, the only
solution is to install an additional SLICE system in a new rack with a
separate head module.

Message Cannot add the module. Bit Input/Output range exceeds ... points.

Description [lt is not possible to add the module, because the total number of bit /O
points in the system would exceed the limit.

Causes and |e In a PROFIBUS-DP system, the point mode is selectable, so you may

actions be able to change to a higher point mode and continue.

e [f there is no way to reduce the number of bit input/output points used,
the only solution is to install an additional SLICE system in a new rack
with a separate head module.

Message Cannot add the module. Word Input/Output range exceeds ... points.

Description |lIt is not possible to add the module, because the total number of word /O
points in the system would exceed the limit.

Cal_Jses and |e In a PROFIBUS-DP system, you may sometimes be able to switch to a

actions lower point mode to increase the number of word I/O items that can be

used.

e |f there is no way to reduce the number of word input/output items
used, the only solution is to install an additional SLICE system in a new
rack with a separate head module.
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Message Cannot add the module. Intelligent modules can be added to the
maximum of ...

Description  |lt is not possible to add the module, because the maximum number of
intelligent modules has already been reached.

Causes and |e In a PROFIBUS-DP system, the number of intelligent modules
actions permitted is affected by the point mode selected. You may be able to
change the point mode to allow more intelligent modules to be used.

¢ You may be able to install different types of intelligent modules in the
system to get the same results with a lower number of modules.

* You may be able to install one or more non-intelligent modules in the
system to get the same results.

e If more intelligent modules are still needed, the only solution is to install
an additional SLICE system in a new rack with a separate head
module.

Message The module could not be recognized. Module:... No...

Description [GX Configurator-ST does not recognise the module.

Causes and |e This message should not normally be shown. Uninstalling and
actions reinstalling the application may solve the problem.

Message The module isn't selected. Please select the module.

Description  |In the 'Add module' dialog, 'add’ was pressed before a module was
selected.

Causes and |e Select a module from the drop-down list, then try again.
actions

Message It cannot add the module in the specified position.

Description  |[In the 'Add module' or 'Copy module' dialog, an attempt was made to add
a module at an invalid slot number.

Causes and |e Correct the slot number and try the action again. The slot number
actions should not be before or at the head module slot, or beyond the end of
the rack.
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Message A missing number will be made. Is it OK to change the No. to ...?

Description  |In the 'add module' or ‘copy modules' dialog, an attempt was made to add
a module after the end of the rack. For example, if the last module in the
rack is in slot 8, an attempt to add a new module in slot 10 would cause
this error.

Cal_Jses and |e Either select 'Yes' to accept the suggested alternative (normally the slot

actions number just after the right hand end of the rack), or 'No' to cancel the

addition and re-enter the slot number manually.

Message Warning - after adding this module, the supply current is not sufficient.
Supply current : ... mA, Consumption : ... mA. Select 'OK' to add the
module anyway.

Description  |[This message is shown after adding a module in the wizard area, if there
was previously sufficient power supply to the modules in the
configuration, but adding the new module would cause more current to
be drawn than is being supplied.

Causes and |e Select 'OK' to add the module anyway and fix the power supply issue

actions later, or
e Select 'Cancel' to prevent the addition, so that another power supply

module (e.g. ST1PSD) can be added in the correct place.

Message Warning - there are not enough unused bits available. Unused bits
available : ..., Required : ... . Select 'OK' to add the module anyway.

Description | This message is shown after adding a module in the wizard area, if the
unused bits had not previously been exceeded, but adding the new
module would require the use of more unused bits than there are
available.

Causes and |e Select 'OK' to add the module anyway and fix the problem later, or

actions
¢ Select 'Cancel’ to prevent the addition, so that the marked module or

the module to the left of it can be changed to a standard module.
Depending on your configuration, you may be able to rearrange the
other modules to make better use of the unused bits to be able to use
them for byte packing.

Message There is no file path settings. Please check it again.

Description | This occurs when trying to use the 'Add' button on the 'Copy’ dialog
without having selected a valid path for the source file.

Cal_Jses and |e Select the source file to copy from using the 'Browse' button. There are

actions further instructions available in 'Copying the module information'.
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Message Cannot add the module. Maximum configuration reached.
Description  |No more modules can be added to the system - the limit on the number
of modules in a SLICE system has been reached.
Causes and |e Use a larger /O module instead of smaller ones.
actions
¢ You may be able to reduce the number of modules needed by using
different types of modules. If there is no way to reduce the number of
modules needed, the only solution is to install an additional SLICE
system in a new rack with a separate head module.
Message Cannot add the head module. Please select the other module.
Description  [This error is shown when adding to use the 'Copy' dialog to copy the
head module.
Causes and | The wrong module may have been accidentally selected, in which case
actions select the correct module to copy.

e The head module cannot be directly copied - however you can obtain
the same result by entering items such as the label name and
parameters manually.

13.2.6 Module configuration errors
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If a problem is detected with the module configuration, the affected module will be
highlighted in red in the module list. When the context menu is shown (e.g. by clicking on
the module with the right mouse button), the descriptions of the module errors will appear
at the top of the context menu.

The possible errors are:

Message Slot 1 should always contain a'..." module
Description  |[In a valid configuration, the first slot after the head module should always
contain a power supply module of the type shown in the message. This
provides power to the head module itself, as well as to the remaining
modules.
Causes and |e The power supply module is either missing, or in the wrong place.
actions Either move an existing power supply module to the slot immediately
after the head module, or install a new power supply module after the
head module.
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Message The power supply module in slot 1 should have an 'H-SET' base type
Description  [The first power supply module has the wrong base type selected - for the
first power supply after the head module, the base type should always be
'H-SET'. The remaining power supply modules have 'R-SET' base types.
Causes and |e Ensure that a power supply with 'H-SET' base type is installed
actions immediately after the head module. You can change the base module
type by right clicking on the slot and selecting '‘Option’ from the pop-up
menu. For more information see 'Option setting'.
Message The power supply module in this slot should have an 'R-SET' base type
Description | The power supply module in this slot has the wrong base type selected -
for power supply modules other than the first power supply after the head
module, the base type should always be 'R-SET".
Cal_Jses and |e Ensure that a power supply with 'R-SET" base type is used in this slot.
actions You can change the base module type by right clicking on the slot and
selecting 'Option' from the pop-up menu. For more information see
'Option setting'.
Message Power consumption exceeds supply from power supply module in slot
Description  [With the current configuration, there is not enough power being supplied
to the module. The message shows the number of the slot containing the
power supply which feeds this module.
Causes and |e There may not be enough power supply modules in the system. To fix
actions this, you will need to install an additional power supply just before the
first module that reports this error.
e Depending on your configuration, you may be able to rearrange the
other modules to make better use of the existing power supplies.
Message ST1X1616-DE1-S1-L module required after this module
Description |The ST1X1616-DE-S1 module is presented in the software as two
modules, ST1X1616-DE1-S1-F and ST1X1616-DE1-S1-L. These
modules are one physical unit and so they must always appear as a pair
with the ST1X1616-DE1-S1-F module followed by the ST1X1616-DE1-
S1-L module. This message appears when there is a ST1X1616-DE1-
S1-F module which is not followed by a ST1X1616-DE1-S1-L module.
Causes and |e Either add an ST1X1616-DE1-S1-L module if it is missing, or rearrange
actions the existing modules so that the two modules are adjacent with the

ST1X1616-DE1-S1-F module followed by the ST1X1616-DE1-S1-L
module.
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Message ST1X1616-DE1-S1-F module required before this module
Description |The ST1X1616-DE-S1 module is presented in the software as two
modules, ST1X1616-DE1-S1-F and ST1X1616-DE1-S1-L. These
modules are one physical unit and so they must always appear as a pair
with the ST1X1616-DE1-S1-F module followed by the ST1X1616-DE1-
S1-L module. This message appears when there is a ST1X1616-DE1-
S1-L module which does not have a ST1X1616-DE1-S1-F module before
it.
Causes and |e Either add an ST1X1616-DE1-S1-F module if it is missing, or rearrange
actions the existing modules so that the two modules are adjacent with the
ST1X1616-DE1-S1-F module followed by the ST1X1616-DE1-S1-L
module.
Message Byte pack consumption exceeds unused bits
Description  |A byte pack module cannot be used here because there are not enough
unused bits left.
Causes and |e There are not enough unused bits left to use byte packing. To fix this,
actions the marked module or the module to the left of it must be a standard

module. Depending on your configuration, you may be able to
rearrange the other modules to make better use of the unused bits to
be able to use them for byte packing.

13.2.7 Module deletion errors
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These errors can occur when deleting modules. For more information, see 'Deleting a
module' or 'Deleting all modules'.

Message Cannot delete head module.

Description  |An attempt was made to delete the head module.

Causes and |e The head module cannot be deleted - all valid systems must have a
actions head module in the first slot. If you wish to start again and reconfigure

the system with a different head module, select 'File -> New'.
Alternatively, use the 'Edit' menu item 'Change head module' to select
another head module type while leaving the remaining modules in
place.
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Message The module to be deleted has not been selected. Please select the
module to delete in the Module Information List.

Description  |[The 'Delete module' action was selected, but there is no module selected
for deletion.

Causes and |e Select a module by clicking on it, then try again.
actions

13.2.8 Module parameter errors

These errors can occur when setting or reading parameter values.

Message There are some errors. The following reasons may be responsible:
¢ The invalid setting value is selected.

¢ The value besides the range is set as the setting value.

Description  [When checking the parameter settings for errors on the parameter
settings screen, some of the parameters were not valid.

For more information about parameter settings, see 'Checking the
parameters for errors'.

Causes and |e The most likely cause is that the parameter value is out of range. For
actions example, a number has been entered which is below the lower limit for
the parameter value or above the upper limit for the parameter value.

Message The parameter item for the corresponding Read/Write/Verify has not
been selected. Please select the parameter item.

Description  |In the parameter settings dialog, an action (such as upload / download /
verify) was selected without first selecting the parameters to work on.

Causes and |e To prevent this happening, select one or more parameters from the list
actions before selecting an action. For more information, see 'Parameter
setting' or 'Uploading/Downloading the parameters'.
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Message The setting value that cannot be changed is read only. The setting value
for the read only cannot be downloaded.

Description |In the parameter settings dialog, an attempt was made to download an
item which is read only.

Causes and |e Read only items cannot be downloaded by GX Configurator-ST. If there

actions are other parameters to download which are not read only, deselect the

read only item and try again.
* In some cases, it may be possible to change the parameter by sending
a command from the master station.

Message The module differs from the mounted module.

Description | This error can occur when trying to download parameters to a module in
a given slot using the parameter settings dialog. The problem is that the
module in that slot in the connected SLICE system is not the same type
as the module in that slot in the configuration file. For more information,
see 'Parameter setting'.

Causes and |e This normally means that there is a mismatch between the

actions configuration file and the connected hardware. Check that the PC is

connected to the right hardware, i.e. that the cable is not in the wrong
port on the computer or connected to a different SLICE system.

¢ The configuration file may be out of date. If the connected system was
expected to match, it may be easier to use 'Get system' to read the
details from the connected hardware, and then try again.

Message Cannot set the parameter of the specified module.

Description  |An attempt was made to show the parameter settings of a module which
does not have parameters (such as a power supply module).

Causes and |e There are no parameters for the type of module selected.

actions
e If you were expecting the module to have parameters, please check

that the right module is selected.

Message The module to be set has not been selected. Please select the module to
be set in the Module Information List or the System Monitor.

Description  [An attempt was made to show the parameter settings dialog without first
selecting the module to view.

Causes and |e Select a module, and then try again.

actions
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Message Please select modules

Description  |When performing a parameter block write, no modules have been
selected for download.

Causes and |e Select the modules whose parameters should be downloaded to the

actions SLICE system by clicking in the 'Select' column, then try again.

Message Download canceled.

Description | This message is shown when a parameter block write is canceled before
the parameters have been downloaded for all modules.

Causes and |e To continue with the download, make sure that all the required modules

actions are selected (modules whose status is marked as ‘completed' have

already been downloaded in full and can be deselected) and try again.

13.2.9 Module selection errors

These errors can occur when it is not possible to tell which module was selected.

Message The Module Information List is not displayed. Please activate the Module
Information List in the menu.

Description  [This error is shown in edit mode when an attempt is made to use a
feature that needs a selected module, but the module configuration
window is not shown, or no module is selected. The module configuration
window must be visible to allow modules to be selected.

Causes and |e Use the 'View' menu 'Module configuration' item to show the window,

actions then click on a module in the module list or rack display to select it, and

try again.

Message The module to be set has not been selected. Please select the module to
be set in the Module Information List.

Description  [An attempt was made to show the module option dialog without first
selecting a module to work with.

Causes and |e Make sure that a module has been selected in the module list or rack

actions display by clicking on it, then try again.
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13.2.10 Module verify (compare) errors

These errors can occur while verifying (comparing) modules against another
configuration file. For more information about this feature, see the 'Verifying the projects’

section.

Message The system configuration of the file opened for verification and the file
under editing is different. Cannot execute verification for all the selected
modules.

Description  [This error can be shown when the destination file is first opened in the
verify dialog, when the 'Verify all modules' tab is active. When "Verify all
modules’ is used, the source and target systems are expected to be very
similar, with the same number and type of modules, and this is not the
case for the selected file.

Causes and |e If you do not intend to use the 'Verify all modules' feature, you can

actions ignore this message and activate the 'Verify selected modules' tab

instead, as this will still work even if the configurations are different.
e |[f you were expecting the two configurations to be comparable, check
that you have opened the correct file.

Message Is it OK to clear the selected module?

Description  |This message is shown when using the 'Verify selected modules' tab to
set up the list(s) of modules to compare. It appears when the source is
changed after some modules have been selected, and is a warning that
all the module selections will be reset if the source is changed.

Causes and |e Either confirm the prompt, in which case the selections will be cleared

actions and you will have to enter them again, or
e Cancel, in which case the source will not be changed.

Message Module at the verification source has not been selected.

Description  [With the 'Verify selected modules' tab active, an attempt was made to
start the comparison before selecting a source module.

Causes and | One source module needs to be selected before starting the

actions comparison. This module will be compared against each of the

destination modules in turn.
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Message Module at the verification destination has not been selected.
Description  [With the 'Verify selected modules' tab active, an attempt was made to
start the comparison before selecting any destination modules.
Causes and |e One or more destination modules need to be selected before starting
actions the comparison. Each of these will be compared against the source
module.
Message The specified module does not exist.
Description  |[In the verify results dialog, after trying to edit the parameter settings by
double clicking a module row or pressing the 'Parameter settings' button,
GX Configurator-ST could not find the module whose settings should be
edited.
Causes and |e Make sure that a valid row is selected.
actions )
¢ Make sure that the module at the selected row has editable
parameters.
¢ Try closing the results dialog and using the module list or rack display
to edit the parameters of the module instead.

13.2.11 Online change errors

These errors can occur during online module change. For more information about the
online change procedure, see the head module documentation and the sections 'Online
module change' and 'Online module change from GX Configurator-ST'.

Message The module for the setting has not been selected. Please select the
module that is to be set in the System Monitor.

Description  [The 'online change' feature was started without first selecting the module
to be changed.

Causes and |e Select a module to change by clicking on it in the system monitor

actions dialog, then try again.
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Message The selected module cannot execute Online Module Change.

Description | This message is shown when an attempt is made to use the online
change feature on a module which does not support online change. For
example, the head module and power supply modules cannot be
exchanged while the system is running.

Causes and |e Select a module which supports online changes and try again. If you do

actions need to replace a module that does not support online change, the only

safe way is to power down the system and replace the module while
the whole system is switched off.

Message Online Module Change was stopped. This module does not operate.
Please execute "Online Module Change™ again.

Description | This message is shown if the online change procedure is cancelled part
way through the exchange. It indicates that the selected module is not
operating as a result of stopping the exchange procedure.

Causes and |e Go through the online change procedure again for the same module (it

actions does not actually have to be replaced). If you try to select a different

module, an error will be shown.

Message There is some other module that is performing Online Module Change.
Please execute Online Module Change for one module of at a time.

Description  [An attempt was made to start an online change operation, but there is
already a module part way through the online change process. This can
occur if a previous online change (either from GX Configurator-ST or
using the buttons on the front of the head module) has not fully completed
or was cancelled part way through.

Causes and |e Select the module that is part way through online change (the module

actions

will have a purple (Bl) status colour in the system monitor), and
complete its online change procedure first. Online change can only be
used for one module at a time.
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13.2.12 Printing errors

The errors in this section can occur during printing. For more information, see 'Printing
the project data'.

Message Please close GX Configurator-ST after closing Print Preview.
Description  |If the print preview dialog is open, it must be closed before trying to close
GX Configurator-ST.
Causes and |e Close the print preview dialog, then select the 'File' menu 'Exit' item to
actions quit.
Message Please select one or more modules.
Description  [This message is shown on the print dialog, if the print range is 'selected
modules' but no modules have been seleced.
Causes and |Either:
actions - . ,
e Select some modules by clicking on them in the list on the left, then
using the '->' button to add them to the list of modules to print, or
e Select the 'All modules' option for the print range instead, in which case
all the modules will be included in the printout.
Message Please specify the print item.
Description  |The print dialog has three options for sections that can be included in the
printout:
¢ Module configuration
e Module information list
¢ Individual module information
This error message is shown when all three options have been
deselected, and there is nothing remaining to print.
Causes and |e Select at least one section to be printed. If you do not want to print
actions anything, cancel the dialog.
Message Please set the Module Turning Position within the range of 1-99.
Description [ The module turning position gives the number of modules printed per row
on the module configuration page of the printout. It must be a number
from 1-99.
Causes and |e Enter a number from 1-99 for this value, then try again.
actions
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Message The initial page value is outside the range.\nThe initial page value should
be set within the range 1-32767.

Description  [This error is shown on the page setup dialog, if the first page number is
not within the range 1-32767.

Causes and |e Enter an initial page number from 1-32767 and try again.

actions

13.2.13 System errors

These errors occur when there are other issues with the system, or problems with the

installation.
Message Insufficient memory. Please close other applications to increase
memory.
Description | There is not enough free memory available to complete the current
activity.
Causes and |e If possible, try to close other applications which you are not using, to
actions release memory.
¢ You may also be able to increase the amount of memory available by
increasing the size of the page file, or by installing additional memory in
the computer.
Message There is not enough memory, so the GX Configurator-ST cannot be
activated. Quit other applications, then activate the GX Configurator-ST.
Description  [There is not enough free memory available to start the application.
Causes and |e If possible, try to close other applications which you are not using, to
actions release memory.
* You may also be able to increase the amount of memory available by
increasing the size of the page file, or by installing additional memory in
the computer.
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Message Some of the necessary files for running the application are not found.
Please reinstall.

Description  |This message normally means that GX Configurator-ST did not install
correctly, or some of the application files or registry settings have been
damaged.

Causes and |e Afile is missing, or part of the application failed to load or initialise.

actions
¢ In general, uninstalling the program (from 'Control Panel -> Add or

remove programs') and then reinstalling should fix the problem.

Message Failed to read the registry data. There is some possibility for some error
in the operating environment of the application.

Please do reinstall. Administrator authorization is required in case of
using Windows® 2000, Windows® XP, Windows Vista® and Windows®
7.

Description  |[The application was unable to read settings from the system registry.

Causes and |e The currently logged-on user may not have Administrator rights. Log

actions back on as a user with Administrator access.
¢ The application may not be correctly installed, in which case it should

be uninstalled (from 'Control Panel -> Add or remove programs') and
then reinstalled.

Message Cannot execute online operations in this application. Online operation is
possible only in the application that started in the beginning.

Description  |The system cannot make connections to the device hardware, as the
connection is already in use.

Causes and |e This message will be shown if GX Configurator-ST is run twice. Use

actions the instance that was started first for online operations.

Message Failed to open the database. Please reinstall.

Description | This message normally means that GX Configurator-ST did not install
correctly, or some of the application files or registry settings have been
damaged.

Causes and |e Afile is missing, or part of the application failed to load or initialise.

actions

¢ In general, uninstalling the program (from 'Control Panel -> Add or
remove programs') and then reinstalling should fix the problem.
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Message Cannot access the database, The database may be damaged or old.
Please update to the latest database.

Description  |This message normally means that GX Configurator-ST did not install
correctly, or some of the application files or registry settings have been
damaged.

Causes and |e Afile is missing, or part of the application failed to load or initialise.

actions
e [f restarting the application or rebooting the PC does not help,

uninstalling the program (from 'Control Panel -> Add or remove
programs') and then reinstalling it may fix the problem.

Message Failed to access some necessary information from database. The
database may be damaged or old. Please update to the latest database.

Description  |This message normally means that GX Configurator-ST did not install
correctly, or some of the application files or registry settings have been
damaged.

Causes and |e Afile is missing, or part of the application failed to load or initialise.

actions
e |f restarting the application or rebooting the PC does not help,

uninstalling the program (from '‘Control Panel -> Add or remove
programs’) and then reinstalling it may fix the problem.

Message Cannot read the database because it is of an old version. Please renew
the database.

Description | This message normally means that GX Configurator-ST did not install
correctly, or some of the application files or registry settings have been
damaged.

Causes and |e Afile is missing, or part of the application failed to load or initialise.

actions
¢ In general, uninstalling the program (from 'Control Panel -> Add or

remove programs') and then reinstalling should fix the problem.

Message Cannot read the database because it is of a new version. Please update
the application.

Description | This message normally means that GX Configurator-ST did not install
correctly, or some of the application files or registry settings have been
damaged.

Causes and |e In addition to trying to uninstall and reinstall GX Configurator-ST, check

actions that there is only one version installed on the computer. This error

could occur if two versions of the software are installed into the same
directory.
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Message

Application becomes unstable. Please restart.

Description

This message may be shown if the application is not able to load a key
file.

Causes and
actions

¢ |f the message is only shown when opening a particular file, the file
may be corrupt, have an invalid path, or could have been created by a
much earlier or much later version of GX Configurator-ST.

e If this message is shown regularly, try uninstalling and reinstalling the
application.

Message

A MELSOFT application error has occurred. Please restart.

Description

This message may be shown if an unknown error occurs, i.e. an error
which does not have its own error message. This is normally related to
online operations or data communications.

Causes and
actions

* This message may just be an unusual communications error. Make
sure that the communication link is correct, and that you are connected
to the right SLICE system.

e Check that the configuration being edited does actually match the
SLICE hardware.

e Restarting the application may fix the problem.

e If this message is shown regularly, try uninstalling and reinstalling the
application.
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Block download of parameters 144
I n d eX Block write - no module selected error 209
Block write cancelled error 209
Br 10, 11, 17, 59, 61, 64, 66, 170, 171
_ 1 _ Br.n 155, 158, 180
Br.n bit input area 15, 18
Bus cycle time 18
Bus refreshing module 14
Bus terminator 17

- A - Buttons

Linerify 74,79

Add 63
A1SJ71PB92D 17 Delete 63
Abbreviations 14 Toolbar 55
About (Help menu) 36 Bw 10, 11, 18, 59, 61, 64, 66, 165, 170, 171
Access denied error (file) 196 Bw.n 22, 155, 158, 165, 180
Add (Edit menu) 96 Bw.n bit output area 15, 18
Add button 63 Bw.n+1 165
Add module dialog 96 Bw.n+2 165
Add modules 96, 100 Bw.n+3 165
Add modules using the wizard area 100 Byte pack 136, 206
Adding modules 96, 100 Byte pack check 26
Adding modules with "Add module” 96 Byte packing 203
AJ65BT-64AD 15
AJB5BT-64DAI 15 _ C _
AJB5BT-64DAV 15
AJ65BTB1-16D 15 Cable 29

AJ65SBTB1-16D 15
AJ71PB92D 17
Alignment 82, 86

All delete 108

All delete (Edit menu) 108
Already running error 215

Another module is performing online change error
212

Application error 217
Application unstable error 217

Cancel download 144

Cancel forced output test mode error 198
Cannot access database error 216

Cannot add more modules error 201

Cannot add the head module 204

Cannot delete head module error 206

Cannot execute while monitoring active error 192
Cannot set parameters of this module error 208
Cannot show detail of module error 195
Cascade (Window menu) 54

Areas _
Information 18 CC-Link 14, 59, 132 _
Request 18 Change head module (Edit menu) 132

Change head module type 132

Change PROFIBUS-DP head module protocol version
134

- B - Change to diagnosis mode 149
Changing modules online 180, 182, 183
Base module 14, 58, 127, 129, 155, 158, 180, 183 Channel 119, 121, 124, 146

Arrange icons (Window menu) 54

Batch write cancelled error 209 Channel not selected error (offset/gain) 200
Baud rate 138 Check parameters 117, 124

Bit I/O range limit exceeded error 201 Check power distribution 130

Bit input area 10, 11, 15, 17, 18 Checking the parameters for errors 124

Bit inputs 160 Clear 165, 180

Bit output area 10, 11, 15, 18 Clearlog 156, 159

Bit output data 165 Close 51

Bit outputs 160 Close (File menu) 71
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Close all (Window menu) 54

Close file while forced output test mode active error

199
Closing the program 51
Closing the project 71

Columnar writing 82, 94
COM port 138
Command 16, 18

Command execution area 10, 11, 16, 18
Command execution result 11
Command parameter 16
Command result area 10, 11, 15, 17
Communication baud rate 155
Communication error 37, 191, 192
Communication errors 191
Communication port 141
Communications

Erors 191

Settingup 138
Communications setup 138
Compare 74
Compare module errors 210
Compare projects 74
Comparing two configurations 74
Compatibility with earlier versions 20
Configuration

Printing 82

System 29
Configuration does not match error (verify) 210
Configuration errors 58, 59, 61
Configuration has changed error 195
Configuration mismatch error 194
Configuration setting 59
Configuration software 14
Configurations

Comparing 74

Creating CC-Link 68

Creating PROFIBUS-DP 68
Consumption 130
Contents (Help menu) 36
Control panel 47
Conwersion 135, 136
Copy 109
Copy (File menu) 109

Copy to file (master station data communication
monitor) 174

Copy to file (network parameter monitor) 177
Copying module information 109

Copying modules from another file 109

CPU 30

Cr 10,11, 17,171

Cr.n Command result area 15

220

Creating a new CC-Link configuration 68
Creating a new PROFIBUS-DP configuration
Creating a new project 68
Creating projects 67
Cw 10, 11, 18, 171
Cw.n Command execution area 16
Cycle time
Bus 18
SThus 16, 18
Cyclic transmission 15

D -

Damaged file error 196
Data

/o 18

Input 17

Output 18
Data link status 15
Database error 215
Database \ersion error 216
Default parameters 120
Delete (Edit menu) 107
Delete all (Edit menu) 108
Delete all modules 108
Delete button 63
Deleting a module 107
Deleting all modules 108
Deleting modules 107, 206
Destination directory 73
Destination folder 41
Destination module not selected error (verify)
Details of information area 64
Details of module configuration window 56
Details of module list 59
Details of rack display 58
Details of toolbar 55
Details of wizard area 63
Diagnosis (Menu mode) 38
Diagnosis mode 38, 49, 118, 149
Diagnosis mode operation procedure 38
Diagnostics 149

Errors 193

Forced output test 165

I/O monitoring 160

Input/Output monitor 160

Master station data communication monitor
169, 174

Module detail information 154

Module detail information (head module)
158

MELSOFT
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Diagnostics 149

Module detail information (other modules) 155,

158
Monitoring 149, 160, 169, 174, 175, 177
Offset/gain settings 146

PROFIBUS-DP network parameter monitor 175,

177
Saving communication data 174

Saving PROFIBUS-DP network parameter monitor

data 177

System monitor 149
Diagnostics errors 193
Diagnostics menu 34

Master station data communication monitor
169

Module detail information 154
Online module change 180
Profibus-DP network parameter monitor 175
Different head module type error 194
Different module configuration error 194
Display position 149
Display switching 53, 54
Documentation layout 8
Download 49
Download cancelled error 209
Download parameters 117
Download parameters as a block 144
Downloading a read only item error 208
Downloading and uploading the parameters 137
Downloading parameters 121
Drag and drop 114
Drop down menu 53

_E -

Edit (Mode menu) 38
Edit footer 88
Edit header 88
Edit menu 33
Add 96
All delete 108
Change head module 132

Delete 107
Delete all 108
Option 126

Parameter setting 117, 118
Power distribution check 130
Rearrange 112

Redo 112

Undo 111

Edit mode 38, 118

Edit mode only 53

Edit mode operation procedure 38
Editing the project 96
Environment of MELSOFT 41

17, 171

Ern 180

Error check (parameters) 124
Error clear area 11, 18
Error information area 11, 17
Error messages 191
Errors 198

0180840b 139, 191

0x0180840b 139, 191

A missing number will be made 203
Access denied (file) 196

Already running 215

Another module is performing online change
212

Application error 217

Application unstable 217

Batch write cancelled 209

Bit I/O range limit exceeded 201
Block write - no module selected 209
Block write cancelled 209

Byte pack consumption exceeds unused bits
206

Cancel forced output test mode 198
Cannot access database 216
Cannot add more modules 201
Cannot add the head module 204

Cannot communicate with head module 20,
140, 192

Cannot delete head module 206

Cannot execute while monitoring active 192
Cannot set parameters of this module 208
Cannot show detail of module 195

Channel not selected (offset/gain) 200
Clearlog 156, 159

Close file while forced output test mode active
199

Communication 191

Configuration does not match (werify) 210
Configuration has changed 195
Configuration mismatch 194

Damaged file 196

Database 215

Database version 216

Destination module not selected (verify) 211
Diagnostics 193

Different head module type 194

Different module configuration 194
Download cancelled 209

Downloading a read only item 208

221
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Errors 198 No print item selected 213

ES:10000002 20, 140, 192 Not enough memory 214

Failed to read database 216 Offset and gain 197

File 196 Offset/gain input error 200

File name too long 197 Offset/gain settings not supported 199

File not found 197 Offset/gain value out of range 200

File sharing violation 197 Online change 211

File version 196 Online change not supported 212

Forced output 197 Online module change stopped 212

I/O monitor will be started 195 Parameter 207

Initial page no. out of range 214
Insufficient memory 214
Intelligent module limit exceeded
Invalid forced output value 200
Maximum configuration reached
Memory 214

Messages 191

Missing files 215

Missing power supply module
Module addition 200

Module cannot be added at position
Module change already in progress
Module configuration 204
Module configuration not shown
Module copy 200

Module deletion 206

Module different from mounted module 208
Module does not support forced output test
Module does not support I/O monitoring
Module isn't selected 202
Module limit exceeded 201
Module parameters 207

Module selection 209

Module to delete is not selected
Module turning position out of range
Module verify (compare) 210
Monitoring will be stopped 195
Multiple instances 215

Must close print preview before exiting
Must switch to forced output test mode
No file path setting 203

No module selected 193, 208

No module selected (forced output test) 197
No module selected (/O monitoring) 194
No module selected (offset/gain settings)
No module selected (online change) 211
No module selected (options) 209
No module selected (printing) 213
No monitor data to write 193

No output selected (forced output test)
No parameters selected 207
No power supply module in slot 1

202

204

204

202
212

209

198
193

207
213

213
199

199

200

204

222

Power consumption error 205

Power consumption exceeded after adding module

203

Power supply in slot 1 should have 'H-SET base
type 205

Power supply in this slot should have 'R-SET

base type 205

Printing 213

Registry 215

Restart application 217
Send / receive error 192

Source module not selected (werify) 210
Specified module does not exist (verify)

ST1X1616-DE1-S1-F required before
ST1X1616-DE1-S1-L 206

ST1X1616-DE1-S1-L required before

211

203

ST1X1616-DE1-S1-F 205

Stop monitoring before save 193

Switch mode while forced output test active
System 214

Timeout range error (transfer setup) 192
Unknown module 202

Unused bits exceeded after adding module

W /O range limit exceeded 201

Window closed during offset/gain setting 199

Word I/O range limit exceeded 201
Wrong head module type 194
XY /O range limit exceeded 201
Ew 18,171
Ew.n 22, 146, 160, 165, 180
Example printouts 94
Exit (File menu) 51, 71
Exiting GX Configurator-ST
Extended cyclic 155
Extended cyclic setting 59
Extended diagnostic information
External power supply 14

_E -

F1lhelp 20, 58, 59, 61
Failed to read database error

51

17

216

198
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Fast user switching 30
FDL address 17, 54, 158
Features 22

File compatibility 20

File errors 196

File menu 33

Close 71
Copy 109
Exit 51,71
New 68
Open 70
Print 82
Recent files 33
Sawe 72
Sawas 73
Verify 74, 79
File name 70, 73

File name too long error 197

File not found error 197

File sharing violation error 197

File version error 196

Footer 88

Forced output errors 197

Forced output test 7

Forced output test (diagnostics) 165
Forced output test (Online menu) 165
Function list 32

-G -

G.RDMSG 14

Gain 146

Get input / output data settings 143
Get input/output data settings (online menu) 143
Get system 49, 141

Get system (online menu) 141
Global control 18

Glossary 14

GP.RDMSG 14

GSD file 17, 134

GSD wersion 61, 134

GX Configurator-DP 17

GX Configurator-ST 14

_H -

Hard drive space 30

Head module 7, 14, 58, 68, 114, 134, 149, 155,
158, 169, 179, 180, 182, 183
Cannot communicate 192

Change type 132

Changing to CC-Link 132
Changing to PROFIBUS-DP 132

Mode 61, 134
Protocol version 61, 134
Resetting 179

Head module mode 61, 134

Head module protocol version 61

Header 88
Help menu 36
About 36

Contents 36

Key operation list 190
Hold 165, 180
Horizontal writing
Howdol... 27
Howto 27

I/O data 15, 18

I/O module 7,14

I/O monitor will be started error 195
I/O monitoring 160

I/O occupation points 59, 61
Information area 18, 56, 64

Initial page no. out of range error 214

Initialize Module Configuration View Position (View
menu) 54, 56

Input data 17
Input module 14
Input/output module 155, 158
Input/Output monitor 160
Input/Output monitor (online menu) 160
Insert position 96
Installation 40, 41
Installation procedure 40
Installing GX Configurator-ST 41
Insufficient memory error 214
Intelligent function module 14, 155, 158
Intelligent module limit exceeded error 202
Intelligent modules 146
Interface modules

Al1SJ71PB92D 17

AJ71PB92D 17

QJ71PB92D 17
Introduction 6
Invalid forced output value error 200

K -

Key operation list (Help menu) 190

82, 94
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Key operations list 190
Keyboard shortcuts 190

_L -

Label name 59, 61, 127, 129
Labels 127, 129

Landscape 82, 86, 88
Layout 8, 53

Link special relay 15

List of modules 59, 61

Local station 15

M -

Master module 14
Master modules
QJ71PB92V 17
Master station 15, 17, 134, 136

Master station data communication monitor 169,
174

Master station data communication monitor
(Diagnostics menu) 169

Maximize 53

Maximum configuration reached error 204
Maximum input/output points 96, 129, 158
MELSEC-ST system 14

Memory 30
Memory errors 214
Menu bar 53
Menu list 33
Menus

Diagnostics 34

Edit 33

File 33

Help 36

Mode 34

Online 34

View 34

Window 36
Message transmission 10
Minimize 53

Missing files error 215
Missing number will be made error 203
Missing power supply module error 204
Mode 59
Mode menu 34

Diagnosis 38

Edit 38
Module 200, 204, 206, 207, 210

Labels 126

224

Options 126
Module addition 200
Module addition errors 200
Module cannot be added at position error 202
Module change already in progress error 212
Module compare 210
Module configuration 204
Module configuration (View menu) 54
Module configuration errors 204
Module configuration not shown error 209

Module configuration window 53, 54, 56, 68, 96,
107, 108

Module copy errors 200

Module copying 200

Module deletion errors 206

Module detail information (Diagnostics menu) 154
Module different from mounted module error 208

Module does not support forced output test error
198

Module does not support I/O monitoring error 193
Module graphic 64, 66
Module isn't selected error 202
Module limit exceeded error 201
Module list 56, 59, 96, 107
Module operating status 15
Module options 126
Module parameter errors 207
Module selection errors 209
Module status 149, 183
Module status area 11, 17
Module to delete is not selected error 207
Module turning position 82
Module turning position out of range error 213
Module verification 210
Module verify (compare) errors 210
Modules 7, 200, 204, 206, 207, 210
A1SJ71PB92D 17
Add dialog 96
Adding 96, 100
Adding using the wizard area 100
Adding with "Add module" 96
Adding with wizard 100
AJ71PB92D 17

Base module 180, 183
Changing online 180, 182, 183
Changing order 112, 114

Checking parameters 124

Copying 109
Copying from another file 109
Deleting 107

Deleting all 108
Downloading parameters 121
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Modules 7, 200, 204, 206, 207, 210
Drag and drop 114

Head 7, 14, 58

Head module 114, 149, 155, 158, 169, 179,
180, 183

o 7

Input/Output 96, 100

Input/output module 155, 158

Intelligent 96, 100, 119, 146, 155, 158
Master 14

Online change 180, 183

Online change precautions 180

Online change procedures 182
Parameters 117, 118, 121, 124

Power distribution 96, 100, 130, 180
Power distribution module 155, 158
Power supply 58, 96

Power supply module 114

QJ61BT1IN 14

QJ71PB92D 17

QJ71PB92V 17

Rearranging 112, 114

Rearranging with drag and drop 114
Rearranging with the rearrange dialog 112
Reorder 112, 114
Replacing 183
Setting parameters
ST1AD2-l 146
ST1AD2-V 146
ST1DA1l-l 146
ST1DA1l-I-FO1 146
ST1DA2-V 146
ST1DA2-V-FO1 146

117, 118, 121

STIH-BT 68
STIH-PB 68
STIPSD 58, 112, 130, 203

ST1X1616-DE1-S1 180
ST1X1616-DE1-S1-F 205
ST1X1616-DE1-S1-L 206
Uploading parameters 121
Verifying parameters 121

Monitor 149
Monitor and test 149
Monitoring 149, 169, 174

Monitoring the system 149

Monitoring will be stopped error 195

Mr 17,171

Mr.n 180

Multiple configurators 49, 53

Multiple instances 49, 53

Multiple instances running 215

Must close print preview before exiting error 213

Must switch to forced output test mode error 199

- N -

n:nverify 74

Network parameter monitor (PROFIBUS-DP) 175
Network parameters 175

New (File menu) 68

New features 19

Next window 53

No file path setting error 203

No module selected error 193, 208

No module selected error (forced output test) 197
No module selected error (/O monitoring) 194
No module selected error (offset/gain settings) 199
No module selected error (online change) 211
No module selected error (options) 209

No module selected error (printing) 213

No monitor data to write error 193

No output selected error (forced output test) 200
No parameters selected error 207

No power supply module in slot 1 error 204

No print item selected error 213

No. of stations 59, 155

Not enough memory error 214

Notes for upgrading users 20

Number of occupied I/O points 16, 18

Number of stations 59, 155
Occupied I/O points 16, 18

Occupied stations 155
Offset 146
Offset / gain settings 146
Offset and gain errors 197
Offset/gain input error 200
Offset/Gain setting (Online menu) 146
Offset/gain settings not supported error 199
Offset/gain value out of range error 200
Online change errors 211
Online change not supported error 212
Online menu 34
Forced output test 165
Get input/output data settings 143
Get system 141
Input/Output monitor 160
Offset/Gain setting 146
Parameter block write 144
Reset head module 179
Transfer setup 138

225
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Online module change 7, 180, 183 Slave 175

Connection to external device after replacement Uploading 117, 121, 137

187 Verifying 117

Disconnect external device 186 Verifying edited parameters 121

Operations after external device connection 187 pgint mode 105, 129, 143

Preparation for replacing slice module 183 Point mode change warning 105

Replacing slice module 186 Portrait 82, 86, 88

Online module change (Diagnostics menu) 180

Online module change precautions 180

Online module change procedures 182

Online module change stopped error 212

Online module operation 179

Open (File menu) 70

Opening an existing project 70

Opening projects 70

Operating environment

Operating systems
Supported 30

Operation history 111, 112

Operation procedures 37

Option (Edit menu) 126

Option setting 126

Options 126

Orientation 82, 86, 88

Output data 18

Output module 14

Oweniew 22

_P-

Page layout (printing) 88
Page number format 88
Parameter block write 49, 144
Parameter block write (Online menu) 144
Parameter error check 124
Parameter errors 207
Parameter setting 118
Parameter setting (Edit menu) 117, 118
Parameter settings 117, 118, 121, 124, 207
Parameter settings dialog 119
Parameters 74, 77, 79, 109

Block download 144

Block write 144

Checking 117

Checking for errors 124

Download as a block 144

Downloading 117, 121, 137

Error check 124

Network 175

Read from device 141

Reset to default 120

Setting 117, 118, 119

226

30, 41
41, 47, 49

Power consumption 96, 100, 130
Power consumption error 205

Power consumption exceeded after adding module
error 203

Power distribution check 26, 130
Power distribution check (Edit menu) 130
Power distribution module 14, 96, 155, 158, 180
Power feeding module 14
Power saving function 37
Power supply 130
External 14
Power supply module 58, 96, 100, 114
Power supply modules 130
Precautions 7, 37
Precautions for online module change 180
Preset 165
Preview printing 92
Previous versions 20
Previous window 53
Print (File menu) 82
Print examples 94

Print orientation 82, 86, 88
Print preview 51, 92, 213
Printer setup 86, 88

Printing 82
Examples 94
Page layout 88
Previewing 92
Printing errors 213
Printing the configuration 82
Procedures for online module change 182

PROFIBUS-DP 14, 61, 103, 132, 134, 143, 175,
177

PROFIBUS-DP network parameter (diagnostics)
175, 177

PROFIBUS-DPVO 17

PROFIBUS-DPV1 17

PROFIBUS-DPV2 17

Project

Editing 96
Printing 82
Project creation 67
Projects

Closing 71

Comparing 74
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Projects Reset head module 7
Creating 67, 68 Reset head module (Online menu) 179
Opening 70 Reset the head module 179
Saving 72 Resize 56, 59, 61
Samving with a different name 73 Resolution 30
Verifying 74 Restart application error 217
Protocol 68 Resume 37
Protocol version 20, 61, 68, 103, 133, 134, 135, ROM 121, 124, 138, 141, 144
136, 140, 149, 163, 171, 192, 195 RS232 29
RS232 cable 29
_ Q _ RWr 10, 59, 64, 155
Rww 10, 59, 64, 155
QJ61BT1L 15 RX 10, 59, 64, 155
QJ61BTLIN 14, 15 RY 10, 59, 64, 155
QJ71PB92D 17
QI71IPBO2V 17 -S-
_ R _ Safety precautions 7
Sawe (File menu) 72
rack display 56, 58, 96, 107, 114 Saweas 51
RAM 121, 124, 141, 144 Sawe as (File menu) 73
RDMSG 14 Sawe changes 71, 72
Read configuration from device 141 Sawe project with a different name 73
Read only 208 Sawe the project 72
Read parameters 141 Saving communication data 174
Rearrange (Edit menu) 112 Saving network parameter monitor PROFIBUS-DP)
Rearrange dialog 112, 114 177. ]
Rearranging modules 112, 114 Saving PROFIBUS-DP network parameter monitor
Rearranging modules with drag and drop 114 data 177
Rearranging modules with the rearrange dialog 112 Screen layout 53
Scroll bar 58

Recent files (File menu) 33
Recommended speed 138
Redo 112

Redo (Edit menu) 112
Registry error 215

Release all 121, 144, 165
Remote desktop 30

Remote device station 15
Remote I/O station 15
Remote input 10, 15

Remote net Ver. 1 mode 15
Remote net Ver. 2 mode 15
Remote output 10, 15
Remote register 10, 15
Remote station 15

Removing GX Configurator-ST 47
Reordering modules 112, 114
Repeater 17

Replacing modules online 183
Request area 18

Resened byte 96, 103, 135, 136, 203

Segments 17
Select all 121, 144, 165
Select base module 127, 129
Send / receive error 192
Serial port 138
Setting a page layout 88
Setting gain 146
Setting module parameters 117, 118
Setting offset 146
Setting parameters 117, 118, 119
Setting up communications 138
Setting up the printer 86
Setup
Printer 86
Shared files 47
Slave parameter 17
Slave parameters 175
Slawe station 17
Slice module 14
Slice No. 16, 18
Slice number 16, 18
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Slice position number 16

Slices 64, 66

Slots 64, 66

Software licence 41

Source module not selected error (verify) 210

Specified module does not exist error (verify) 211

ST bus cycle time 16, 18
STIH-BT 19, 68
ST1H-PB 68
STIPSD 58, 112, 130, 203
ST1X1616-DE1-S1 module 180
Standby mode 37
Start menu 41, 49
Start more than once 49, 53
Start slice No. 16
Starting GX Configurator-ST 49
Station address 54
Station number 155
Stations 59, 155

Local 15

Master 15

Remote 15

Remote device 15

Remote /O 15
Status bar 54
Status bar (View menu) 54
Status bit detail 64
Stop monitoring before save error 193
Supply check 130
Supply current 130
Supported Operating Systems 30
Suspend 37
Sw 18,171

Switch mode while forced output test active error
198

Switch to diagnosis mode 149
Switch windows 53
SWnD5C-PROFID-E 17
SWnD5C-STPB-E 14
Symbols used 9
System

Read from device 141
System area 11, 18
System Configuration 29
System errors 214
System monitor 54, 149
System monitor (View menu)
System monitoring 149

Target memory
228

54, 149

124, 144

Terminator 17
Terms 14
Terms and abbreviations 14
Test 149
Tile horizontally (Window menu) 54
Tile vertically (Window menu) 54
Timeout 138
Timeout range error (transfer setup) 192
Titlebar 51, 53
Toolbar 53, 54, 55
Toolbar (View menu) 54
Toolbar buttons 55
Toolbar icons 55
Topic layout 8
Transfer setup 138, 192
Transfer setup (Online menu) 138
Transmission
Cyclic 15
Transmission speed 158
Turning position 82

U -

Undo 111

Undo (Edit menu) 111
Uninstallation 40, 47

Uninstalling GX Configurator-ST 47
Unknown module error 202
Unused bits 61, 96, 103, 203, 206

Unused bits exceeded after adding module error
203

Upgrading 20

Upload 49

Upload parameters 117

Uploading parameters 121

Use word input data 96, 103, 129, 132
Use word output data 96, 103, 129, 132
Using the status bar 54

Using the toolbar 55

_V -

Verify 49, 74

In 74,79

nn 74

Projects 74

Result 77
Verify (File menu) 74, 79
Verify all modules 74, 210
Verify parameters 117
Verify result 77

MELSOFT



13 Reference MELSOFT

Verify results 77, 118
Verify selected modules 79, 210 _ X _
Verifying parameters 121
Verifying projects 74
Verifying the parameters being edited 121
View menu 34, 54

Initialize module configuration view position 54, = Z -

XY /O range limit exceeded error 201

56

Module configuration 54 Zoomin 92
Status bar 54 Zoom out 92
System monitor 54, 149

Toolbar 54

W -

W /O range limit exceeded error 201
What's new 19
Window 53
Window closed during offset/gain setting error 199
Window menu 36, 54

Arrange icons 54

Cascade 54

Close all 54

Tile horizontally 54

Tile vertically 54
Window rearranging 54
Windows

Module configuration 56
Wiring types

Screw (E) 126, 154

Spring clamp (S) 126, 154
Without Wr 96, 103, 127, 129, 132, 143
Without Ww 96, 103, 127, 129, 132, 143
wizard area 56, 63, 100
Word I/O range limit exceeded 201
Word input area 10, 11, 15, 17, 18
Word inputs 160
Word output area 10, 11, 15, 18
Word output data 165
Word outputs 160
Wr 10, 11, 17, 59, 61, 64, 66, 170, 171
Wr.n 127, 129, 143, 155, 158, 160, 180
Wr.n word input area 15, 18
Wrong head module type error 194
Ww 10, 11, 18, 59, 61, 64, 66, 165, 170, 171
Ww.n 22,127, 129, 143, 155, 158, 160, 165, 180
Ww.n word output area 15, 18
Ww.n+1 165
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